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CHAPTER 1 : LOGGING ON

This chapter explains how to:

• Log on to the Oracle Daybreak system
• Change a password
• Reset a password
• Log off from the Oracle Daybreak system.

Logging on
At the beginning of each Oracle Daybreak session and prior to working with any account, 
you must log on at your workstation. Oracle Daybreak then allows you to “enter” the sys-
tem and open the programs available according to your level of responsibility. To log on to 
Oracle Daybreak, you need to have your own user id and password. Each user id is 
attached to a responsibility level, or “profile,” that controls the user’s access to various 
areas of the system. Your user id is associated to all the accounts you process. 

The ability to log on is automatically disabled after a specified number of days of inactiv-
ity. The user id and password required to log on to Oracle Daybreak may be different from 
the user id and password used to log on to your computer or network. If you are unsure of 
your user id and password for Oracle Daybreak, contact your system administrator.

To log on to the Oracle Daybreak system

1 Follow the guidelines for your business to launch the iAS window and begin a Oracle 
Daybreak session. 

After starting Oracle Daybreak, the Login form appears.

2 In the User Id field, type your user identification name.
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3 Press TAB to move to the Password field.
-or-
Click the Password field.

4 In the Password field, type your password.

5 Choose Connect.
-or-
Press ENTER.

Note: If you choose Cancel, Oracle Daybreak closes the Login form.

If your user id or password is inaccurate, Oracle Daybreak displays the following dialog 
box:

• Choose OK and retype your user id and password. If problems logging on persist, con-
tact your system administrator.

IMPORTANT: 
The length of a password is established during system setup. Special characters (&, @, #, 
$, %, ^, &, *, and so on) cannot be used to create a password. To prevent others from see-
ing your password, your password does not appear in the Password field as you type it. 
Instead, your keystrokes appear as asterisks (*). Keep your password confidential to pre-
vent access to Oracle Daybreak by unauthorized users.

If Oracle Daybreak recognizes your user id and password, the login form updates to dis-
play and automatically complete the User Id, User Name, Responsibility, Organization, 
and Division fields. Your user id appears as the title of the form.
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When you successfully log on to Oracle Daybreak, the menu items available to your 
responsibility are available. (Whatever menu items are “unavailable” are visible, but 
dimmed.)

If you have not logged out of Oracle Daybreak, have an old Oracle Daybreak session 
open, or you did not correctly exit your previous Oracle Daybreak session, when you 
attempt to log in again, the following dialog box appears:

•  Choose Yes to close your existing sessions.

Note: The majority of the time, you will choose Yes. Choose No only if you want to work 
with multiple Oracle Daybreak sessions.
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Changing passwords
Passwords will automatically expire after a period of time set by your system administra-
tor. Oracle Daybreak notifies you of approaching password expiration dates with a mes-
sage dialog box that appears after you log on. 

To change your password

1 Close all open Oracle Daybreak forms and return to the User Id form.

2 On the File menu, choose Change Password.

The Old Password, New Password, and Confirm New Password fields appear on the form, 
along with the Change Password and Cancel buttons.

3 In the Old Password field, type your old password and press TAB.

4 In the New Password field, type your new password and press TAB.

5 In the Confirm New Password field, retype your new password and choose Change 
Password.

Oracle Daybreak displays the following dialog box:

6 Choose Ok.
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Resetting passwords
Oracle Daybreak allows you to reset your password from the Login form by choosing the 
Forgot Password button. This command button can be used when:

• You forget your password
• You discover that your password is not working (as another user might have disabled 

or changed it)
• Oracle Daybreak disables your password after you entered the wrong password multi-

ple times.

To reset your password with the Forgot Password button

1 Close all open Oracle Daybreak forms and return to the User Id form.

2 In the User Id field, enter your user identification.

3 Choose Forgot Password.

Oracle Daybreak generates a random alphanumeric password and sends this new pass-
word to the email address listed in your record on the Administration form’s Users page. 
Oracle Daybreak then displays a Forms dialog box with the message “Password Reset 
Successfully. You should receive the new password in your email shortly.”
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Logging off
When exiting Oracle Daybreak, always use one of the following procedures:

• On the File menu, choose Exit or Re-Logon
-or-
On the Oracle Daybreak menu bar, choose Exit.
-or-
On the Login form, press CTRL+Q.

Oracle Daybreak closes the session and releases any accounts you may have been working 
on.

IMPORTANT: 
Do not choose the Close button on the Oracle Daybreak menu bar to end a Oracle Day-
break session
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CHAPTER 2 : CUSTOMER SERVICE

After an application has cycled through the loan origination process, it becomes an 
account. Account maintenance and collections tasks can be performed with Oracle Day-
break’s Customer Service form.

The Customer Service form allows you to view and manage all customer information in a 
centralized location to assure data integrity and provide better service. Oracle Daybreak 
provides online real-time information about the applicant(s), contract, account balances, 
dues, transactions, call activities, and comments. Oracle Daybreak also supports back-dat-
ing of financial transactions up to account’s opening date.

Customer Service form is divided into tabs that perform the following tasks:

• Search for and load accounts on the Customer Service form
• View comprehensive account and customer details, including status, balances, trans-

action histories, payoff quotes, statements, escrow information, insurance informa-
tion, and vendor work orders.

• Track attributes associated with an account
• View vendor work orders
• Record call activities, promises to pay, comments, and references
• Use checklists to perform customer service tasks
• View payment rating history and due date history
• Perform monetary and nonmonetary maintenance on an loan
• Record information concerning bankruptcies, repossessions, foreclosures, and account 

deficiencies
• View contract information recorded during the funding process
• View information regarding account collateral
• Perform a credit bureau pull
• Add comments to an account during any time of the customer service process.

This chapter explains how to do all of this.
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Activating an account
An account is automatically activated when you fund the contract with the Funding form 
or when you activate an account with the Conversion App/Acc form. You cannot activate 
an account with the Customer Service form.

Posting and reversing payments
A payment can be posted and reversed on the Consumer Lending (Advance and Payment) 
form. You cannot post and reverse the payment in Customer Service form. (For more 
information, see the Batch Transactions chapter.)

A note about account numbers
After an application completes the loan origination cycle and is funded or is ported into 
Oracle Daybreak through the DLS Open Interface, it becomes an account and receives an 
account number.

Oracle Daybreak assigns account numbers using the following logic:

YYYYMMNNNNNNNX

where:

YYYYMM = contract date
NNNNNNN = serial number
X = check digit

Oracle Daybreak sorts accounts using the NNNNNN portion only. That portion is what we 
call the account ID.
Chapter 2 :-2   User Guide - Consumer Loans Servicing 



Search (1) master tab
There are a number of different ways to load an account on the Customer Service form.

• Use the Search (1) master tab (similarly to the Underwriting and Funding forms)
• Use the Search block on the Customer Service form’s master page
• Use the Next Account feature to load an account from a predefined queue
• Use the Auto Run feature.

To search for and load an account with the Search (1) master tab

1 On the Lending menu, choose Customer Service.

The Customer Service form appears, opened at the Account Details page.
Chapter 2 :-3   User Guide - Consumer Loans Servicing 



2 Choose the Search (1) master tab, then choose the Search tab.

3 In the Search Criteria block, use the Comparison Operator and Values columns to cre-
ate the search criteria you want to use to find an account.

Note: Choose Reset Criteria at any time to clear the Comparison Operator and Values 
columns.

4 Choose Search. 

Oracle Daybreak locates and displays on the Results page all the accounts that meet your 
search criteria in the Search Criteria block.

Note: The Secured check box indicates whether the account is secured and may only be 
loaded by authorized users.

5 On the Results page, double-click the application you want to retrieve.

Oracle Daybreak loads the account on the Customer Service (2) master tab’s Account 
details page. 

You are now ready to begin work on the account.
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To load an account with the Customer Service form’s master block

1 On the Lending menu, choose Customer Service.

2 In the Search block’s Acc # field, enter the account number of the account you want to 
load and press ENTER.

Oracle Daybreak displays the account details on the Customer Service form’s Account 
Details page. (Note: This method will locate a single account.)
-or-
In the Search block’s SSN field, enter the social security number of the applicant on the 
account and press ENTER. 

Oracle Daybreak displays all the accounts involving the applicant with that social security 
number on the Customer Service form’s master block Accounts block.

Note: If you complete both the Acc # and the SSN fields, Oracle Daybreak displays the 
account with that account number and all the accounts involving the applicant with that 
social security number on the Customer Service form’s master block Accounts block.

To view the loan origination information about an account

1 On the Lending menu, choose Customer Service.

2 Load the account you want to work with.

3 If you choose Underwriting from the Lending menu, Oracle Daybreak opens the Under-
writing form and loads the underwriting information from which the account was created. 

4 If you choose Funding from the Lending menu, Oracle Daybreak opens the Funding form 
and loads the funding information from which the account was created.
Chapter 2 :-5   User Guide - Consumer Loans Servicing 



A note about conditions and queues
Accounts do not have sub statuses; instead, accounts use conditions. Conditions further 
define the status of an account; for example, an account may be delinquent, bankruptcy, 
and scheduled for charge off. Conditions can be applied automatically by Oracle Daybreak 
based on set up and manually by Oracle Daybreak users with the Customer Service form.

Oracle Daybreak can assign accounts to specific users by way of queues. Queues are a 
workflow management tool that allow Oracle Daybreak users to work on accounts sequen-
tially from a prioritized list, rather than having to manually search for and load them. 
Queues are created and sorted during nightly processing. Examples of customer service 
queues include due date change requests, delinquent accounts, deferment requests, and 
title and insurance follow-up.

Oracle Daybreak assigns accounts to queues based on the account’s condition. 

However, an account can have more than one condition, so an account can be in more than 
one queue.In the example below, the single account for Hughs Meyers has two different 
conditions, Schedule for Chargeoff and Delinquent. It can appear in two different queues, 
one for Schedule for Chargeoff and one for Delinquent. 
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Multiple queues can be created for a single condition. Account attributes (such as number 
of days delinquent and product code) can be used for assigning accounts to a queue and 
sorting accounts within a queue. 

You can quickly load an account from a queue using the Next Account feature in the Cus-
tomer Service form master block.

To use the Next Account feature

1 On the Lending menu, choose Customer Service.

2 In the Search block of the Customer Service form master block, select the queue you want 
to work with in the Queue field and choose Next Account (Nx).

Oracle Daybreak displays the account details for you on the Customer Service form’s 
Account Details page.

Note: The accounts are selected from the predefined queue based on the following criteria:

• Accounts in the appointment list
• Accounts with the oldest next follow-up date and time
• Accounts meeting the sort criteria defined in the Queue Setup.

If the user has the authority to review queues without entering call activities, then only 
those accounts based on the sort criteria are selected.

To use the Auto Run feature

1 On the Lending menu, choose Customer Service.

2 In the Search block of the Customer Service form master block, select Auto Run.

Oracle Daybreak displays the account details for you on the Customer Service form’s 
Account Details page.
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Customer Service form’s master block
The Customer Service master block contains the Search block and the Accounts block. 
The Search block allows you to search for and load an account. The Accounts block pro-
vides a quick overview of an account by displaying its status, loan type, payoff amount, 
oldest due date, company, and branch. The information on the Customer Service form 
always refers to the account selected in the master block.

To view an account’s details in the master block

1 Open the Customer Service form and load the account you want to work with. 

2 On the Customer Service form’s master block, view the following information in the 
Accounts block:

In this field: View this:

Acc # Account number.
Status Account status.
Product Product.
Payoff Amt Payoff amount.
Amt Due Delinquent amount due.
Oldest Due Dt Due date.
Company Company.
Branch Branch.
Total (Payoff Amt) Total payoff amount.
(Total) (Amt Due) Total amount due.
# of Accounts Total number of accounts that the customer has in Oracle 

Daybreak, regardless of status (this includes closed 
accounts).
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Customer Service (2) master tab
The Customer Service (2) master tab contains information that is useful to all customer 
service personnel. The master tab contains the following pages:

• Account Details
• Customer Details
• Balances
• Transactions 
• Statements
• Escrow (available if this account contains escrow information)
• Insurances
• Vendor Work Orders.

Account Details page
The Account Details page displays information about the current state of the account.It’s a 
quick snapshot of the most important account-related information, including:

• Customer and contact information
• Dues (including delinquencies, late charges, and nonsufficient funds)
• conditions
• Dates of activities and payments, as well as payment amounts
• Number of delinquencies by length of overdue payment
• Number of broken promises
• Number of nonsufficient funds.

To view the Account Details page

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose Account Details.
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3 View the following information:

In this field: View this:

Customers block
Customer Name (unlabeled) Customer name.
Relationship (unlabeled) Customer’s relationship to the account.
Customer # Customer number (unique customer identifier).
SSN Customer’s social security number. Note: If the organiza-

tional parameter UIX_HIDE_RESTRICTED_DATA is set 
to Y, this appears as a masked number; for example, 
XXX-XX-1234.

Birth Dt Customer’s date of birth.
Gender Customer’s gender.
Email Customer’s email address.
Language Language spoken by the customer.
Marital St Customer’s martial status.
Disability Customer disability indicator If selected, this indicates 

that the customer is disabled.
Skip Customer’s skip indicator. If selected, this indicates that 

the customer is a skip debtor. This is selected using the 
Maintenance (3) master tab.

Stop Correspondence Stop correspondence indicator. If selected, Oracle Day-
break will not send correspondence to customer. This is 
selected using the Maintenance (3) master tab.

Privacy Opt-Out Privacy opt-out indicator. If selected, indicates that the 
applicant has elected to refrain from the non-public shar-
ing of information (optional).

Time Zone The applicant’s time zone.
Active Military Duty Active military duty indicator. If selected, indicates that 

the customer is on active military duty and may qualify 
for the rates in accordance with the Servicemembers 
Civil Relief Act of 2003 (SCRA).

Contact Information block
Address Type Address type.
Current If selected, indicates that this is the current address. 
Mailing If selected, indicates that this is the mailing address.
Phone Phone number.
Address (unlabeled) Address details.

Dues block
Today’s Payoff Payoff (for today).
Oldest Due Dt Due date.
Delq Due Delinquent amount.
LC Due Late charges due.
NSF Due Nonsufficient funds fee due.
Other Due Other dues.
Total Due Total amount due.
Due Dt (1) Due date.
Amt (1) Amount due.
Due Dt (2) Due date.
Amt (2) Amount due.
Due Dt (3) Due date.
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Amt (3) Amount due.
Due Dt (4) Due date.
Amt (4) Amount due.
Due Dt (5) Due date.
Amt (5) Amount due.

Activity block
Effective Dt Account effective date.
Active Dt Date account was made active.
Paid Off Dt Date account was paid off.
Chargeoff Dt Date account was charged off.
Current Pmt Current payment amount.
Due Day Due day for payment.
Last Pmt Amt Last payment amount.
Pmt Dt Last payment date.
Last Bill Amt Last bill amount.
Last Activity Dt Last activity date.
Producer Channel and producer of the account.
Behavior Score Behavior score.
App# Application number from which this account was cre-

ated.
Customer Grade Displays the customer grade.
Score Displays the score.
Military Duty If selected, indicates that at the time of billing, the cus-

tomer was in active military duty and qualifies for rates 
in accordance with Servicemembers Civil Relief Act 
(SCRA) of 2003.

Conditions block
Condition Condition.
Start Dt Start date.
Followup Dt Next follow-up date.
Alert Alert on the account (This is a message marked “alert” on 

the Comments master page or Comments sub page.)

Delinquency Information block
Late The number of times less than 30 days delinquent over 

the life of the account.
30 The number of times 30 days delinquent over the life of 

the account.
60 The number of times 60 days delinquent over the life of 

the account.
90 The number of times 90 days delinquent over the life of 

the account.
120 The number of times 120 days delinquent over the life of 

the account.
150 The number of times 150 days delinquent over the life of 

the account.
180 The number of times 180 days delinquent over the life of 

the account.
BP (Life) The number of broken promises over the life of the 

account.
NSF (Life) The number of nonsufficient funds over the life of the 

account.
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BP (Year) The number of broken promises this year.
NSF (Year) The number of nonsufficient funds this year.
Days The number of days delinquent. A negative number in 

this fields denotes the number of days until a payment is 
due.

Category The delinquency category.
Collector The default collector working on the account.

Account Details sub pages
The Accounts Details page shares the same sub pages with the Customer Details, Business 
and Vendor Work Order pages, as well as the Bankruptcy (4), Repo/Foreclosure (5), and 
Deficiency (6) master tabs: Call Activities, Promises, Comments, Checklist, Refer-
ences, Payment Rating History, and Due Date History.

Using these sub pages, you can complete the following Customer Service tasks:

• Record call activity
• Make and cancel an appointment
• Cancel a promise to pay
• View payment promises
• Record additional comments
• Complete a checklist
• Record a new reference
• View the customer’s payment rating history
• View the customer’s due date history.
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Using the Call Activities sub page
With the Call Activities sub page, Oracle Daybreak allows you to record the details of all 
actions performed regarding this account. This includes calls from the customer, calls you 
make regarding the account, or changes to the condition of the account. Entries in the Call 
Activities page are listed in reverse chronological order of follow-up date. 

Note: Call activity action codes (Action field) and call activity results codes (Results field) 
are user-defined.

The code for the call action and call result is what appears on the Call Activity sub page.

To record call activity

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Call Activities sub tab.

4 In the Action field, select the action performed.

5 In the Result field, select the result of the action.

6 If you want, complete the following optional fields:

In this field: Do this:

Contact Select who you contacted.
Reason Select the reason for the communication.

7 In the Condition field, select the condition or queue type. Conditions determine the 
queue/condition for the contents of the Action field and set the follow up data for that 
queue/condition.
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The LOV that is used in the Condition field is the intersection of the list of condition set-
ups for what is entered in the Action and Result fields and the open conditions on the 
account.

8 In the Followup Dt field, type the next follow-up date; that is, the next scheduled review. 
(This may automatically default based on setup.)

9 In the Time Zone field, view the default time zone for the customer. You can update this 
information if necessary.

10 In the Adj. Followup Dt field, view the adjusted followup date based on the contents of 
the Followup Dt and Time Zone fields. 

Note: This information appears after you save the entry.

11 Save any changes you made to the account.

Oracle Daybreak automatically creates a comment for your entry on the Comments sub 
page and master tab using the description for the call action and call result, not the code.

Making an appointment
The Appointment box on the Call Action sub page allows you to schedule an account to 
appear in a particular queue at a future date and time. When you make an appointment, the 
account will appear in the front of the queue listed in the Conditions field at the time listed 
in the Followup Dt field.

Note: You must be working that queue at the followup time in order to view the account. 

To make an appointment

1 Complete the fields on the Call Action sub page (see above, To record call activity).

2 In the Condition field, select the condition for the queue you want the account to appear 
in.

3 In the Followup Dt field, type the date and time you want the account to appear. This can 
be either the current day or a day in the future.

4 If necessary, update the Time Zone field if the customer is going to be in a different time 
zone at the time of the appointment.

5 Select the Appointment box.

Note: If account was not worked within the queue on day of the appointment, the nightly 
jobs will cancel the appointment. Also, if the account’s queue condition changes during 
the nightly batch jobs, the outstanding appointments are cancelled.
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Canceling an appointment
Using the Call Activities sub page, you can cancel an appointment for an account. The 
account will still appear in the queue on the follow up date, but no longer receive a prior-
ity.

To cancel an appointment

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Call Activities sub tab.

4 If you need to change the time for the appointment, create a new entry on the account’s 
Call Activities sub page with the same condition, but enter a new followup date.

If you need to cancel the appointment, create a new entry on the account’s Call Activi-
ties sub page with the same condition, but don’t check the Appointment check box.

5 Save any changes you made to the account.

Recording a promise to pay
If you record an action on the Call Activities sub page as a “promise to pay,” it appears on 
the Promises sub page. The Promises sub page allows you to quickly view these actions 
without searching for them individually and displays the 25 most recent promises to pay.

To record a promise to pay

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Call Activities sub tab.

4 In the Action field, select the action performed.

5 In the Result field, select PP PROMISE TO PAY.

6 If you want, complete the following optional fields:

In this field: Do this:

Contact Select the contact type. (Who was the person you com-
municated with?) (optional).

Reason Select the reason, as stated by the contacted person. 
(What is the reason for this contact?) (optional).

Promise Dt Record the date when the person you spoke with prom-
ises to make payment (optional).

Promise Amt Record the amount of the payment the person you spoke 
with promises to make (optional).

7 In the Condition field, select the condition or queue type.

8 In the Followup Dt field, enter the next follow-up date for the promise-to-pay or accept 
the default date.
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9 Save any changes you made to the account.

Oracle Daybreak automatically notes this information as an entry on the Promises and 
Comments sub pages.

Canceling a promise to pay
Oracle Daybreak allows you to cancel promises to pay with the Call Activities sub page. 
You would do this when a customer informs you prior to the promise date that he or she 
cannot make the payment. 

To cancel the existing promise to pay 

1 Open the Customer Service form and load the account (loan) you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Call Activities sub tab.

4 To find the existing promise to pay:

• Press F7 to move to Enter-Query mode.
-or-

• Select Enter Query button on the tool bar.

5 Search for the promise to pay you want to cancel using the Promise Amt field or Promise 
Dt field.

6 Press F8 to perform the query.
-or-
Select Execute Query button on the tool bar.

7 In the Call Activities sub page, select the promise you want to cancel.

8 Select the Cancel box.

9 Save the changes you made to the account.

The promise is marked as canceled and will not be considered when processing promises; 
in other words, it will not be counted as either satisfied or broken.
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Using the Promises sub page
If a call was recorded as a “promise to pay” on the Call Activities sub page, it will appear 
on the Promises sub page. The Promises sub page allows you to quickly view details about 
the call and subsequent actions and displays the 25 most recent promises to pay.

If Oracle Daybreak does not receive the promised amount before the promised time, it 
notes the broken promise on the Delinquency Information block of the Account Details 
page.

To view payment promises for an account 

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Promises sub tab.

4 View the following information:

In this field: View:

Promise Amt The amount promised.
Promise Dt The date the promise was made.
Taken By The user who took the promise.
Taken Dt The date the promise was taken.
Collected Amt The amount collected against the promise.
Broken Indicates if this is a broken promise.
Cancelled Indicates if this is a cancelled promise.
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Using the Comments sub page
Oracle Daybreak allows you to record comments on the Customer Service form using the 
Comments sub page. These comments can also appear on the Comments (10) master tab.

To record an additional comment

1 Open the Customer Service form and load the account (loan) you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Comments sub tab.

4 If you want to tag this comment as important, select the Alert box.

Note: If you select the Alert box, the comment appears on the Customer Service form’s 
Account Details page in the Alert field on the Conditions block.

5 In the Type field, select what type of comment you are adding.

6 In the Sub Type field, select what sub type of comment you are adding.

7 In the Comment field, type your comment.

8 When you are finished, save the changes you made to the account.
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Using the Checklist sub page
Oracle Daybreak allows you to create checklists to ensure that procedures are followed to 
complete various tasks. This information appears on the Checklist sub page.

To complete a checklist for an account

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Checklist sub tab.

4 In the Checklist Type field, select the type of checklist you want to complete.

5 Choose Load Checklist.

Oracle Daybreak loads the type of checklist you choose in the Checklist box and the 
checklist in the Action column.

6 As you follow the actions in the checklist, note your work with the Yes/No/NA option but-
tons. 

Note: You can add comments to each action on the checklist in the Comment column.

7 When you complete the check box, select Complete.

8 Save your entry.
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Using the Reference sub page
The References sub page allows you to attach new references to an account at anytime, as 
well as view the references attached to the account during the loan origination cycle.

To add a new reference to the account

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Reference sub tab.

4 Complete the text fields on the Reference sub page.

In this field: Do this:

Relationship Select the reference type (required).
Name Enter the reference name (required).
Yrs Enter the number of years (required).
Mths Enter the number of months (required).
Address Enter the address line 1 (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (optional).
City Enter the city (optional).
St Select the state (optional).
Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country (required).
Phone Enter the reference’s primary phone number (optional).
Ext Enter the reference’s primary phone extension (optional).
Phone Enter the reference’s secondary phone number (optional).
Ext Enter the reference’s secondary phone extension 

(optional).
Comment Enter a comment (optional).

5 Save the changes you made to the account.
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Using the Payment Rating History sub page
The Payment Rating History sub page displays the month and year of payment and the rat-
ing reported to credit bureaus through the Metro 2 file for the past 24 months.

To view a customer’s rating history

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Payment Rating History sub tab.

4 View the following display only information:

In this field: View this:

Pmt Rating The payment rating.
Description The payment rating description.
Acc Status The credit bureau account status.
Description The credit bureau account status description.
Month/Year The month/year of payment rating.
Rating The payment rating.
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Using the Due Date History sub page
The Due Date History sub page provides a delinquency history, by payment, by displaying 
a history of all due dates, along with when the actual payment was made for that due date 
and the subsequent balance. If a payment was delinquent, the Due Date History sub page 
displays the number of days the customer was delinquent against each due date.

To view a customer’s rating history

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Account Details tab or the 
Customer Details tab.

3 Choose the Due Date History sub tab.

4 View the following display only information:

In this field: View this:

Due Dt The due date.
Due Amt The due amount.
Pmt Dt The payment date.
Pmt Amt The payment amount.
Balance Amt The balance amount.
Days Past Due The days past due.
Pmt Received If selected, indicates the payment was received.
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Customer Details page
Information gathered on the Application Entry form regarding the customer and the cus-
tomer’s address, employment data, and phone numbers appears on the Customer Details 
page. Using the Customer Service form’s Customer Details page, you can update or add to 
a customer’s address, employment information, or phone listing. 

Note: Information about the customer can be changed using the Maintenance (3) master 
tab.

To view or edit customer information

1 Open the Customer Service form and load the account (loan) you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Customer Details tab.

3 Load the customer whose information you want to edit or enhance. Use the scroll bar on 
the right of the Customer block to view all the customers associated with this account. 

In this field: View this:

Customer # Customer number (display only).
Relation Customer’s relationship to the account (display only).
ECOA Customer’s Equal Credit Opportunity Act code (display 

only).
Name Customer’s name (display only).
SSN Customer’s social security number. Note: If the organiza-

tional parameter UIX_HIDE_RESTRICTED_DATA is set 
to Y, this appears as a masked number; for example, 
XXX-XX-1234(display only).

Birth Dt Customer’s date of birth (display only).
Language Customer’s language (display only).
Marital St Customer’s marital status (display only).
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Enabled Customer’s enabled indicator (display only).
Dependents Customer’s number of dependents (display only).
License # Customer’s driving license number (display only).
State Customer’s driving license state (display only).
Mothers Maiden Name Customer’s mother’s maiden name (display only).
Email Customer’s email address (display only).
Class Customer’s classification type (display only).
Time Zone Customer’s time zone (display only).
Stop Correspondence Customer’s stop correspondence indicator. If selected, 

this indicates that Oracle Daybreak will not send the cus-
tomer any correspondence, such as monthly statements. 
This is selected using the Maintenance (3) master tab 
(display only).

Disability Customer’s disability indicator (display only).
Skip Customer’s skip indicator. If selected, this indicates that 

the customer is a skip debtor.This is selected using the 
Maintenance (3) master tab (display only).

Privacy Opt-Out Privacy opt-out indicator. If selected, indicates that the 
applicant has elected to refrain from the non-public shar-
ing of information (optional).

4 To change or add an address, use the Address block text boxes:

In this field: Do this:

Type Select the address type (required).
Postal Type Select the postal address type (required).
# Enter the building number (optional).
Pre Select the street prefix (directional).
Street Name Enter the street name (optional).
Street Type Select the street type (optional).
Post Select the street postfix (directional).
Apt (#) Enter the apartment number (optional).
Address 1 (unlabeled) View the address as entered on line 1 (display only).
Address 2 (unlabeled) Enter address line 2 (optional).
Zip Extension Select the zip code (required).
City Enter the city (required).
St Select the state code (required).
Extension (unlabeled) Enter the zip + 4 extension (required).
Country Select the country (required).
Ph Enter the phone number (required).
Census Tract Enter census tract/BNA code (optional).
MSA Code Enter the metropolitan statistical area (MSA) code 

(optional).
Comment Enter a comment (optional).

• If this is the customer’s current address, select Current.

• If this is the customer’s mailing address, select Mailing.
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5 If the customer is in the military, view the following display only information in the Mili-
tary Services block:

In this field: View this:

Active Military Duty Active military duty indicator. If selected, indicates that 
the customer is on active military duty and may qualify 
for the rates in accordance with the Servicemembers 
Civil Relief Act of 2003 (SCRA).

Order Ref # The order reference number.
Effective Dt The effective date. This is the date the Active Military 

Duty indicator was selected.
Released Dt The release date. This is the date the customer was 

released from active military duty.

6 To edit a customer’s employment information, use the Employment block text boxes:

In this field: Do this:

Type Select the occupation (required).
Employer Enter the employer’s name (required).
# Enter the building number (optional).
Address 1 (unlabeled) Enter the address line 1 (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (optional).
City Enter the city (optional).
St Select the state (optional).
Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country (required).
Occupation Select the occupation (optional).
Title Enter the title (optional).
Ph Enter the work phone number (required).
Ph Extension Enter the work phone number extension (optional).
Comment Enter a comment (optional).

• If this is a customer’s current place of employment, select Current.

7 To record additional phone numbers, use the Telecom block.

In this field: Do this:

Telecom Type Select the telecommunication type (required).
Phone Enter the phone number (required).
Extn Enter the phone extension (optional).
Start Time Enter the best time to call start time (optional).
Time Period (unlabeled) Select the time period for the best time to call start time, 

AM or PM (optional).
End Time Enter the best time to call end time (optional).
Time Period (unlabeled) Select the time period for the best time to call end time, 

AM or PM (optional).
Time Zone Select the applicant’s time zone (optional).
Current Select if this telecom number is current (required).

8 Save any changes you made to the account.

Note: Sub pages for the Customer Details page are described in the Account Details sub 
pages section of this chapter.
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Business page
If this is a SME loan, information gathered on the Application Entry form regarding the 
business and the business’s address, partners and affiliates data, and phone numbers 
appears on the Business page. Using the Customer Service form’s Business page, you can 
update or add to a business’s address, partners and affiliates information, or phone listing. 

To view or edit business information

1 Open the Customer Service form and load the account (loan) you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Business tab.

3 Load the business whose information you want to edit or enhance. Use the scroll bar on 
the right of the Business block to view all the businesses associated with this account. 

In this field: View this:

Organization Type Organization type.
Type of Business Type of the business.
Name of the Business Name of the business.
Legal Name Legal name of the business.
Tax Id # Tax identification number.
Start Date Business start date.
# of Employees (Curr) Current number of employees at the business.
# of Employees Number of employees at the business after financing.
Contact Person Contact person at the business.
Business Checking Bank Bank name of the business’s checking account.
Bank Account Number Bank account number.
Average Checking Balance Average checking balance.
# of Locations Number of locations of the business.
Management Since Year the current management was established.
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4 To change or add an address, use the Address block text boxes:

In this field: Do this:

Type Select the address type (required).
Postal Type Select the postal address type (required).
# Enter the building number (required).
Pre Select the street prefix (directional) (optional).
Street Name Enter street name (optional).
Street Type Select the street type (optional).
Post Select the street postfix (directional) (optional).
Apt # Enter the apartment number (optional).
Address Enter the address (required).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (required).
City Enter the city (required).
St Select the state (required).
Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country code (required).
Ph Enter the phone number (required).
Own / Rent Select the ownership type (required).
Comment Enter a comment (optional).

• If this is the business’s current address, select Current.

• If this is the business’s mailing address, select Mailing.

5 To record additional phone numbers for the business, use the Telecom block.

In this field: Do this:

Telecom Type Select the telecommunication type (required).
Phone Enter the phone number (required).
Ext Enter the phone extension (optional).
Current If selected, indicates that this is the current record.
Time Zone Select the applicant’s time zone (optional).
Current Select if this telecom number is current (required).

6 To edit a business’s partners information, use the Partners block text boxes:

In this field: View this:

First Name Enter the partner’s first name (required).
MI Select the partner’s middle name (optional).
Last Name Enter the partner’s last name (required).
Suffix Enter the partner’s suffix (optional).
SSN Enter the partner’s social security number (required).
Birth Dt Enter the partner’s birth date (required).
Birth Place Enter the partner’s birth place (optional).
Networth Enter the partner’s net worth (required).
Gross Income Enter the partner’s gross income. (required).
Language Enter the partner’s language (required).
Nationality Enter the partner’s nationality (optional).
Title Select the partner’s title (optional).
Ownership (%) Enter the percentage of ownership held by the customer 

(required).
Email Enter the partner’s email (optional).
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Phone Enter the partner’s phone (required).
Extn Enter the partner’s phone extension (optional).

7 To edit a business’s affiliate information, use the Affiliates block text boxes:

In this field: Do this:

Organization Type Select the affiliate’s organization type (required)
Legal Name Enter the affiliate’s legal name (required)
Business Name Enter the affiliate’s business name (required)
Tax ID Enter the affiliate’s tax identification (required)
Ownership (%) Enter the affiliate’s percentage of ownership (required)
No of Employees Enter the affiliate’s number of employees (required)
NAICS CODE Enter the affiliate’s North American Industry Classifica-

tion System code (required).

8 Save any changes you made to the account.

Note: Sub pages for the Customer Details page are described in the Account Details sub 
pages section of this chapter.
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Balances page
Details of an account’s balance can be viewed on the Balance page. The Balances page 
contains four action buttons in the Balance Group block: Current Balance, Deficiency Bal-
ance, Non-Performing Balance, and Terminate Balance. 

Depending on which one you select, a different set of balance information appears. In all 
cases, the Balance page can be viewed in two transaction period modes: ITD/CTD (Incep-
tion-to-date: loans)/Cycle-to-date: line of credit) and YTD (year-to-date).

To view account balance information

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Balances tab.

3  In the Balance Group block, select the balance you want to view.

• Current Balance displays the current balances for accounts with an status of ACTIVE. If 
you choose Current Balance, the following information appears:

In this field: View:

Balance Type The balance type.
Opening Balance The opening balance amount.
Posted The amount posted (in addition to the opening balance).
Paid The amount paid.
Waived The amount waived.
Charged Off The amount charged off.
Adjusted (-) The amount adjusted (negative adjustments).
Adjusted (+) The amount adjusted (positive adjustments).
Balance The current (closing) balance.
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Total Balance The total of the account balance.

• Deficiency Balance displays the current balances for accounts with an status of 
CHARGED OFF. If you choose Deficiency Balance, the following information appears:

In this field: View:

Balance Type The balance type.
Opening Deficiency The opening deficiency balance.
Chargeoff Posted The additional charged off amounts posted.
Recovery The amount of deficiency balance paid.
Deficiency Balance The current (closing) deficiency balance.
Deficiency Balance (total) The total deficiency balance.

• Non-Performing Balance displays the current balance for accounts with an status of 
NON-PERFORMING. Non-Performing accounts fall between CHARGED OFF accounts and 
ACTIVE accounts. These accounts are treated as active when dealing with the customer, 
but for accounting purposes are treated differently as they are expected to charge off in the 
future. Fee and interest balances are not expected to be collected in full and therefore are 
not recognized as income. If you choose Non-Performing Balance, the following infor-
mation appears:

In this field: View:

Balance Type The balance type.
Opening Non-Performing The opening nonperforming balance.
Paid The amount of nonperforming balance paid.
Paid Excess The additional nonperforming amounts posted.
Waived The amount waived.
Adjusted (-) The amount adjusted (Negative adjustments).
Adjusted (+) The amount adjusted (Positive adjustments).
Balance The current (Closing) nonperforming balance.
Total Balance The total deficiency balance.

4 In the Txn Period block, choose how you want to view the balance:

• Choose ITD/CTD to view transactions by Inception-to-date (loans)/Cycle-to-date (line of 
credit)
-or-

• Choose YTD to view the transactions by year to date. 
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Transactions page
The Transaction page displays all transactions with a monetary impact that have occurred 
over the life of the account. Transactions can be sorted by when the transaction was made 
effective (Post Dt) or the date the transaction was created (Txn Dt). You can also choose to 
view all transactions or reverse certain transactions. This information comes from the pay-
ments and advances applied to the account, maintenance tasks, and nightly processes such 
as billing.

To view the transaction history of an account

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Transactions tab.

3 In the View Options block, select the type of transactions in this account’s history you 
want to view in the Transactions block.

If you select this: Oracle Daybreak displays:

Good Payments All valid payments that were neither voided nor reversed.
All Payments All transaction involving payments.
Good Txns All transactions that were neither voided nor reversed.
All Txns All transactions.

4 In the Sort By block, choose Post Dt to sort the entries on in the Transactions block in 
order of when the transaction was made effective. 

-or-
Choose Txn Dt to sort the entries on in the Transactions block in order of when the trans-
action was created.

In either case, Oracle Daybreak displays the following information:

In this field: View:

Transactions block
Post Dt The transaction posting date.
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Txn Dt The transaction effective date.
Txn Description The transaction details.
Txn Amt The transaction amount.
Txn Details The transaction details.
Balance Amt The balance amount. Note: This is the principal balance, 

not the total balance amount.
Details block
Txn The transaction allocation details.
Amt The transaction allocation amount.
Description block
Payment Type The payment type.
Reference The reference number associated with the transaction.
Mode The mode of the transaction.
Reason The reason for the transaction.

To reverse (or void) a transaction 

1 Load the account with the transaction you want to void using the Customer Service form.

2 Choose the Customer Service (2) master tab, then choose the Transactions tab.

3 In the Transactions block list box, select the transaction you want to reverse in the Txn 
Description column. (You may have to use the scroll bar to find the transaction).

4 In the Action block, choose Reverse.

Note: Some transactions cannot be reversed. If a transaction cannot be reversed, the 
Reverse button will be dimmed when the transaction is selected. 

In this example, the Reverse button is available. The transaction ADJUSTMENT TO SER-
VICING EXPENSES - ADD can be reversed.
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In this example, the Reverse button is unavailable. The transaction PAYMENT (Y) cannot 
be reversed.

Access to the Reverse button can be restricted by user responsibility and the account’s 
product type using the PAYMENT_REV transaction code (Super Group: ACCOUNT 
MONETARY TXN) on the Administration form. (For more information, see the Txn Codes 
page section in the Oracle Daybreak Lending Suite Setup Guide).

To void an account

Oracle Daybreak can be configured to void an account using the Reverse button on the 
Transaction page. 

1 Load the account you want to void using the Customer Service form.

2 Choose the Customer Service (2) master tab, then choose the Transactions tab.

3 In the View Option block of the Transactions page, choose Good Txns.

4 In the Transactions block, select the ACTIVE entry in the Txn Description field.

5 In the Action block, choose Reverse.

In the Transactions block, Oracle Daybreak creates an entry of REVERSE ACTIVE and 
reverses all transactions. Oracle Daybreak also changes the status of the account to 
CLOSED: VOID and changes the status of the application to APPROVED-VOID (or what-
ever the account’s last status was before funding).

Note: To use this feature, the ACTIVE _REV transaction code must be enabled and set to 
manual on the Administration form for your user responsibility and account’s product 
type. For more information, see the Txn Codes page section in the Oracle Daybreak 
Lending Suite Setup Guide.
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Tracking Attributes page
The Tracking Attributes page allows you to link information to an account that is not 
tracked by default in the Oracle Daybreak system, but is part of your company’s business 
practices; for example, the location of important documents, how customers receive pay-
checks, or the hint questions for remembering a PIN number. Such attributes are defined 
during system setup.

To track attributes on the Customer Service (2) master tab

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Tracking Attributes tab.

3 Choose Create Tracking.

Oracle Daybreak loads the tracking parameters.

4 If you want to reduce the list of parameters, select a sub-attribute in the Sub Attribute 
box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the Parameter display.

5 Complete the Tracking block by entering the requested parameter in the Value field.

6 Save any changes you made to the account.
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Balances, Transactions, Tracking Attributes, and Insurances pages’ 
sub pages

The Balances, Transactions, Tracking Attributes, and Insurances pages share the following 
sub pages: 

• Loan Details (fixed rate and variable rate loans only)
• Rate Schedule (variable rate loans only)
• Addl Loan Details
• Repayment Schedule
• ACH
• Coupon
• LoC Balance Details
• Card Details

Note: Depending on the type of loan and the method of payment, only certain sub pages 
will be available.

Loan Details sub page 
The Loan Details sub page for fixed rate loans contains further information about the loan, 
including interest and accruals, extensions and due dates, and additional details.

To view the Loan Details sub page for fixed rate loans

1 Open the Customer Service form and load the loan account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Balances, Transactions, 
Tracking Attributes, or Insurances tab.

3 Choose the Loan Details sub tab.

4 View the following fixed rate loan information on the Loan Details sub page: 

In this field: View:
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Interest and Accruals block
Rate The current rate.
Last Rate Change Dt The last rate change date.
Accrual Start Dt The accrual start date.
# of Rate Changes (Year) The number of rate changes (year).
Last Accrual Dt The last accrual date.
# of Rate Changes (Life) The number of rate changes (life).
Stop Accrual The stop accrual indicator. If selected, indicates that not 

interest is currently accrued.
Rate Start Of Year The rate at start of the year.
Accrual Mthd The current accrual calculation method.
Rebate Mthd The current rebate calculation method.

Extensions and Due Dates block
# of Extensions (Year) The number of times extensions granted (year).
# of Extensions (Life) The number of times extensions granted (life).
# of Extension Term (Year) The number of terms extensions granted (year).
# of Extension Term (Life) The number of terms extensions granted (life).
# of Due Day Changes (Year) The number of due date changes (year).
# of Due Day Changes (Life) The number of due date changes (life).
Last Extn Dt The last extension date.
Due Day Chg Dt The last due date change date.

Additional Details block
Total Term The total term.
Paid Term The paid term.
Maturity Dt The maturity date.
Balloon Amt The balloon amount.

Rate Schedule sub page
The Rate Schedule sub page contains information about rate adjustments, such as the 
sequence and number of adjustments. The Rate Schedule sub page only applies to variable 
rate loans.

To view the Rate Schedule sub page

1 Open the Customer Service form and load the loan account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Balances, Transactions, 
Tracking Attributes, or Insurances tab.

3 Choose the Rate Schedule sub tab.
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4 View the following loan information on the Rate Schedule sub tab: 

In this field: View:

Rate Schedule block
Seq The sequence number for rate adjustment.
Adjustment Frequency Type The rate adjustment frequency type.
Period The rate adjustment period for the frequency.
# of Adjustments The number of rate adjustments for the frequency.

Addl. Loan Details sub page
The Addl. Loan Details sub page contains further information about the loan, such as the 
advance and securitization details.

To view the Addl. Loan Details sub page

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Balances, Transactions, 
Tracking Attributes, or Insurances tab.

3 Choose the Addl. Loan Details sub tab.
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4 View the following information on the Addl. Loan Details sub tab:

In this field: View:

Advance Details block
Approved Amt The sanctioned amount.
Consumed The total consumed.
Remaining Amt The advance balance.
Last Advance The last advance balance.
Last Adv. Dt The last advance date.

Securitization Details block
Pool Id The the pool id.
Pool Status The pool account status.
Pool Sale Dt The pool sale date.
Repurchase If selected, indicates that repurchasing is allowed.
Dt The repurchase date.

Repayment Schedule sub page
The Repayment Schedule contains information about the schedule of repayment such as 
the date and payment amount.

To view the Repayment Schedule sub page

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Balances, Transactions, 
Tracking Attributes, or Insurances tab.

3 Choose the Repayment Schedule sub tab.
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4 View the following information on the Repayment Schedule sub tab: 

In this field: View:

Repayment Schedule block
Seq The payment sequence number.
Date The repayment date.
# of Pmts The number of payments.
Pmt Amt The payment amount.
Generated If selected, indicates that the repayment schedule has 

been generated.

ACH sub page
If the account uses an automated clearinghouse method of payment, then the ACH sub 
page is available. The ACH sub page displays information about automated clearinghouse 
and electronic fund transfers. This information can be edited using the Maintenance (3) 
master tab and the nonmonetary transaction ACH MAINTENANCE.

To view the ACH sub page

1 Open the Customer Service form and load the account with the ACH you want to work 
with.

2 Choose the Customer Service (2) master tab, then choose the Balances, Transactions, 
Tracking Attributes, or Insurances tab.
Chapter 2 :-39   User Guide - Consumer Loans Servicing 



3 Choose the ACH sub tab.

4 View the following information on the ACH sub page: 

In this field: View:

Bank Information block
ACH If selected, indicates that ACH is enabled.
Bank The bank name.
Start Dt The ACH start date.
Routing # The routing number.
Account Type The account type.
Account # The account number. Note: If the organizational parame-

ter UIX_HIDE_RESTRICTED_DATA is set to Y, this 
appears as a masked number; for example, 
XXXXX1234.

ACH Debit Amt The payment amount.
Debit Freq The payment frequency.
Debit Day The payment day.

Coupon sub page
If the account uses a coupon book method of payment, then the Coupon sub page is avail-
able. The Coupon sub page displays coupon order information and whether another book 
has been ordered. This information can be edited using the Maintenance (3) master tab and 
the nonmonetary transaction COUPON BOOK MAINTENANCE.

To view the Coupon sub page

1 Open the Customer Service form and load the account with the coupon you want to work 
with.

2 Choose the Customer Service (2) master tab, then choose the Balances, Transactions, 
Tracking Attributes, or Insurances tab.
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3 Choose the Coupon sub tab.

4 View the following coupon information on the Coupon sub page:

In this field: View:

Coupon Book Information block
Order If selected, indicates coupon book is ordered.
Order Dt The coupon book order date.
Ordered By The user id of the user who ordered the coupon book.
# of Coupons The number of coupons.
First Pmt Dt The first payment date.
Coupon Starting # The starting number of the coupon book.
First Coupon Dt The first coupon date.
Coupon Ending # The ending number of the coupon book.
Last Coupon Dt The last coupon date.
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Card Details sub page
The Card Details sub page displays information regarding credit cards associated with the 
account. 

To view the Card Details sub page

1 Open the Customer Service form and load the account with the promotion details you 
want to work with.

2 Choose the Customer Service (2) master tab, then choose the Balances, Transactions, 
Tracking Attributes, or Insurances tab.

3 Choose the Card Details sub tab.

4 View the following display only credit card details on the Card Details sub page:

In this field: View:

Credit Card Details block
Card Type The credit card type.
Start Dt The credit card start date.
Card Company The credit card company.
Card # The credit card number.
Expiration Dt The expiration date.
Pmt Amt The card payment amount.
Billing Address The billing address for the credit card.
Zip The zip code for the billing address for the credit card.
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Statements page
The Statements page contains three display only blocks. The Statements block displays a 
list all the statements generated during the life of the account. The Transaction block dis-
plays monetary transactions applied to the account from the closing date of the previous 
statement through the closing date of the current statement. The Messages block displays 
the user-defined message that appears in the statement.

To view the Statements page

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Statements tab.

The Statements block displays the following information:

In this field: View:

Closing Dt The statement closing date.
Due Dt The statement due date.
Generation Dt The statement generation date.

3 In the Statements block, select the statement you to view.

Oracle Daybreak displays the following information for the selected statement in the 
Transactions and Messages block.

In this field: View:

Transactions block
Txn Dt The transaction effective date.
Description The transaction.
Amount The transaction amount.

Messages block
Seq # The sequence number.
Message The message.

The Statements pages has three sub pages: Loan one of which will appear depending on 
what kind of account you have loaded. 
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4 View the statement details on the available sub page.

• If the Loan sub page for fixed rate loans is available, view the following information:

In this field: View:

Statement Details block
Current Balance The current balance.
Current Due The current due.
(+) Past Due The past due amount.
(+) Late Charge The late charge due.
(+) Other Charges The other charges due.
= Total Due The total due.
Payoff Dt The payoff date.
Payoff Amt The payoff amount.

Escrow block
Current Balance The current escrow balance.
Current Due The current escrow due.
Past Due The past due escrow amount.

• If the Loan sub page for variable rate loans is available, view the following information:

In this field: View:

Statement Details block
Current Balance The current balance.
Current Due The current due.
(+) Past Due The past due amount.
(+) Late Charge The late charge due.
(+) Other Charges The other charges due.
= Total Due The total due.
Payoff Dt The payoff date.
Payoff Amt The payoff amount.

Rate block
Last Rate Change Dt The last rate change date.
Current Rate The current rate.

Escrow block
Current Balance The current escrow balance.
Current Due The current escrow due.
Past Due The past due escrow amount.
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Escrow page
The Escrow page is a display only page that allows you to view escrow details such as the 
escrow amount due, current escrow payment, escrow balances, and whether escrow analy-
sis is required. The Escrow page contains two sub pages, the Escrow Details sub page and 
the Escrow Transactions sub page.

Note: The Escrow page is only available if escrow is allowed for the account. 

To view the Escrow page

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Escrow tab.

3 In the Escrow Due block, view the following information:

In this field: View:

Escrow Amt Due The escrow amount due on the account belonging to the 
escrow balance type (this is the sum of Amt due 1 to Amt 
due 5).

Due Dt (1) The due date.
Amt (1) The amount due.
Due Dt (2) The due date.
Amt (2) The amount due.
Due Dt (3) The due date.
Amt (3) The amount due.
Due Dt (4) The due date.
Amt (4) The amount due.
Due Dt (5) The due date.
Amt (5) The amount due.
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4 The Escrow block contains the following check boxes related to the escrow:

Check box: If selected, then:

Escrow Allowed Escrow is allowed for this account.
Opt Out Customer has optioned out of escrow.
Analysis Required Analysis of this escrow is required. Escrow analysis can 

be performed with the Escrow Analysis and Disburse-
ments form (for more information, see the Escrow Analy-
sis chapter in this User Guide).

Stop Disbursement Disbursement is stopped. Note: Escrow disbursement can 
be stopped or resumed using a nonmonetary transaction 
on the Maintenance (3) master tab.

Stop Analysis Escrow is stopped. Note: Escrow analysis can be stopped 
or resumed using a nonmonetary transaction on the 
Maintenance (3) master tab.

5 In the Escrow Payment block, view the following information:

In this field: View:

Current Escrow Pmt The current escrow payment amount. This is the standard 
escrow installment due every term.

6 In the Escrow Balance block, choose how you want to view the escrow:

If you choose: Oracle Daybreak displays:

ITD Transactions by inception to date.
YTD Transactions by year to date. 

7 In the Escrow Balance block, view the following information:

In this field: View:

Opening Balance The opening balance.
Received The received balance.
Interest Received The interest received balance.
Disbursed The disbursement balance.
Adjusted (-) The amount adjusted (negative).
Adjusted (+) The amount adjusted (positive).
Balance The current balance.
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Escrow Details sub page
The Escrow page contains two sub pages: Escrow Details and Escrow Transactions. The 
Escrow Details sub page displays additional information regarding the escrow, while the 
Escrow Transaction sub page displays monetary and nonmonetary escrow transactions, 
such as payments made towards the escrow balance and disbursements made from the 
escrow balance.

To view the Escrow Details sub page

1 Open the Customer Service form and load the escrow account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Escrow tab.

3 Choose the Escrow Details sub tab.

4 In the Escrow Type and Sub Type fields, view the escrow type and sub type. (Use the 
scroll bar to select different escrow types.)

5 The Escrow Details sub page indicators display the following information:

Indicator: If selected, then:

Required Escrow Escrow is required.
Cushion Allowed Cushion is allowed.
Opt Out Customer has optioned out of the escrow.
Current Escrow is current.

6 In the Disbursement block, view the following information:

In this field: View:

Rule The rule.
Vendor The vendor name.
Account # The account number. Note: If the organizational parame-

ter UIX_HIDE_RESTRICTED_DATA is set to Y, this 
appears as a masked number; for example, 
XXXXX1234.

Maturity Dt The maturity date.
Yearly Amt The yearly amount.
Next Disb Dt The next disbursement date.
Last Disb Dt The last disbursement date.

7 In the Insurance block, view the following information:

In this field: View:

Coverage Type The coverage type.
Policy # The policy number.
Coverage Amt The coverage amount.
Coverage Term The coverage term.
Effective Dt The effective date.
Expiration Dt The expiration date.

8 In the Tax block, view the following information:

In this field: View:

Property Tax The property tax.
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To view the Escrow Transactions sub page

1 Open the Customer Service form and load the escrow account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Escrow tab.

3 Choose the Escrow Transactions sub tab.

4 In the Sort By block, select how you want to view the information:

If you choose: Oracle Daybreak:

Post Dt Sorts the entries in order of when the escrow transaction 
was created. 

Txn Dt Sorts the entries in order of when the escrow transaction 
occurred.

5 In the View Options block, select how you want to view the information:

If you choose: Oracle Daybreak displays:

Payments Transactions involving payments.
Disbursements Transactions involving disbursements.
All Txns All transactions.

6 In the Escrow Transactions sub page list box, view the following information:

In this field: View:

Post Dt The post date.
Txn Dt The transaction description.
Txn Description The transaction description.
Txn Amt The transaction amount.
Txn Details The transaction details.

Oracle Daybreak creates a requisition when it posts an escrow disbursement. You can 
view escrow disbursements on the AP Transactions form when you choose Vendor in the 
Payee Type block. For more information, see the Accounts Payable (Requisitions) 
chapter in this User Guide.
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Insurances page
If during the loan origination, the Insurance sub page was completed on the Funding form, 
you can view the financed insurance information on the Customer Service form’s Insur-
ances page. The Insurances page displays detail information related to all financed insur-
ances, including cancellation and refund information whenever applicable. It also displays 
the insurances that were financed after funding of the loan using the Maintenance (3) mas-
ter tab.

To view the Insurances page

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Insurances tab.

3 In the Insurance block, view the following display only information:

In this field: View:

Policy Information:
Contractual If selected, indicates that the insurance policy is required 

by contract.
Insurance Type The insurance type.
Sub Type The insurance sub type.
Status The insurance status.
Insurance Plan The insurance plan.
Insurance Mode The insurance mode.
Itemization The contract itemization.
Company The insurance company.
Policy Number The insurance policy number.
Phone No The insurance company’s primary phone number.
Ext The insurance company’s primary phone extension.
Policy Number The insurance policy number.
Phone No The insurance company’s alternate phone number.
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Ext The insurance company’s alternate phone extension.
Effective Dt The insurance effective date.
Expiration Dt The insurance expiry date.
Premium Amt The insurance premium amount.
Term The insurance term.
Commission Rule The insurance premium amount.
Commission Amt The insurance commission amount.
Primary (Beneficiary) The primary beneficiary of the insurance.
Secondary (Beneficiary) The secondary beneficiary of the insurance.
Comments The comments regarding the insurance policy.

Cancellation/Refund block:
Policy Cancellation Dt The insurance cancellation date.
Term Remaining The remaining term on the insurance at cancellation.
Refund Allowed If selected, a refund is allowed. A selected box indicates 

that the insurance premium can be rebated to the cus-
tomer in case of early payoff.

Refund Method The refund calculation method.
Estimated Refund Amt The estimated insurance refund.
Received Refund Amt The insurance refund received.
Complete Refund If selected, a complete refund is allowed.
Grace Day’s Cancellation If selected, indicates that cancellation fees during grace
Fee Allowed period is allowed.
Grace Days   View the number of grace days allowed for cancellation 

without charging a cancellation fee.
Cancellation Fee View the amount of the cancellation fee to be charged 

when the insurance is cancelled.

4 In the Insurance Tracking block, choose Create Tracking.

Oracle Daybreak loads the insurance tracking parameters in the Insurance Tracking block.

5 If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the parameter display.

6 Complete the Insurance Tracking block.

7 Save your entry.
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Vendor Work Order page
To expedite repossessions and foreclosures, the display only Vendor Work Order page 
allows you to view all the work orders issued to different vendors for an account.

To view the Statements page

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Customer Service (2) master tab, then choose the Vendor Work Order tab.

3 In the Vendor Work Order block, view the following display only information:

In this field: View this:

Work Order #                     The work order number.
Dt                                    The assignment date.
Estimated The estimated dollar amount of work order.
Type                                      The assigned type.
Vendor                                  The vendor number and name.
Status                                    The assigned status.
Total Amt The total estimated dollar amount of all work orders.

4 Select the work order in the Vendor Work Order block you want to view and choose View 
Work Order.

Note: The View Work Order button appears dimmed if your responsibility does not allow 
access to the Vendor form.

Oracle Daybreak opens the Vendor Management form’s Work Orders page with informa-
tion about that work order. You can then perform tasks and record additional information, 
such as changing the work order’s status and adding comments on the Work Orders page.
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Maintenance (3) master tab
The Maintenance (3) master tab acts as a single command stations that allows you to post 
a wide array of monetary and nonmonetary transactions for any given account. The trans-
actions available depend on the nature of the account, whether it is a loan. This section 
explains how to complete the following tasks:

Monetary tasks
Loan:
• Apply, adjust, or waive servicing expenses
• Adjust or waive late charges
• Adjust or waive nonsufficient funds
• Apply, adjust, or waive repossession expenses
• Apply, adjust, or waive bankruptcy expenses
• Apply or adjust phone pay fees
• Change an index/margin rate
• Apply, adjust, or cancel financed insurance
• Generate a payoff quote
• Payoff an account
• Charge-off an account
• Close an account
• Adjust, charge-off, or waive the advance/principal balance
• Adjust the interest balance
• Stop interest accrual
• Indicate a borrower as on or off active military duty
• Change a due date
• Apply, adjust, or waive an extension fee
• Change payment amount
• Adjust or waive a prepayment penalty
• Reschedule an escrow payment
• Adjust or waive an escrow payment
• Adjust or waive a payoff quote fee
• Place an account in a nonperforming condition
• Reverse a nonperforming condition
• Reschedule precompute loan to interest bearing loan

Nonmonetary tasks
Loan :
• Update a customer’s name
• Maintain customer details
• Mark a customer as a skipped debtor
• Change a customer’s Privacy Opt-Out indicator
• Stop correspondence
• Modify financed insurance information
• Start or stop an ACH
• Reprint a statement (batch only)
• Create or cancel a one time ACH - phone pay
• Re-order coupon books
• Cancel or adjust an ESC 
• Apply a refund payment to an ESC 
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• Cancel insurance (or reverse the insurance cancellation)
• Add new escrow insurance details
• Add new escrow tax details
• Change insurance annual disbursement
• Change insurance disbursement plan
• Change escrow indicators of insurance
• Change insurance expiration date
• Change insurance maturity date
• Change tax annual disbursement
• Change tax disbursement plan
• Change escrow indicators of tax
• Resume escrow analysis
• Resume escrow disbursements
• Stop escrow analysis
• Stop escrow disbursements
• Refund or adjust insurance

Oracle Daybreak allows you to post a monetary transaction immediately or submit it for 
nightly processing. The transaction is identified as either a “real-time” or nightly batch 
transaction in Oracle Daybreak’s transaction setup codes. Oracle Daybreak also allows 
you to cancel the future dated transactions or the transaction that have been submitted for 
nightly processing. All the activity on the account, including who performed it and a date 
and time stamp, is captured in the audit trail.

A note about verifying transactions:

You can set up transactions so that they must be validated by a different Oracle Daybreak 
user. With this authorization process, you can view these transactions on the Transaction 
Authorization form before they are posted. When you post such transaction on the Mainte-
nance (3) master tab, they receive a status of WAITING FOR AUTHORIZATION. For more 
information, see the chapter Transaction Authorization (Maker-Checker) in this User 
Guide.
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Using the Maintenance page for monetary and nonmonetary transac-
tions

All of the monetary and nonmonetary tasks listed in Appendix C: Transaction Parame-
ters use the Maintenance page. Each task requires a Transaction value and a Parameter 
value. 

To use the Maintenance page to complete monetary transactions

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Maintenance (3) master tab.

3 In the Action block:

• Select the Monetary box to complete a monetary transaction
-or-

• Clear the Monetary box to complete a nonmonetary transaction.

4 In the Transaction field, select the transaction for the task you want to complete. Transac-
tion availability depends on the type of account (loan), whether the transaction is mone-
tary or nonmonetary, and user responsibility.

5 During set up, you can choose to process a transaction in real time or as a batch transac-
tion.

• If a transaction will be performed in a batch transaction, the Batch box appears selected.

• If a transaction will be performed in real time, the Batch box appears cleared. 

6 Choose Load Parameters.

7 Enter all the required parameter values and choose Post.

Oracle Daybreak displays the results (success, failure, or waiting for authorization) in the 
Results block “Transaction Processing Details” list.
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Transactions page (A reminder)
As discussed earlier in this chapter, the Transactions page displays transactions with a 
monetary impact that have occurred over the life of the account. The Transaction page also 
allows you to view transactions or reverse certain transactions you manually perform on 
the Maintenance page. For more information, see the Transaction page section of this 
chapter.
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Bankruptcy (4) master tab
The Bankruptcy page allows you to record the details of a bankruptcy. This information 
usually is supplied from the customer or customer’s attorney. You can track each stage of 
the bankruptcy process based on its follow-up date and record information using the 
Details and Tracking blocks. 

As there are occasions when a borrower files bankruptcy more than once during the tenure 
of the loan, you can record information for multiple bankruptcies. The Create New Bank-
ruptcy button enables you to create a new bankruptcy record with different start and end 
dates. You can also use the Bankruptcy page to view the previous bankruptcy record using 
the scroll bar in the Details block. The Current box in the Details block indicates the cur-
rent bankruptcy details.

To enter bankruptcy details for an account

1 Using the Customer Service form, load the account you want to add bankruptcy details 
to and choose the Bankruptcy (4) master tab.

2 If there is a previous bankruptcy record in the Details block, choose Create New Bank-
ruptcy to refresh the Bankruptcy page.

3 Complete the Details block.

In this field: Do this:

Current box Select to indicate this is the current bankruptcy record.
Followup Dt Enter the follow-up date for the bankruptcy (required).
File Received Dt Enter the file received date for the bankruptcy (optional).
Disposition Select the bankruptcy disposition (required).
Bankruptcy Start Dt Enter the bankruptcy start date (optional).
Type Select the bankruptcy type (optional).
Bankruptcy End Dt Enter the bankruptcy end date (optional).
Comment Enter a comment (optional).
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4 Choose Create Tracking.

Oracle Daybreak loads the bankruptcy tracking parameters.

5 If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the parameter display.

6 Complete the Tracking block.

7 Save your entry.

Note: Sub pages for the Bankruptcy page are described in the Account Details sub 
pages section of this chapter.
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Repo/Foreclosure (5) master tab
The Repo/Foreclosure (5) master tab allows you to record information regarding reposses-
sions on the Repossession page or foreclosures on the Foreclosure page in a manner simi-
lar to how bankruptcies are recorded on the Bankruptcy page. You can track each stage of 
the repossession or foreclosure process based on the follow-up date and record informa-
tion using the Details and Tracking blocks. 

On occasion, a lender performs multiple foreclosures or repossessions for the same loan. 
The Create New Fore Closure buttons on the Repossession and Foreclosure pages enable 
you to create a new repossession or foreclosure record for a different collateral and differ-
ent start and end dates. You can also use the Repossession and Foreclosure pages to view 
the previous repossession or foreclosure information using the scroll bar in the Details 
block. The Current box in the Details block indicates the current repossession or foreclo-
sure record for each asset. 

You can update the current record, but previous records cannot be modified.

To enter repossession details for an account

1 Using the Customer Service form, load the account you want to add repossession details to 
and choose the Repo/Foreclosure (5) master tab, then choose Repossession.

Note: If there is a previous repossession record in the Details block, choose Create New 
Repossession to refresh the Repossession page.

2 Complete the Details block.

In this field: Do this:

Current box Select to indicate this is the current repossession/foreclo-
sure record.

Followup Dt Enter the follow-up date for the repossession/foreclosure 
(required).
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File Received Dt Enter the file received date for the repossession/foreclo-
sure (optional).

Disposition Select the repossession/foreclosure disposition 
(required).

Repo/Forc Start Dt Enter the repossession/foreclosure start date (optional).
Type Select the repossession/foreclosure type (optional).
Repo/Forc End Dt Enter the repossession/foreclosure end date (optional).
Collateral Select the repossession/foreclosure asset (required).
Comment Enter a comment (optional).

3 Choose Create Tracking.

Oracle Daybreak loads the repossession tracking parameters.

4 If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the parameter display.

5 Complete the Tracking block.

6 Save any changes you made to the account.

Note: Sub pages for the Repossession page are described in the Account Details sub 
pages section of this chapter.

To enter foreclosure details for an account

1 Using the Customer Service form, load the account you want to add foreclosure details to 
and choose the Repo/Foreclosure (5) master tab, then choose Foreclosure.

Note: If there is a previous foreclosure record in the Details block, choose Create New 
Foreclosure to refresh the Foreclosure page.
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2 Complete the Details block.

In this field: Do this:

Current box Select to indicate this is the current repossession/foreclo-
sure record.

Followup Dt Enter the follow-up date for the repossession/foreclosure 
(required).

File Received Dt Enter the file received date for the repossession/foreclo-
sure (optional).

Disposition Select the repossession/foreclosure disposition 
(required).

Repo/Forc Start Dt Enter the repossession/foreclosure start date (optional).
Type Select the repossession/foreclosure type (optional).
Repo/Forc End Dt Enter the repossession/foreclosure end date (optional).
Collateral Select the repossession/foreclosure asset (required).
Comment Enter a comment (optional).

3 Choose Create Tracking.

Oracle Daybreak loads the foreclosure tracking parameters.

4 If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the parameter display.

5 Complete the Tracking block.

6 Save any changes you made to the account.

Note: Sub pages for the Foreclosure page are described in the Account Details sub 
pages section of this chapter.
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Recording repossession or foreclosure analysis
The Analysis page allows you to create and analyze possible scenarios for the remarketing 
and the sale of the asset. This enables you to calculate the possible gain or loss in the sale 
of an asset. Expenses already incurred on the asset are displayed on the form. You can 
change the numbers if you expect more expenses by the time the asset is sold. 

Note: You can have three Repo/Foreclosure analyses and three Sales analyses on a work-
sheet, but you can create more than one analysis worksheet. 

To complete a repossession/foreclosure analysis or sales analysis for an 
account

1 Load the account you want to work with on using the Customer Service form.

2 Choose the Repo/Foreclosure (5) master tab, then choose the Analysis tab.

3 Select the Current box if you wish to indicate that this is the current analysis worksheet

4 In the Analysis block, use the Level field to select the analysis level you want to use, 
ACCOUNT or ASSET.

• Choose Account if you want the analysis to use the value of the entire account.

• Choose Asset if you want the analysis to use the value of a particular asset.

5 Enter the following information in the Analysis block:

In this block: Do this:

Balance % Enter balance allocation percentage (required).
Analysis Dt View the analysis date (display only).
Asset If you want to perform an analysis for a particular asset, 

select the asset (optional).
Current Value View the asset current total value (display only).
Analysis Comment Enter comment associated with the analysis (optional).

6 Enter all the required information in the Repo/Foreclosure or Sales block, depending on 
the type of incident you are analyzing.
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7 Complete the details in the Expenses and Refunds sub pages, corresponding to the anal-
ysis or bid number on the Analysis page. 

• To complete the Expenses sub page:

In this field: Do this:

Expense Type Select the expense type (required).
Manual Indicates that the expense was entered manually 

(required).

Repo/Foreclosure block
Analysis1 Amt Enter the expense amount for analysis1 (required).
Analysis2 Amt Enter the expense amount for analysis2 (required).
Analysis3 Amt Enter the expense amount for analysis3 (required).

Sales block
Bid1 Amt Enter the expense amount for bid1 (required).
Bid2 Amt Enter the expense amount for bid2 (required).
Bid3 Amt Enter the expense amount for bid3 (required).

• To complete the Refunds sub page:

In this field: Do this:

Refund Type Select the refund type (required).
Manual Indicates that the refund was entered manually 

(required).

Repo/Foreclosure block
Analysis1 Amt Enter the refund amount for analysis1 (required).
Analysis2 Amt Enter the refund amount for analysis2 (required).
Analysis3 Amt Enter the refund amount for analysis3 (required).

Sales block
Bid1 Amt Enter the refund amount for bid1 (required).
Bid2 Amt Enter the refund amount for bid2 (required).
Bid3 Amt Enter the refund amount for bid3 (required).

The data here is loaded to the analysis and bid columns as “expenses” and “refunds.”
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8 If you are analyzing a repossession/foreclosure, choose the corresponding Load button on 
the Repo/Foreclosure block to load details on the Repo/Foreclosure block spread sheet.

If you are analyzing a sale of an asset, choose the corresponding Load (#) button on the 
Sales block to load details on the Repo/Foreclosure block spread sheet.

If this is a sales analysis and you know who is bidding, complete the Bid By fields.

9 Repeat steps 4 to 8 with information regarding other repossession/foreclosure or sales 
analysis.

10 In the Status field, select the status of the analysis: APPROVED or REJECTED. 

11 When you have decided which analysis or which sale bid you want to approve, select your 
choice in the either the Final Analysis or Final Sales block.

Note: You can approve only one analysis.

12 Save your entry.
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Deficiency (6) master tab
The Deficiency (6) master tab allows you to record information about deficiency accounts 
- accounts that are no longer collectable. You can create and track specific details on the 
status of the charged-off account for timely follow-up and analysis. You can track each 
stage of the deficiency process based on its follow-up date and record information using 
the Details and Tracking blocks.

The Create New Deficiency button enables you to create a new deficiency record with dif-
ferent start and end dates. You can also use the Deficiency page to view the previous defi-
ciency information using the scroll bar in the Details block. The Current box in the Details 
block indicates the current bankruptcy details.

Note: To view the balance of a charged off account, choose the Customer Service (2) 
master tab, then choose the Balances tab and in the Balance Group block, select Defi-
ciency Balance.

To enter deficiency details for an account

1 Using the Customer Service form, load the account you want to add deficiency details to 
and choose the Deficiency (6) master tab.

2 If there is a previous deficiency record in the Details block, choose Create New Defi-
ciency to refresh the Deficiency page.

3 Complete the Details block.

In this field: Do this:

Current box Select to indicate this is the current deficiency record.
Followup Dt Enter the follow-up date for the deficiency (required).
File Received Dt Enter the file received date for the deficiency (optional).
Disposition Select the deficiency disposition (required).
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Charge Off Dt Enter the deficiency start date (optional).
Type Select the deficiency type (optional).
Deficiency End Dt Enter the deficiency end date (optional).
Comment Enter a comment (optional).

4 Choose Create Tracking.

Oracle Daybreak loads the repossession/foreclosure tracking parameters that track actions 
taken to collect on the account.

5 If you want to reduce the list of parameters, select a sub attribute in the Sub Attribute box.

If your system has been configured to use the Sub Attribute field, only attributes in a par-
ticular group appear in the parameter display.

6 Complete the Tracking block.

7 Save your entry.

Note: Sub pages for the Deficiency page are described in the Account Details sub pages 
section of this chapter.
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Contract (7) master tab
The Customer Service form Contract (7) master tab allows you to view the contract and 
truth-in-lending information recorded during the funding process. It’s a display only ver-
sion of the same pages and sub pages found on the Funding form Contract (5) master tab. 

To view an account’s contract information 

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Contract (7) master tab.

Depending on what type of account you selected, the Loan page appears. If  selected a 
loan account with escrow, Escrow Analysis tab is available.

3 Use the following sub pages to view more information about the contract, if available:

• Contract
• Contract (2)
• Itemization
• Trade-In
• Insurance
• ESC
• Escrow
• Compensation (loan)
• Subvention
• Proceeds
• Disbursement to Others (Disbursement...)
• Fee
• ACH
• Coupon
• Real Estate Fields (Real Estate Fie...)
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Collateral (8) master tab
The Collateral (8) master tab contains pages that record information regarding any assets 
associated with an account. Collateral can be a vehicle, home, or something else, such as 
household goods. The Collateral tab is not available if the account is an unsecured loan, as 
such loans by definition do not include collateral.

To view the Collateral details 

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Collateral (8) master tab.

•  If the account’s collateral is a vehicle, the Vehicle page appears:

• If the account’s collateral is a home, the Home page appears:
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• If the account’s collateral is neither a vehicle nor a home, the Other page appears:

Substituting collateral
With the Customer Service form, you can substitute one asset for another to be used as an 
account’s collateral. However, you cannot substitute collateral involving homes.

To substitute the collateral for an account

1 Open the Customer Service form and load the account with the collateral you want to sub-
stitute.

2 Choose the Collateral (8) master tab.

Depending on the account you selected, the Vehicle or Other page appears.

3 Press F6 to clear the page.

4 Enter the data regarding the new asset to be used as collateral on the available page 

• If you are using the Vehicle page, complete the Vehicle block:

In this field: Do this:

Asset Class Select the asset class (required).
Asset Type Select the asset type (required).
Sub Type Select the asset sub-type (required).
Identification Number Enter the identification number (optional).
Registration # Enter the registration number (required).
Status Select the asset status (required).
Year Enter the year of the vehicle (required).
Make Select the make of the vehicle (optional).
Model Select the model of the vehicle (optional).
Body Enter the body of the vehicle (optional).
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Desc View the vehicle description (display only).
Condition Select the vehicle condition (optional).
Address (#) Enter the building number (optional).
Address 1 (unlabeled) Enter the address line 1 (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (optional).
City Enter the city (optional).
St Select the state (optional).
Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country code (required).
County Select the county (optional).

Oracle Daybreak validates the VIN if you add or modify the Identification Number field 
on the Customer Service form’s Vehicle page. 

Interface with VINTEK (If interface is installed)
Using the Vintek interface, Oracle Daybreak retrieves the year, make, model, and body of 
the vehicle on the Vehicle page of the Underwriting, Funding, Customer Service, and Con-
version App/Acc forms’ Collateral master tab when you choose Vehicle Details. This time 
saving feature reduces data entry errors. Using the VIN entered in the Identification Num-
ber field, Oracle Daybreak populates the following fields in the Vehicle block:

• Year
• Make
• Model
• Body 

If the Vintek interface is unable to retrieve information based on the VIN entered in the 
Identification Number field, Oracle Daybreak displays an error message.

• If you are using the Other page, complete the Other block:

In this field: Do this:

Asset Class Select the asset class (required).
Asset Type Select the asset type (required).
Sub Type Select the asset sub-type (required).
Identification Number Enter the identification number (optional).
Registration # Enter the registration number (required).
Status Select the asset status (required).
Year Enter the year of the collateral (required).
Make Select the make of the collateral (optional).
Model Select the model of the collateral (optional).
Body Enter the body of the collateral (optional).
Desc View the collateral description (display only).
Condition Select the collateral condition (required).
Address (#) Enter the building number (optional).
Address 1 (unlabeled) Enter the address line 1 (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (optional).
City Enter the city (optional).
St Select the state (optional).
Zip Extension (unlabeled) Enter the zip extension (optional).
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Country Select the country code (required).
County Select the county (optional).

Note: Accounts that are secured with collateral can have exactly one Primary collateral.

5 Clear the Primary box on the collateral you are replacing and select the Primary box on 
the new collateral page.

6 Select Substitute on the new collateral page.

7 Save your entry.

Valuation sub page
With the Valuation sub page, you can change the collateral or asset valuation for an 
account. In this process, you reassess the current value of the collateral (which has been 
used to secure the loan) using multiple sources. This helps companies determine if the risk 
of delinquency or charge off is worth the asset securing it.

To add the collateral or asset valuation for an account

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Collateral (8) master tab.

3 On the available page (Vehicle, Home, or Other), choose the Valuation sub tab.

4 If the Valuation sub page already contains information, press F6 to clear it.

5 On the Valuation sub page do the following

In this field: Do this:

Value block
Current Select if this is the current valuation (required).
Valuation Dt Enter the valuation date (required).
Source Select the valuation source (required).
Supplement Enter the valuation supplement (optional).
Edition Enter the valuation edition (optional).
Wholesale (Base) Enter the wholesale value (required).
Usage Enter the usage. This pertains to loans and usually is 

entered as the current mileage on the vehicle (required).
Retail (Base) Enter the retail value (required).
Addons + View the add-ons value (display only).
Usage Value + Enter the usage value; that is, the monetary effect that the 

current mileage has on the value of the vehicle (required).
Total Value = View the total value (display only).

Addons block
Addon/Attribute Select the add-on/attribute (required).
Value Enter the value of the attribute (optional).
Amt Enter the add-on amount (required).

6 Save the changes you made to the account. 

Note: Assets can have exactly one current valuation. NADA and Kelly Blue Book inter-
faces are available only in the client/server environment.
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Tracking sub page
With the Tracking sub page, you can add the collateral or asset tracking details for an 
account. This allows you to track additional data related to an asset, such as the location of 
the title, liens, and insurance information.

To add the collateral or asset tracking for an account

1 Load the account you want to work on using the Customer Service form.

2 Choose the Collateral (8) master tab.

3 On the available page (Vehicle, Home, or Other), choose the Tracking sub tab.

4 Choose Load Details.

5 Enter or select the tracking details in the Tracking Items block.

In this field: Do this:

Tracking Items block
Tracking Item View the tracking type (display only).
Disposition Select the disposition (required).
Start Dt Enter the tracking start date (required).
End Dt Enter the tracking end date (optional).
Followup Dt Enter the next follow-up date (required).
Enabled Select to track the information from the start date in the 

Start Dt field. (required).
Comment Enter a comment (optional).

Tracking Items Details block
Parameter View parameter (display only).
Value Enter the tracking parameter value (optional).

6 Save any changes you made to the account.
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Bureau (9) master tab
The Customer Service form Bureau (9) master tab allows you to create and pull a credit 
bureau report and view the results as a text only file. 

To request a manual credit bureau report

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Bureau (9) master tab.

3 In the New Request block, use the LOV to complete the following fields:

In this field: Do this:

Applicant Select the applicant. 
Spouse Select the applicant’s spouse (if applicable).
Bureau Select the credit bureau (required).
Report Select the credit bureau report type (required).

4 Choose Create Request. 

Oracle Daybreak displays this information in the Bureau Details block and further infor-
mation about the customer in Applicant/Customer Detail block.

5 If you want to receive a copy of a previously pulled credit bureau report, enter the credit 
bureau reorder number in the Credit Bureau Reorder # field on the Bureau Details 
block. This allows you to receive a previously pulled credit report from (currently other 
bureaus do no provide a copy) (optional).

6 In the New Request block, choose Submit Request. 

7 Press F8 to refresh the status of the credit request until the credit pull is completed.

Oracle Daybreak displays the latest status of the currently requested bureau report in the 
Bureau Details block.

When the report pull process is complete, the Status field in the Applicant/Customer 
Detail block changes to COMPLETED. The results of the credit bureau pull appear in the 
list box at the bottom of the Customer Service form.

Note: To send a copy of the report to a predefined printer, choose Print Report.
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Comment (10) master tab
The Customer Service form Comment (10) master tab allows you to view and add free-
form text notes regarding an account at any time. This tab contains the same information 
as the Comments sub page.

The Type field allows you to classify comments in user-defined categories. Oracle Day-
break assigns each comment a time-date stamp and records the User Id of who made the 
comment.

To use the Customer Service form Comment tab

1 Open the Customer Service form and load the account you want to work with.

2 Choose the Comments (10) master tab.

3 In the Type block, select the type of comment you are adding.

4 In the Sub Type block, select the sub type of comment you are adding.

5 In the Comments block, type your comment.

6 If you want Oracle Daybreak to recognize this comment as an alert, select Alert.

Note: If you select the Alert box, the comment appears on the Customer Service form’s 
Account Details page in the Comment sub page.

7 Save any changes you made to the account.

Note: Comments on the Comments (10) master tab also appear on the Comments sub 
page.
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CHAPTER 3 : PAYMENT PROCESSING

Oracle Daybreak allows you to post payment transactions to accounts in a batch mode, 
either by manual entry or the use of data files. These transactions can be posted in real-
time of in batch mode.

Payments can be entered in Oracle Daybreak in a variety of ways:

• Lockbox payments
• ACH payments
• Manual entry with the Payment Entry page.

The manual entry option is useful in a low volume or branch scenario when customers 
would make payments in person or through the mail. The lockbox and ACH options allow 
for processing payments electronically without manual input.

Lockbox payments
Oracle Daybreak can accept payments from lockboxes in the NACHA format. The 
NACHA format is an industry standard that can be used to post multiple batches of pay-
ments at one time. The lockbox load batch process can be configured to run at any time of 
the day and at multiple times if needed. All payments from the lockbox file are loaded into 
Oracle Daybreak as batches. Any errors by identified by Oracle Daybreak during the load 
process are logged.

ACH Payments
Oracle Daybreak allows you to post directly from the ACH file that has been created for 
customer payments. This is controlled by the ACA_PAYMENT_AUTO_LOAD system 
parameter. If the parameter is set to Y, Oracle Daybreak automatically creates payment 
batches for the payments in the ACH file and posts them on the day of payment.

Batch NSF Processing
Oracle Daybreak provides the upload of the rejected ACH “payment requests file” sent by 
the financial institution/lender to allow for improved NSF processing for all returned pay-
ments. This is done using a “batch mode” process.

In previous versions, Oracle Daybreak LS supported the upload of payment files through 
lockbox uploads. In addition to the Payment file, Oracle Daybreak also provides the 
upload of Payment Return files through lockbox uploads. Oracle Daybreak LS provides an 
upload of the “Entry Detail Addenda Record” in the NSF Notification file received from 
the client's financial institution. This record pertains to payment returns.
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Manual entry
The Payment Entry page allows you to manually post batches of payments. You can enter 
payment details such as payment date, payment reason and mode, and payment amount. A 
batch is comprised of a number of payments. Oracle Daybreak provides audit controls to 
audit the actual payments entered.

Each batch needs to be associated with a company and one or all branches within the com-
pany. Information you enter controls totals to allow Oracle Daybreak to verify the actual 
number of payments against the total of payment amounts you enter.
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Payment entry and maintenance
This chapter explains how to use the Consumer Lending (Advance and Payment) form to 
complete the following tasks:

• Post a payment
• Correct a payment

Note:
The Consumer Lending (Advance and Payment) form’s Payment Entry and Payment 
Maintenance pages can be set up to display in one of two different modes:

Mode One:
One payment to one account

Mode Two: 
One payment to multiple account.

Each mode uses a different Payment Entry and Payment Maintenance page. This chapter 
describes how to use both.

i-flex solutions Corp. recommends deciding at set up which mode you want to use on the 
Consumer Lending (Advance and Payment) form. It is possible to switch from the one 
payment/one account mode to the one payment/multiple accounts in the future, though 
problems can arise when you reverse payments after switching modes. However, once 
your Oracle Daybreak system uses the one payment/multiple accounts mode, you cannot 
revert back to the one payment/one account mode. It is for this reason that we recommend 
deciding at set up which method you will use.

To set up the one payment - one account method

The one payment - one account option can be used by setting the 
TPE_PAYMENT_TO_MULTI_ACCOUNTS parameter to “no.”

1 On the Setup menu, choose Administration > System.

The Administration form appears, opened at the System tab.

2 Choose the Parameter tab, then choose the System sub tab.

3 In the System Parameters block, select the following parameter:

TPE_PAYMENT_TO_MULTI_ACCOUNTS

4 In the Parameter Value column, type N.

5 Select Enabled.

6 Save the settings and close the Administration form.
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To set up the one payment - multiple accounts method

The one payment - multiple accounts option can be used by setting the 
TPE_PAYMENT_TO_MULTI_ACCOUNTS parameter to “yes.”

1 On the Setup menu, choose Administration > System.

The Administration form appears, opened at the System tab.

2 Choose the Parameter tab, then choose the System sub tab.

3 In the System Parameters block, select the following parameter:

TPE_PAYMENT_TO_MULTI_ACCOUNTS

4 In the Parameter Value column, type Y.

5 Select Enabled.

6 Save the settings and close the Administration form.
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Payment Entry page (one payment - one account)
Using the Payment Entry form, you can view and manually enter a batch of payment 
transactions. You can then post a batch to apply payment to an account, place a batch on 
hold, open a batch on hold, or reverse a batch.

Viewing batches
The Payment Entry page allows you to view either all batches or only open batches. You 
can choose which batch you want to view using the View Options block. Viewing all 
batches allows you to locate batches with a status of OPEN, REVERSE, HOLD, ERROR, or 
POSTED.

To view open payment batches 

1 On the Batch Transactions menu, choose Payments > Payment Entry.

2 In the All Payments block, select Payments.

3 In the View Options block, select Open Batch Only (the default option) and press F8 to 
perform the query.

In the Batch block, Oracle Daybreak displays all batches with a status of OPEN that have 
not been posted.

4 Use the scroll bar in the Batch block to scroll through the list of batches
-or-
Use search criteria in the Batch block (such as batch type, date, and batch number) to 
locate a particular batch.

Details regarding the selected batch appear in the Payments block.
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To view all payment batches

1 On the Batch Transactions menu, choose Payments > Payment Entry.

2 In the All Payments block, select Payments.

3 In the View Options block, select All Batches and press F8 to perform the query.

In the Batch block, Oracle Daybreak displays all payment batches, regardless of status.

4 Use the scroll bar in the Batch block to scroll through the list of batches
-or-
Use search criteria in the Batch block (such as batch type, date, and batch number) to 
locate a particular batch.

Details regarding the selected batch appear in the Payments block.

If a batch contains a payment with an error status, the Error Reason field displays the 
cause.

To locate a payment batch with an error

1 On the Batch Transactions menu, choose Payments > Payment Entry.

2 In the All Payments block, select Payments.

3 In the View Options block, select All Batches and press F8 to perform the query.

In the Batch block, Oracle Daybreak displays all batches, regardless of status.

4 Press F7, type error in the Batch Status field of the Batch block, and press F8 to perform 
the query.

5 Use the scroll bar in the Batch block to scroll through the list of batches
-or-
Use search criteria in the Batch block (such as batch type, date, and batch number) to 
locate a particular batch.

6 In the Payments block, select the payment with ERROR in its Status field.

Oracle Daybreak displays the cause of the error in the Error Reason field.
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To view the uploaded Return / NSF notification file 

1 On the Batch Transactions menu, choose Payments > Payment Entry.

2 In the All Payments block, select Return/NSF.

3 In the View Options block, select All Batches and press F8 to perform the query.

In the Batch block, Oracle Daybreak displays all batches, regardless of status.
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Entering and posting payments

The Payment Entry page allows you to manually post batches of payments. A batch can 
consist of one or more accounts.

To enter and post a batch for a payment transaction

1 On the Batch Transactions menu, choose Payments > Payment Entry.

2 In the Batch block, enter the following information:

In this box: Do this:

Company Select the portfolio company (required).
Branch View the portfolio branch (display only).
Date Enter batch date, usually either today’s date or the date 

the batch was received as a whole (required).
Batch Type Select the batch type. Oracle Daybreak identifies each 

batch with a type signifying the type of payment batch it 
is; for example, mail, drop box, Western Union, walk in, 
and so on (required).

Total # Enter total number of payments in the batch (required).
Total Amt Enter total amount of payments in the batch (required).
Batch # View the batch number (system generated). The batch 

number format is PAY-YYYY-JJJ-SSSS, where YYYY is 
the year, JJJ is the Julian date, and SSSS is a sequential 
number. Oracle Daybreak generates a new sequence for 
every different date, so the first batch of each day starts 
with SSSS = 0001 (display only).

Batch Status View the batch status (display only).
Total #* View the total number of payments in the batch (actual). 

Note: This figure must match the figure in the required 
Total # field before a batch can be posted (display only).

Total Amt* View the total amount of payments in the batch (actual) 
Note: This figure must match the figure in the required 
Total Amt field before a batch can be posted (display 
only).
* These two fields update every time you save the item-
ized payment entries in the Payments block.
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3 Save your entry.

4 The Payments block records itemized information of the batch payment. It allows you to 
make one payment to one account, or more than one payment to more than one account.
In the Payments block, enter the following information:

In this box: Do this:

Account # Select the account number to which this payment applies 
(required).

Title View the account title (display only).
Date Enter the payment effective date. This date must be less 

than or equal to the date recorded in the Batch block 
(required).

Amount Enter the payment amount (required).
Spread Select the spread (payment allocation strategy) for the 

payment. The spread determines the manner in which the 
payment gets applied; that is, how a payment is split 
between principal, interest, and fees (required).

Mode Select the payment mode (optional).
Reason Select the reason for the payment. 
Reference Enter any reference information (such as check number) 

(optional).
Status View the payment status (display only).
Error Reason View the reason for error (display only).

5 After you record a payment in the Payments block, save your entry. 

Oracle Daybreak updates the display only Total # and Total Amt fields in the Batch block 
to record the contents of the Payments block.

Note: Before you can post a batch transaction on the Payment Entry page, the contents of 
the display only Total # and Total Amt fields must match the contents of the required Total 
# and Total Amt fields.
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6 In the Action block, choose Post.

Oracle Daybreak changes the batch status from OPEN to PROCESSING and submits the 
batch to the job service. After the batch has been processed, Oracle Daybreak changes the 
batch status to POSTED or ERROR.

The posted payments can be viewed on the Customer Service (2) master tab’s Transac-
tions page on the Customer Service form.
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Holding, removing a hold on, and reversing a batch of payment trans-
actions

To hold the batch of payments transactions

Note: Only the batches with the status of OPEN can be put on hold.

1 On the Batch Transactions menu, choose Payments > Payment Entry.

2 In the All Payments block, select Payments.

3 Use the View Option block to select the batches you want to view:

• If the batch status is OPEN, select Open Batches Only in the View Options block and 
press F8 to perform the query.

• If the batch status is ERROR, select All Batches in the View Options block, press F8 to 
perform the query.

4 Use the Batch block to search for and select the batch you want to hold.

5 In the Action block, choose Hold/Open.

Oracle Daybreak changes the batch status from OPEN to HOLD.
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To open (or remove hold) on the batch of payments transactions

Note: Only the batches with a status of HOLD can be opened.

1 On the Batch Transactions menu, choose Payments > Payment Entry.

2 In the All Payments block, select Payments.

3 Use the View Option block to select All Batches and press F8 to perform the query.

4 Use the Batch block to search for and select the batch with the status of HOLD you want to 
open.

5 In the Action block, choose Hold/Open.

Oracle Daybreak changes the batch status from HOLD to OPEN.

To reverse the batch of payment transactions

Batches can be reversed in case of problems with the batch. This will reverse all payments 
that have been posted.

Note: Only the batches with a status of POSTED can be reversed.

1 On the Batch Transactions menu, choose Payments > Payment Entry.

2 In the All Payments block, select Payments.

3 Use the View Option block to select All Batches, and press F8 to perform the query.

4 Use the Batch block to search for and select the batch with the POSTED status you want to 
reverse.

5 In the Action block, choose Reverse.

Oracle Daybreak displays a Forms dialog with the message “You are reversing the Batch. 
Do you want to continue?”

6 Choose Yes.

Oracle Daybreak changes the batch status from POSTED to PROCESSING and submits the 
batch to the job service. After the batch has been processed, Oracle Daybreak changes the 
batch status to REVERSE. 
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Note: You can verify the reversal using the Transaction page on the Customer Service 
form for each account in the batch or by running the payment history report (Reports > 
Run > Payment History > (Loan). 

Note: Access to the Reverse button can be restricted by user responsibility and the account’s 
product type using the PAYMENT_REV transaction code (Super Group: ACCOUNT 
MONETARY TXN) on the Administration form. 
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Printing a receipt

You can print receipts for walk-in payments using the Print Receipt button on the Con-
sumer Lending (Advance and Payment) form’s Payment Entry page. The Print Receipt 
button appears in the Action block. Receipts can be printed before actually posting the 
payment. This allows you to create just the batch, leave it for end of the day processing, 
and print the receipt for the customer. 

To print a receipt of the payments transactions

1 On the Batch Transactions menu, choose Payments > Payment Entry.

2 Complete the Batch block with information regarding the payment for which you want to 
print a receipt. (Note: For more information, see the previous section in this chapter, 
Entering and posting a payment.)

3 Save your entry.

4 Complete the Payments block with information regarding the payment for which you 
want to print a receipt. (Note: For more information, see the previous section in this chap-
ter, Entering and posting a payment.)

5 In the Action block, choose Print Receipt.

Oracle Daybreak sends the payment receipt directly to the printer based on the company 
level system parameter CMN_CMB_DEFAULT_PRINTER.
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Payment Maintenance page (one payment - one account)
The Payment Maintenance page allows you to perform maintenance functions on individ-
ual payments that have been posted. The common functions are as follows:

Function: Purpose:

Modify Allows you to change one or more of the payment 
attributes such as the payment amount, spread, and date.

NSF Notifies Oracle Daybreak that the customer did not have 
sufficient funds in the account and will post a NSF fee 
(based upon setup).

Reverse Allows you to simply reverse a payment.

In all cases, Oracle Daybreak performs a “true backdating” to post the transaction based 
upon the transaction date. Interest recalculations are automatic and all necessary transac-
tions can be sent to the general ledger for automatic reconciliation.

Suspended payments
In case of payments that are not posted to accounts due to issues such as incorrect account 
condition, the payments are posted to suspense. You must process these payments using 
the work queue for suspense payments. This would typically involve identifying the cor-
rect amount or correcting problems with the account before attempting to re-post the pay-
ment. In this case, the payment is moved out of the suspense account and posted to the 
specified account.

To view payments 

1 On the Batch Transactions menu, choose Payments > Payment Maintenance.
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2 In the View Options block, select which payment you want to view:

If you choose: In the Payments block, Oracle Daybreak displays:

Posted Posted payments.
Suspense Suspended payments. (Suspended payments are posted 

payments that haven’t been applied to accounts because 
of errors involving account numbers or the account itself, 
such as its status, spread issues, and so on.)

All All payments.

3 Press F8 to view either all posted payments or all payments in suspense
-or-
Use the Enter-Query mode to limit the search using criteria in the Payments block.

Oracle Daybreak displays the selected payments in the Payments block. 

4 In the Payments block, view the following information:

In this field: View this:

Account # Account number.
Title Account title.
Txn Dt Payment effective date.
Txn Amt Payment amount.
Spread Spread (payment allocation strategy).
Mode Payment mode.
Reason Payment reason.
Reference Reference information for payment.
Status Payment status.

5 Select a payment in the Payments block and view the following additional information:

In this field: View this:

Company Portfolio company.
Branch Portfolio branch.
Batch # Batch number.
Batch Type Batch type.
Date Displays batch date.

The Payment Allocation block details how the selected payment was applied against the 
account. This is useful in determining whether the payment was posted correctly or 
whether the spread or transaction date needs to be modified.

Modify and reversing payment transactions
In some cases, a payment may be valid, but how it was posted was incorrect; for example, 
payment was posted to the wrong account, with the wrong date, or with incorrect spread 
data. The Payment Maintenance page allows you to correct such errors.

To modify (correct) an individual payment transaction

1 On the Batch Transactions menu, choose Payments > Payment Maintenance.

2 In the View Options block, select the type of payments you want to view: Posted, Sus-
pense, or All.
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3 Press F7 to move to Enter-Query mode.

4 In the Payments block, complete the field(s) you want to use as search criteria to locate a 
payment (Account #, Title, Txn Dt ...).

5 Press F8 to perform the query.

Oracle Daybreak displays payments matching your search criteria in the Payments block.

6 Select the payment that you want to modify.

7 In the Action block, select Modify.

8 In the Details block, update the fields with information about the payment you want to 
modify.

In this field: Do this:

Account # : Title Select the account number (required).
Txn Dt Enter the payment effective date (required).
Amt Enter the payment amount (required).
Reason Select the reason for payment (optional).
Spread Select the spread (Payment allocation strategy) 

(required).
Error Reason View the error reason (display only).

9 Save your entry.

Oracle Daybreak modifies the original payment and posts the new payment.

The modified payment can be viewed on the Customer Service (2) master tab’s Transac-
tions page on the Customer Service form.
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To reverse an individual payment transaction

1 On the Batch Transactions menu, choose Payments > Payment Maintenance.

2 Press F7 to move to Enter-Query mode.

3 In the Payments block, complete the field(s) you want to use as search criteria to locate a 
payment (Account #, Title, Txn Dt ...).

4 Press F8 to perform the query.

Oracle Daybreak displays all the transactions matching your criteria in the Payments 
block.

5 Select the payment that you want to reverse.

6 In the Details block, complete the Reason field (if you choose). You shouldn’t have to 
update any other fields when reversing a transaction.

7 In the Action block, select Reverse.

8 Save your entry.

Note: Access to the Reverse button can be restricted by user responsibility and the 
account’s product type using the PAYMENT_REV transaction code (Super Group: 
ACCOUNT MONETARY TXN) on the Administration form. (For more information, see the 
Txn Codes page section in the Oracle Daybreak Lending Suite Setup Guide).

Oracle Daybreak reverses the original payment.

The reversed payment can be viewed when you load the account on the Customer Service 
form from the Customer Service (2) master tab’s Transactions page.

To reverse an individual payment transaction and assess NSF fee

1 On the Batch Transactions menu, choose Payments > Payment Maintenance.

2 Press F7 to move to Enter-Query mode.

3 In the Payments block, complete the field(s) you want to use to locate a payment 
(Account #, Title, Txn Dt ...).

4 Press F8 to perform the query.

Oracle Daybreak displays all the transactions for that account in the Payments block.

5 Select the payment that you want to reverse and charge and a non sufficient fund fee.

6 In the Details block, complete the Reason field (if you choose). You shouldn’t have to 
update any other fields when reversing a transaction.

7 In the Action block, select Non Sufficient Funds.

8 Save the record.

Oracle Daybreak reverses the original payment and assesses the NSF fee.

The reversed payment and nonsufficient fund fee can be viewed on the Customer Service 
form from the Customer Service (2) master tab’s Transactions page.
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Payment Entry page (one payment - multiple accounts)
Using the Payment Entry form, you can enter and view a batch of payment transactions. 
You can then post a batch, place a batch on hold, open a batch on hold, or reverse a batch.

Viewing batches
The Payment Entry allows you to view either all batches or only open batches. You can 
choose which batch you want to view using the View Options block. Viewing all batches 
allows you to locate batches with a status of OPEN, REVERSE, HOLD, ERROR, or 
POSTED.

To view open payment batches 

1 On the Batch Transactions menu, choose Payments > Payment Entry.

2 In the All Payments block, select Normal.

3 In the View Options block, select Open Batch Only (the default option) and press F8 to 
perform the query.

In the Batch block, Oracle Daybreak displays all batches with a status of OPEN that have 
not been posted.

4 Use the scroll bar in the Batch block to scroll through the list of batches
-or-
Use search criteria in the Batch block (such as batch type, date, and batch number) to 
locate a particular batch.

Details regarding the selected batch appear in the Payments and Payment Txns blocks.
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To view all payments batches

1 On the Batch Transactions menu, choose Payments > Payment Entry.

2 In the All Payments block, select Normal.

3 In the View Options block, select All Batches and press F8 to perform the query.

In the Batch block, Oracle Daybreak displays all batches, regardless of status.

4 Use the scroll bar in the Batch block to scroll through the list of batches
-or-
Use search criteria in the Batch block (such as batch type, date, and batch number) to 
locate a particular batch.

Details regarding the selected batch appear in the Payments and Payment Txns blocks.

If a batch contains a payment with an error status, the Error Reason field displays the 
cause.

To locate a batch with an error

1 On the Batch Transactions menu, choose Payments > Payment Entry.

2 In the All Payments block, select Normal.

3 In the View Options block, select All Batches and press F8 to perform the query.

In the Batch block, Oracle Daybreak displays all batches, regardless of status.

4 Press F7 to move the Enter-Query mode, type ERROR in the Batch Status field of the 
Batch block, and press F8 to perform the query.

5 Use the scroll bar in the Batch block to scroll through the list of batches

-or-
Use search criteria in the Batch block (such as batch type, date, and batch number) to 
locate a particular batch.

6 In the Payments Txns block, select the payment with ERROR in its Status field.

Oracle Daybreak displays the cause of the error in the Error Reason field.
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Entering and posting batches

The Payment Entry page allows you to manually post batches of payments. A batch can 
consist of one or more accounts.

To enter and post a batch for payment transaction

1 On the Batch Transactions menu, choose Payments > Payment Entry.

2 In the Batch block, enter the following information:

In this box: Do this:

Company Select the portfolio company (required).
Branch View the portfolio branch (display only).
Date Enter batch date, usually either today’s date or the date 

the batch was received as a whole (required).
Batch Type Select the batch type. Oracle Daybreak identifies each 

batch with a type signifying the type of payment batch it 
is; for example, mail, drop box, Western Union, walk in, 
and so on (required).

Total # Enter total number of payments in the batch (required).
Total Amt Enter total amount of payments in the batch (required).
Batch # View the batch number (system generated). The batch 

number format is PAY-YYYY-JJJ-SSSS, where YYYY is 
the year, JJJ is the Julian date, and SSSS is a sequential 
number. Oracle Daybreak generates a new sequence for 
every different date, so the first batch of each day starts 
with SSSS = 0001 (display only).

Batch Status View the batch status (display only).
Total #* View the total number of payments in the batch (actual). 

Note: This figure must match the figure in the required 
Total # field before a batch can be posted (display only).

Total Amt* View the total amount of payments in the batch (actual) 
Note: This figure must match the figure in the required 
Total Amt field before a batch can be posted (display 
only).
* These two fields update every time you save the item-
ized payment entries in the Payments block.

3 Save your entry.

4 In the Payments block, enter the following information (total must match the correspond-
ing payments):

In this box: Do this:

Pmt Date Enter a payment date, typically the date you received the 
payment, regardless of when you are posting it 
(required).

Pmt Amt Enter the payment amount (required).
Status View the payment status (display only).
Mode Select the mode for the payment (optional).
Reason Select the reason for the payment (optional).
Reference Enter the payment reference (optional).
Total Amt View the total amount (display only).
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5 For each payment, use the Payments Txns block to record information about the account 
receiving payment. (There might be more than one entry for the same account; for exam-
ple, one account may required different payment spreads.) 

Note: The total Amounts in the Payments Txns block must match the contents of the Total 
Amt in the Payments block.

In this box: Do this:

Account # Select the account number (required).
Amount Enter payment amount (required).
Title View the account title (display only).
Spread Select spread (payment allocation strategy) for the pay-

ment (required).
Status View the payment status (display only).
Error Reason View the reason for error. This field will populate after 

you choose Post if payments aren’t reconciled (display 
only).

6 Save your entry.

Oracle Daybreak updates the display only Total # and Total Amt fields in the Batch block 
to record the contents of the Payments block.

Note: Before you can post a batch transaction on the Payment Entry page, the contents of 
the display only Total # and Total Amt fields must match the contents of the required Total 
# and Total Amt fields. In the example below, the batch is ready to post, as these figures 
match.

7 In the Action block, choose Post.

Oracle Daybreak changes the batch status from OPEN to PROCESSING and submits the 
batch to the job service. After the batch has been processed, Oracle Daybreak changes the 
batch status to POSTED or ERROR.

Note: Only a batch with a Batch Status of OPEN can be posted. The batch totals and con-
trol totals should match before you post the batch. If they do not and you choose Post, Ora-
cle Daybreak displays the following Forms dialog box:
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Holding, removing a hold on, and reversing a batch of payment trans-
actions

To hold the batch of payments transactions

Note: Only the batches with the status of OPEN can be put on hold.

1 On the Batch Transactions menu, choose Payments > Payment Entry.

2 In the All Payments block, select Normal.

3 In the View Option block to select the batches you want to view:

• If the batch status is OPEN, select Open Batches Only in the View Options block and 
press F8 to perform the query. 

• If the batch status is ERROR, select All Batches in the View Options block, press F8 to 
perform the query. 

4 Use the Batch block to search for and select the batch you want to hold.

5 In the Action block, choose Hold/Open.

Oracle Daybreak changes the batch status from OPEN to HOLD.

To open (or remove hold) on the batch of payments transactions

Note: Only the batches with a status of HOLD can be opened.

1 On the Batch Transactions menu, choose Payments > Payment Entry.

2 In the All Payments block, select Normal.

3 In the View Option block to select All Batches, and press F8 to perform the query.

4 Use the Batch block to search for and select the batch you want to open.

5 In the Action block, choose Hold/Open.

Oracle Daybreak changes the batch status from HOLD to OPEN.

To reverse the batch of payment transactions

Note: Only the batches with a status of POSTED can be reversed.

Access to the Reverse button can be restricted by user responsibility and the account’s 
product type using the PAYMENT_REV transaction code (Super Group: ACCOUNT MONE-
TARY TXN) on the Administration form. (For more information, see the Txn Codes page 
section in the Oracle Daybreak Lending Suite Setup Guide).

1 On the Batch Transactions menu, choose Payments > Payment Entry.

2 In the All Payments block, select Normal.

3 On the Payment Entry page, use the View Option block to select All Batches, and press 
F8 to perform the query.

4 Use the Batch block to search for and select the batch you want to reverse.
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5 In the Action block, choose Reverse.

Oracle Daybreak changes the batch status from POSTED to PROCESSING and submits the 
batch to the job service. After the batch has been processed, Oracle Daybreak changes the 
batch status to REVERSED. 

Note: You can verify this using the Transaction page on the Customer Service form or by 
running the payment history report (Reports > Run > Payment History > (Loan).

Printing a receipt

You can print receipts for walk-in payments using the Print Receipt button on the Con-
sumer Lending (Advance and Payment) form’s Payment Entry page. The Print Receipt 
button appears in the Action block. Receipts can be printed before actually posting the 
payment. This allows you to create just the batch, leave it for end of the day processing, 
and print the receipt for the customer. 

To print a receipt of the payments transactions

1 On the Batch Transactions menu, choose Payments > Payment Entry.

2 Complete the Batch block with information regarding the payment for which you want to 
print a receipt. (Note: For more information, see the previous section in this chapter, 
Entering and posting a payment.)

3 Save your entry.

4 Complete the Payments block with information regarding the payment for which you 
want to print a receipt. (Note: For more information, see the previous section in this chap-
ter, Entering and posting a payment.)

5 Save your entry.

6 Complete the Payment Txns block with information regarding the payment for which 
you want to print a receipt. (Note: For more information, see the previous section in this 
chapter, Entering and posting a payment.)

7 In the Action block, choose Print Receipt.

Oracle Daybreak sends the payment receipt directly to the printer based on the company 
level system parameter CMN_CMB_DEFAULT_PRINTER.
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Payment Maintenance page (one payment - multiple accounts)
The Payment Maintenance page allows you to perform maintenance functions on individ-
ual payments that have been posted. The common functions are as follows:

Function: Purpose:

Modify Allows you to change one or more of the payment 
attributes such as the payment amount, spread, and date.

NSF Notifies Oracle Daybreak that the customer did not have 
sufficient funds in the account and will post a NSF fee 
(based upon setup).

Reverse Allows you to simply reverse a payment.

In all cases, Oracle Daybreak performs a “true backdating” to post the transaction based 
upon the transaction date. Interest recalculations are automatic and all necessary transac-
tions can be sent to the general ledger for automatic reconciliation.

Suspended payments
In case of payments that are not posted to accounts due to issues such as incorrect account 
condition, the payments are posted to suspense. You must process these payments using 
the work queue for suspense payments. This would typically involve identifying the cor-
rect amount or correcting problems with the account before attempting to re-post the pay-
ment. In this case, the payment is moved out of the suspense account and posted to the 
specified account.

To view payments 

1 On the Batch Transactions menu, choose Payments > Payment Maintenance.
Chapter 3 :-25   User Guide - Consumer Loans Servicing 



2 In the View Options block, select which type of payment you want to load from the fol-
lowing list and press F8 to perform the query.

If you choose: In the Payments block, Oracle Daybreak displays:

Posted Posted payments.
Suspense Suspended payments. (Suspended payments are posted 

payments that haven’t been applied to accounts because 
of errors involving account numbers or the account itself, 
such as its status, spread issues, and so on.)

All All payments.

Note: Step 2 will load all payments from all accounts matching the selected view option.

To load the payments for a single account, enter the account number in the Account 
Search field and choose Search.

3 In the Payments block, view the following information:

In this field: Do this:

Pmt Date View the payment date.
Pmt Amt View the payment amount.
Status View the status.
Reference View the payment reference.
Reason View the payment reason.
Mode View the payment mode.
Pmt Date Enter date.
Pmt Amt Enter amount.
NSF Fee Account # Select account number for NSF fee assessment.

4 Select a payment in the Payments block and view the following additional information:

In this field: View this:

Company The portfolio company.
Branch The portfolio branch.
Batch # The batch number.
Batch Type The batch type.
Date The batch date.

The following information for the selected payment appears in the Payment Txns block:

In this field: View this:

Account # The account number.
Title The account title.
Txn Amt The payment amount.
Status The payment amount.
Spread The spread (payment allocation strategy).

The Payment Allocation block details how the select payment was applied against the 
account. This is useful in determining whether the payment was posted correctly or 
whether the spread or transaction date needs to be modified.

5 Choose the payment transaction you want to modify in the Payment Txns block.

6 Choose Modify.
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7 Use the New Payment Txns block to make adjustments to the data.

In this field: Do this:

Account #: Title Select account number (required).
Txn Amt Enter amount (required).
Spread Select spread (Payment allocation strategy) (required).

8 In the Payment Txns block, choose Post.

9 Save your entry.

Modify and reversing payment transactions
In some cases, a payment may be valid, but how it was posted was incorrect; for example, 
payment was posted to the wrong account, with the wrong date, or with incorrect spread 
data. The Payment Maintenance page allows you to correct such errors.

To modify (correct) an individual payment transaction

1 On the Batch Transactions menu, choose Payments > Payment Maintenance.

2 In the View Options block, select the type of payments you want to view: Posted, Sus-
pense, or All.

3 Press F7 to move to Enter-Query mode.

4 In the Payments block, complete the field(s) you want to use to locate a payment 
(Account #, Title, Txn Dt ...).

5 Press F8 to perform the query.

Oracle Daybreak displays payments matching your search criteria in the Payments block.

6 Select the payment that you want to modify.

7 In the Payments block, select Modify.

8 In the New Payment Txns block, update the fields with information about the payment 
you want to modify.

9 Save your entry.

Oracle Daybreak modifies the original payment and posts the new payment.

The modified payment can be viewed on the Customer Service (2) master tab’s Transac-
tions page on the Customer Service form.

To reverse an individual payment transaction

1 On the Batch Transactions menu, choose Payments > Payment Maintenance.

2 Press F7 to move to Enter-Query mode.

3 In the Payments block, complete the field(s) you want to use to locate a payment 
(Account #, Title, Txn Dt ...).

4 Press F8 to perform the query.

Oracle Daybreak displays all the transactions matching your criteria in the Payments 
block.
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5 Select the payment that you want to reverse.

6 In the Payments block, select Reverse.

7 Save the record.

Oracle Daybreak reverses the original payment.

To reverse an individual payment transaction and assess NSF fee

1 On the Batch Transactions menu, choose Payments > Payment Maintenance.

2 Press F7 to move to Enter-Query mode.

3 In the Payments block, complete the field(s) you want to use to locate a payment 
(Account #, Title, Txn Dt ...).

4 Press F8 to perform the query.

Oracle Daybreak displays all the transactions matching your criteria in the Payments 
block.

5 Select the payment that you want to reverse.

6 In the Payments block, select Non Sufficient Funds.

7 Save the record.

Oracle Daybreak reverses the original payment and assesses the NSF fee.

Note: Access to the Reverse button can be restricted by user responsibility and the 
account’s product type using the PAYMENT_REV transaction code (Super Group: 
ACCOUNT MONETARY TXN) on the Administration form. (For more information, see the 
Txn Codes page section in the Oracle Daybreak Lending Suite Setup Guide).
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Search page
A Search page is available on the Consumer Lending (Advance and Payment) form to help 
locate information such as an account’s number, company and branch. This is information 
that is used on the Payment Entry and Payment Maintenance pages.

To search for an account

1 On the Batch Transactions menu, choose one of the following:

Advances > Advance Entry 
Advances > Advance Maintenance
Payments > Payment Entry 
Payments > Payment Maintenance

2 Choose the Search tab.

The Consumer Lending (Advance and Payment) form’s Search page appears.

3 In the Search Criteria block, use the Comparison Operator and Value columns to enter 
the search criteria you want to use to locate an account. 

4 Choose Search.

Oracle Daybreak displays the result of the search in the Results block at the bottom of the 
page. 

Note: You can use the “Cut” and “Paste” commands to copy the Account # to other text 
boxes. You can also sort your results using the Sort block. For more information, see the 
Using the Sort block section in the Oracle Daybreak Tools chapter.

Note: Choose Reset Criteria at any time to clear the Comparison Operator and Values 
columns on the Search page.
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CHAPTER 4 : ADVANCE PROCESSING

For lines of credit, you can enter multiple advances to the account for the draws made by 
customers. Advances can be entered either by manual entry or batch upload.

Manual Entry
The Advance Entry page allows you to post advances against accounts. This page uses the 
same concepts and has similar features as the Payment Entry page. An advance can be 
paid to one or more payees. The payee can be a standard payee that can be selected from a 
a predefined list of values or a nonstandard payee. For nonstandard payees, you must enter 
the details of the remittance.

Oracle Daybreak creates entries for the posted advances on the AP Transaction form. 
These entries can be used to process the remittances.

Batch Upload
With the advance load process, a batch of advances can be loaded into Oracle Daybreak 
(similar to lockbox processing).

Using the Advance Entry page, you can enter and view a batch of advance transactions. 
You can then post a batch, reverse a batch, or place a batch on hold.
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Viewing batches
The Advance Entry page allows you to view either all batches or only open batches. You 
can choose which batch you want to view using the View Options block. Viewing all 
batches allows you to locate batches with a status of OPEN, REVERSE, HOLD, ERROR, or 
POSTED.

To view open batches 

1 On the Batch Transactions menu, choose Advances > Advance Entry.

2 In the View Options block, select Open Batch Only (the default option) and press F8 to 
perform the query.

In the Batch block, Oracle Daybreak displays all batches with a status of OPEN that have 
not been posted.

3 Use the scroll bar in the Batch block to scroll through the list of batches
-or-
Use search criteria in the Batch block (such as batch type, date, and batch number) to 
locate a particular batch.

Details regarding the selected batch appear in the Advances block.
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To view all batches

1 On the Batch Transactions menu, choose Advances > Advance Entry.

2 In the View Options block, select All Batches and press F8 to perform the query.

In the Batch block, Oracle Daybreak displays all batches, regardless of status.

3 Use the scroll bar in the Batch block to scroll through the list of batches
-or-
Use search criteria in the Batch block (such as batch type, date, and batch number) to 
locate a particular batch.

Details regarding the selected batch appear in the Advances block.

If a batch contains an advance with an error status, the Error Reason field displays the 
cause.

To locate a batch with an error

1 On the Batch Transactions menu, choose Advances > Advance Entry.

2 In the View Options block, select All Batches and press F8 to perform the query.

In the Batch block, Oracle Daybreak displays all batches, regardless of status.

3 Press F7, type error in the Batch Status field of the Batch block, and press F8 to perform 
the query.

4 Use the scroll bar in the Batch block to scroll through the list of batches
-or-
Use search criteria in the Batch block (such as batch type, date, and batch number) to 
locate a particular batch.

5 In the Advances block, select the payment with ERROR in its Status field.

Oracle Daybreak displays the cause of the error in the Error Reason field.
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Entering and posting advances
The Advance Entry page allows you to manually post batches of advances. A batch can 
consist of one or more accounts.

To enter and post a batch for advance transactions

1 On the Batch Transactions menu, choose Advances > Advance Entry.

2 In the Batch block, enter the following information:

In this box: Do this:

Company Select the portfolio company (required).
Branch View the portfolio branch, linked to the selected com-

pany (display only).
Date Enter the batch date (required).
Batch Type Select the batch type (required).
Total # Enter the total number of advances in the batch 

(required).
Total Amt Enter the total amount of advances in the batch 

(required).
Batch # View the batch number (system generated) (display 

only).
Batch Status View the batch status (display only).
Total # View the total number of advances in the batch (actual) 

(display only).
Total Amt View the total amount of advances in the batch (actual) 

(display only).
3 Save your entry.
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4 The Advances block records itemized information of the batch advance. It allows you to 
make one advance to one account, or more than one advance to more than one account. In 
the Advances block, enter the following information:

In this box: Do this:

Account # Select the account number (required).
Account #: Title View the account number (display only).
Date Enter the advance effective date (required).
Amount View the advance amount (display only).
Promotion Select the promotion associated with advance (required).
Mode Select the advance mode (optional).
Reason Select the reason for the advance (optional).
Status View the advance status (display only).
Error Reason View the reason for error (display only).
Reference Enter any reference information (such as check number) 

(optional).

5 In the Advance Allocation block, enter the following information:

In this box: Do this:

Account Enter the advance amount to be paid to this payee 
(required).

Validate Payee View the validate payee indicator. If selected, indicates 
that the payee needs to be validated.

Payee # Select the payee number (required).
Name Enter the payee name (required).
Type Select the payee type (required).
Pmt Mode Select the payee payment mode (required).
Address Enter the address line 1 for the payee (optional).
Address 2 (unlabeled) Enter the address line 2 for the payee (optional).
Zip Select the zip code where the payee is located (optional).
City Enter the city where the payee is located (optional).
State Select the state where the payee is located (optional).
Zip Extension (unlabeled) Enter the zip extension where the payee is located 

(optional).
Country Select the country where the payee is located (required).
Bank Name Enter the payee ACH bank name (optional).
Routing # Enter the payee ACH bank routing number (optional).
Account Type Enter the payee ACH bank account type (optional).
ACH Account # Enter the payee ACH bank account number (optional).
Account # Enter the customer account number with the payee 

(optional).
Comment Enter a comments for this advance allocation (optional).

6 Save your entry.
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Oracle Daybreak updates the display only Total # and Total Amt fields in the Batch block 
to record the contents of the Advances block.

Note: Before you can post a batch transaction on the Advance Entry page, the contents of 
the display only Total # and Total Amt fields must match the contents of the required Total 
# and Total Amt fields. 

7 In the Action block, choose Post.

Oracle Daybreak changes the batch status from OPEN to PROCESSING and submits the 
batch to the job service. After the batch has been processed, Oracle Daybreak changes the 
batch status to POSTED or ERROR.
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The posted advances can be viewed on the Customer Service (2) master tab’s Transaction 
page on the Customer Service form.

Oracle Daybreak creates entries for the posted advances on the AP Transaction page. 
These entries can be used to process the remittances.
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Holding, removing a hold on, and reversing a batch of advance trans-
actions

To hold the batch of advance transactions

Note: Only the batches with the status of OPEN can be put on hold.

1 On the Batch Transactions menu, choose Advances > Advance Entry.

2 On the Advance Entry page, select Open Batches Only in the View Options block and 
press F8 to perform the query. 

3 Use the Batch block to search for and select the batch you want to hold.

4 In the Action block, choose Hold/Open.

Oracle Daybreak changes the batch status from OPEN to HOLD.

To open (or remove hold) on the batch of advance transactions

Note: Only the batches with a status of HOLD can be opened.

1 On the Batch Transactions menu, choose Advances > Advance Entry.

2 On the Advance Entry page, use the View Option block to select All Batches, and press 
F8 to perform the query.

3 Use the Batch block to search for and select the batch with the status of HOLD you want to 
open.

4 In the Action block, choose Hold/Open.

Oracle Daybreak changes the batch status from HOLD to OPEN.

To reverse the batch of payment transactions

Batches can be reversed in case of problems with the batch. This will reverse all advances 
that have been posted.

Note: Only the batches with a status of POSTED can be reversed.

1 On the Batch Transactions menu, choose Advances > Advance Entry.

2 On the Payment Entry page, use the View Option block to select All Batches, and press 
F8 to perform the query.

3 Use the Batch block to search for and select the batch with the POSTED status you want to 
reverse.

4 In the Action block, choose Reverse.

Oracle Daybreak changes the batch status from POSTED to PROCESSING and submits the 
batch to the job service. After the batch has been processed, Oracle Daybreak changes the 
batch status to REVERSE. 

Note: You can verify the reversal using the Transaction page on the Customer Service 
form for each account in the batch or by running the payment history report (Reports > 
Run > Payment History > (Loan). 
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Advance Maintenance page
The Advance Maintenance page on the Consumer Lending (Advance and Payment) 
allows you to perform maintenance functions on individual advances that have been 
posted. The common functions are as follows:

Function: Purpose:

Modify Allows you to modify advance attributes such as amount, 
account number, and date.

Reverse Allows you to reverse the advance from the account com-
pletely.

In all cases, Oracle Daybreak performs “true backdating” to post the transaction based 
upon the transaction date. Interest recalculations are automatic and all necessary transac-
tions can be sent to the general ledger for automatic reconciliation.

Suspended advances
In case of advances that are not posted to accounts due to issues such as incorrect account 
condition, the advances are posted to suspense. You must process these advances using the 
work queue for suspense advances. This would typically involve identifying the correct 
amount or correcting problems with the account before attempting to re-post the advance. 
In this case, the advance is moved out of the suspense account and posted to the specified 
account.

To view advances 

1 On the Batch Transactions menu, choose Advances > Advance Maintenance.
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2 In the View Options block, select which advance you want to view:

If you choose: In the Advances block, Oracle Daybreak displays:

Posted Posted advances.
Suspense Suspended advances. In cases of advances that have been 

posted to suspense, the Suspense work queue can be used 
to process them (similar to suspense payments).

All All advances.

3 Press F8 to view either all posted advances or all advances in suspense
-or-
Use the Enter-Query mode to limit the search using criteria in the Advances block.

Oracle Daybreak displays the selected advances in the Advances block. 

4 In the Advances block, view the following information:

In this field: View this:

Account # Account number.
Title Account title.
Txn Dt Advance effective date.
Txn Amt Advance amount.
Mode Advance mode.
Reason Advance reason.
Reference Reference information for advance.
Status Advance status.

5 Select an advance in the Advances block and view the following additional information:

In this field: View this:

Company Portfolio company.
Branch Portfolio branch.
Batch # Batch number.
Batch Type Batch type.
Date Displays batch date.

Modifying and reversing advance transactions
In some cases, an advance may be valid, but how it was posted was incorrect; for example, 
an advance was posted to the wrong account, with the wrong date, or with incorrect spread 
data. The Advance Maintenance page allows you to correct such errors.

To modify (correct) an individual advance transaction

1 On the Batch Transactions menu, choose Advances > Advance Maintenance.

2 In the View Options block, select the type of advances you want to view: Posted, Sus-
pense, or All.

3 Press F7 to move to Enter-Query mode.

4 In the Advance block, complete the field(s) you want to use to locate an advance 
(Account #, Title, Txn Dt ...).
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5 Press F8 to perform the query.

Oracle Daybreak displays advances matching your search criteria in the Advances block.

6 Select the advance that you want to modify.

7 In the Action block, select Modify.

8 In the Details block, update the fields with information about the advance you want to 
modify.

In this box: Do this:

Account # : Title Select account number (required).
Txn Dt Enter advance effective date (required).
Amt Enter advance amount (required).
Reason Select advance reason (optional).
Error Reason View reason for error (display only).

9 Save your entry.

Oracle Daybreak modifies the original advance and posts the new advance.

To reverse an individual advance transaction

1 On the Batch Transactions menu, choose Advances > Advance Maintenance.

2 Press F7 to move to Enter-Query mode.

3 In the Advance block, complete the field(s) you want to use to locate an advance 
(Account #, Title, Txn Dt, or any other field).

4 Press F8 to perform the query.

Oracle Daybreak displays advances matching your search criteria in the Advances block.

5 Select the advance that you want to reverse.

6 In the Details block, complete the Reason field (if you choose). You shouldn’t have to 
update any other fields when reversing a transaction.

7 In the Action block, select Reverse.

8 Save your entry.

Oracle Daybreak reverses the original advance.

The reversed advance can be viewed when you load the account on the Customer Service 
form from the Customer Service (2) master tab’s Transaction page.
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Search page
A Search page is available on the Consumer Lending (Advance and Payment) form to help 
locate information such as an account’s number, company and branch. This is information 
that is used on the Payment Entry and Payment Maintenance pages.

To search for an account

1 On the Batch Transactions menu, choose one of the following:

Advances > Advance Entry 
Advances > Advance Maintenance
Payments > Payment Entry 
Payments > Payment Maintenance

2 Choose the Search tab.

The Consumer Lending (Advance and Payment) form’s Search page appears.

3 In the Search Criteria block, use the Comparison Operator and Value columns to enter 
the search criteria you want to use to locate an account. 

4 Choose Search.

Oracle Daybreak displays the result of the search in the Results block at the bottom of the 
page. 

Note: You can use the “Cut” and “Paste” commands to copy the Account # to other text 
boxes. You can also sort your results using the Sort block. For more information, see the 
Using the Sort block section in the Oracle Daybreak Tools chapter.

Note: Choose Reset Criteria at any time to clear the Comparison Operator and Values 
columns on the Search page.
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CHAPTER 5 : ESCROW ANALYSIS

The Escrow Analysis module complies with the RESPA guidelines to provide annual 
escrow analysis to the borrower for escrowed items.

Oracle Daybreak enables you to perform escrow analysis with the Escrow Analysis and 
Escrow Analysis Maintenance master tabs and perform escrow disbursement with the 
Escrow Disbursement Entry and Escrow Disbursement Maintenance master tabs. All four 
master tabs appear on the Escrow Analysis and Disbursements form, opened from the 
Escrow command on the Batch Transactions menu.

Escrow Analysis master tab
The Escrow Analysis page allows you analyze accounts involving escrow disbursement. 
Accounts are analyzed in batches, or “analysis groups.” Oracle Daybreak generates a 
batch number for the analysis group and sets the batch status to OPEN. You can view and 
process the accounts included in the analysis group. You can then exclude from an analy-
sis group the accounts that produce errors. Also, you can perform an escrows analysis for 
a period between two and 12 months. By default, the analysis horizon is selected as 12 
months from the date of the analysis. 

The accounts retrieved using the Account Search page can be loaded on the Escrow Anal-
ysis by choosing the Load Accounts button. The fields present in the Analysis Group 
block further filter the records retrieved from the Account Search page.

To enter an escrow analysis batch

1 On the Batch Transactions menu, choose Escrow > Analysis > Analysis Entry.

2 On the Escrow Analysis and Disbursements form, choose the Search master tab.
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3 Use the Account Search page to locate the accounts that require escrow analysis (for 
more information, see the Search master tab section at the end of this chapter.)

4 Choose the Escrow Analysis master tab.

5 Press F6 if you need to clear the Analysis Group block.

6 In the Analysis Group block, enter the following information.

In this field: Do this:

Company Select the portfolio company (required).
Branch View the portfolio branch.
Date Enter the batch date (required).
Analysis Type Select the analysis type. The analysis type (INITIAL 

ESCROW ANALYSIS DISCLOSURE, REGULAR, COM-
PLIANCE, and so on) is a list of user-defined values 
(required).

Batch # View the system generated batch number with a format 
of ANA-YYYY-DDD-SEQNUM (display only).

Batch Status View the batch status (display only).
Processed Dt View the user analysis process date (display only).
Processed By View the user who processed the analysis (display only).

7 If you select the Override Stop Analysis check box, Oracle Daybreak ignores the Stop 
Escrow Analysis flag on the account.

8 In the Action block, choose Load Accounts.

Oracle Daybreak loads the accounts from the search page that match the company and 
branch in the Analysis Group block.

9 In the Accounts block, enter the following information.

In this field: Do this:

Title View the account title (display only).
From Date Enter the from date (start analysis from MM/DD/YYYY) 

(required).
To Date Enter the to date (end analysis at MM/DD/YYYY) 

(required).
Comment View the comment (display only).
Status View the payment status (display only).
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10 Select the Include check box if you want to include the account in the analysis. Clear the 
Include check box if you want to remove the account in the analysis.

11 In the Action block, choose Process Accou...

Oracle Daybreak performs the analysis and changes the batch status to PROCESSING. 

If Oracle Daybreak successfully processes the batch, it changes the batch status to PRO-
CESSED. The individual accounts will all have a status of NEW. The analysis group can 
now be viewed on the Escrow Analysis Maintenance page.
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If Oracle Daybreak is unable to process one or more individual accounts in the batch, it 
changes the batch status to ERROR. One or more of the individual accounts will have sta-
tus of ERROR. The reason of the error appears in the Comment field.

To reprocess an analysis batch with a status of ERROR

1 In the Analysis Group block on the Escrow Analysis page, load the analysis group with 
the status of ERROR.

2 In the Accounts block, clear the Include box for the accounts with a status of ERROR.

3 In the Action block, choose Process Accou....

Oracle Daybreak performs the analysis and changes the batch status to PROCESSING. 

The analysis group can now be viewed on the Escrow Analysis Maintenance master tab.

Escrow Analysis Maintenance master tab
The Escrow Analysis Maintenance master tab allows you to review and maintain escrow 
analysis for each account in a selected analysis group (batch). 

Analysis Group page
With the Analysis Group page, you can:

• Review the analysis results for a selected batch
• Approve the analysis
• Cancel the analysis.

An escrow analysis for a batch may retrieve more than one account. These accounts 
appear in the Analysis sub page along with the:

• Parameters used for the analysis
• Results of the analysis (standard payment, along with additions or deductions and the 

resulting new payment)
• Any surplus or shortage
• Escrow items used for analysis and the disbursement rule
• Analysis details, which lists all the escrow transactions.

Oracle Daybreak then allows you to:

• Reanalyze the account after making changes to the account on the Customer Service 
form if the status of the analysis is OPEN, ERROR, REVIEW or APPROVED. 

• Delete an analysis.
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To view the Analysis Group page 

1 On the Batch Transactions menu, choose Escrow > Analysis > Escrow Maintenance.

2 Choose the Analysis Group tab.

3 In the Batch Group block, view the following display only information.

In this field: View this:

Company The portfolio company.
Branch The portfolio branch.
Date The batch date.
Analysis Type The analysis type.
Batch # The system generated batch number.
Batch Status The batch status.
Processed Dt & By The user analysis process date and the user who pro-

cessed the analysis.
Reviewed Dt & By The user analysis review date and the user who reviewed 

the analysis.
Approved Dt & By The user analysis approved date and the user who 

approved the analysis.
Override Stop Analysis Override stop analysis indicator.
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To review the analysis results for a selected batch

1 On the Batch Transactions menu, choose Escrow > Analysis > Analysis Maintenance.

2 Choose the Analysis Group tab.

3 In the Batch Jobs block on the Analysis Group page, use the Batch Status field and the 
enter-query mode to search for batch you want to review. Note: A new batch will have a 
batch status of PROCESSED.

4 In the Action block, choose Review.

Oracle Daybreak changes the Batch Status field to PROCESSING.

5 In the Batch Jobs block, use the Batch # field and the enter-query mode to search of the 
escrow analysis group you reviewed. Note: The group will have a batch status of 
REVIEWED.

To approve the analysis

1 On the Batch Transactions menu, choose Escrow > Analysis > Analysis Maintenance.

2 Choose the Analysis Group tab.

3 In the Batch Jobs block on the Analysis Group page, use the Batch # field and the enter-
query mode to search for the batch with the status of REVIEWED you want to approve.

4 In the Action block, choose Approve.

Oracle Daybreak changes the Batch Status to PROCESSING.

5 In the Batch Jobs block, use the Batch # field and the enter-query mode to search for the 
escrow analysis group which now has a status of APPROVED.

To cancel the analysis

1 On the Batch Transactions menu, choose Escrow > Analysis > Analysis Maintenance.

2 Choose the Analysis Group tab.

3 In the Batch Jobs block on the Analysis Group page, use the Batch # field and the enter-
query mode to search for the batch you want to cancel.

4 In the Action block, choose Cancel.

Oracle Daybreak changes the Batch Status for the selected status group to PROCESSING.

5 Choose the Escrow Analysis master tab.

The batch you cancelled now has a status of CANCELLED in Analysis Group block.

Searching for the batch on the Escrow Maintenance master tab will produce no returns, as 
Oracle Daybreak has deleted all analysis details.
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To reanalyze escrow analysis

1 On the Batch Transactions menu, choose Escrow > Analysis > Escrow Maintenance.

2 Choose the Analysis Group tab.

3 In the Batch Jobs block on the Analysis Group page, use the Batch Status field and the 
enter-query mode to search for the batch you want to reanalyze. Note: You can only rean-
alyze an account if the status of the analysis batch is OPEN, ERROR, REVIEWED, or 
APPROVED.

4 On the Analysis sub page, use the Parameters block to search for the account you want 
to reanalyze.

5 In the Parameters block on the Accounts page, view the following display only informa-
tion:

In this field: View this:

Date The date.
Acc # The the account # and title.
Escrow Activity From Dt The from date.
Escrow Activity To Dt The to date.
Opening Bal (Act) The opening balance actual amount.
Opening Bal (Est) The opening balance estimated amount.
Cushion Type The cushion type.
Cushion Value The cushion value.
Cushion Amt The cushion amount.
Status The status of the analysis.

6 In the Results block, view the following information:

In this field: View this:

Std Pmt Amt The standard payment amount.
(+) Escrow Pmt Amt The escrow payment amount.
(+) Spread Pmt Amt The spread payment amount.
(+) Other Pmt Amt The other payment amount.
= New Pmt Amt The new payment amount.

7 In the Surplus/<Shortage> block, view the following information:

In this field: View this:

Surplus/<Shortage Amt> The surplus shortage amount.
Refund Amt The refund amount.

8 In the Approval block, view the following information:

In this field: View this:

Approval Dt The approval date.
Approved By The user id of who approved the analysis.

9 In the Analyzed Escrow Items block, view the following information:

In this field: View this:

Escrow The escrow.
Disbursement Rule The disbursement rule.
Yearly Amt The yearly amount.
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10 In the Analysis Details block, view the following information:

In this field: View this:

Txn Dt The transaction date.
Transactions The transactions.
Vendor The vendor name.
Txn Amt The transaction amount.
Bal Amt (Est) The balance amount estimated.
Bal Amt (Act) The balance amount actual.

11 In the View block, choose how you want to view the information in the Analysis Details 
block.

If you choose: Oracle Daybreak displays:

Current Estimated The current estimated analysis.
Last Estimated The last estimated analysis.
Last Actual The last actual analysis.

12 In the Escrow Analysis block on the Analysis sub page, choose Re-Analyze.

Oracle Daybreak clears the Parameters block.

13 When you search for the account in the Parameters block, the status is now NEW.

To delete an individual analysis

1 On the Batch Transactions menu, choose Escrow > Analysis > Escrow Maintenance.

2 Choose the Analysis Group tab.

3 In the Batch Jobs block on the Analysis Group page, use the Batch Status field and the 
enter-query mode to search for the batch with the individual analysis you want to delete.

4 In the Analysis sub page, use the Parameters block to search for the escrow analysis you 
want to delete.

5 In the Escrow Analysis block, choose Delete.

Oracle Daybreak changes the Status field in the Parameters block to DELETED.
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Accounts page
As an alternative to selecting an analysis group and then selecting an account, use the 
Escrow Analysis Maintenance master tab’s Accounts page to directly view an account. 
You can then use the Analysis sub page to reanalyze or delete an escrow analysis follow-
ing the same steps described previously in the Analysis Group page section of this chap-
ter.

To view an escrow analysis for an account 

1 On the Batch Transactions menu, choose Escrow > Analysis > Analysis Maintenance.

2 Choose the Accounts tab.

In the Accounts block on the Accounts page, view the following information:

In this field: View this:

Account # Title The standard payment amount.
Analysis Type The escrow payment amount.
Analysis Dt The spread payment amount.

3 Use the Accounts block on the Accounts page and enter-query mode to search for the 
account with the escrow analysis you want to view on the Analysis sub page.
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Escrow Disbursement Entry master tab
With the Escrow Disbursement Entry page, you can make payments on escrow from Ora-
cle Daybreak in the form of disbursement batches. Disbursement batches record the fol-
lowing information in the Disbursement Group block:

• Company/branch of the account
• Total dollar amount of disbursements
• Total number of disbursements.

The Details block allows you record the following information for each escrow disburse-
ment batch: 

• Account number
• Transaction date
• Disbursement amount 
• Escrow sub type.

You can use the Disbursement Entry page to:

• Validate disbursement totals entered in the Disbursement Group block against the 
transaction totals entered in the Details block

• Post a validated disbursement entry batch
• Cancel a disbursement entry batch. Note: A posted batch cannot be cancelled.
• Temporarily place a disbursement entry batch on hold before validating or posting it.
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Viewing batches
The Disbursement Entry pages allows you to view either all escrow disbursement batches 
or only open escrow disbursement batches. You can choose which type of batch you want 
to view using the View Options block. Viewing all batches allows you to locate escrow 
disbursement batches with a status of OPEN, PROCESSING, PROCESSED, ERROR, or 
CANCELLED.

To view open batches 

1 On the Batch Transactions menu, choose Escrow > Disbursements > Disbursement 
Entry.

2 In the View Options block on the Disbursement Entry page, select Open Batch Only 
and press F8 to perform the query.

In the Disbursement Group block, Oracle Daybreak displays all batches with a status of 
OPEN that have not been posted.

3 Use the scroll bar in the Disbursement Group block to scroll through the list of batches
-or-
Use search criteria in the Disbursement Group block to locate a particular batch.

Details regarding the selected escrow disbursement batch appear in the Details block.

To view all batches

1 On the Batch Transactions menu, choose Escrow > Disbursements > Disbursement 
Entry.

2 In the View Options block of the Disbursement Entry page, select All Batches and press 
F8 to perform the query.

In the Disbursement Entry block, Oracle Daybreak displays all batches, regardless of sta-
tus.

3 Use the scroll bar in the Disbursement Group block to scroll through the list of batches
-or-
Use search criteria in the Disbursement Group block to locate a particular batch.

Details regarding the selected escrow disbursement batch appear in the Details block.
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To locate a batch with an error

1 On the Batch Transactions menu, choose Escrow > Disbursements > Disbursement 
Entry.

2 In the View Options block, select All Batches and press F8

In the Disbursement Group block on the Disbursement Entry page, Oracle Daybreak dis-
plays all batches, regardless of status.

3 Press F7, type errored in the Batch Status field of the Disbursement Group block, and 
press F8 to perform the query.

4 Use the scroll bar in the Disbursement Group block to scroll through the list of batches
-or-
Use search criteria in the Disbursement Group block to locate a particular batch.

5 In the Details block, select the payment with ERROR in its Status field.

Oracle Daybreak displays the cause of the error in the Comment field.
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Validating and posting batches

To validate and post an escrow disbursement batch

1 On the Batch Transactions menu, choose Escrow > Disbursements > Disbursement 
Entry.

2 In the Disbursement Group block on the Disbursement Entry page, enter the following 
information (If necessary, press F6 to clear the block):

In this field: Do this:

Company Select the portfolio company (required).
Branch View the portfolio branch (display only).
Date Enter batch date. Oracle Daybreak uses this date and the 

number of preprocess days (if in use) to determine when 
to disburse the payment (required).

Batch # View the system generated batch number with a format 
of DSB-YYYY-DDD-SEQNUM (display only).

Total # Enter total number of disbursements in the batch.
Total Amt Enter total amount of disbursements in the batch.
Batch Status View batch status (display only).
Total # View total number of actual disbursements in the batch 

(display only).
Total Amt View total amount of actual advances in the batch (dis-

play only).

3 Save your entry.

4 The Details block records itemized information of the escrow disbursement batch. It 
allows you to make one payment for one account, or more than one payment to more than 
one account. In the Details block, enter the following information:

In this field: Do this:

Account # Enter the account number (required).
Title View the title (display only).
Txn Dt Enter the disbursement date (required).
Amount Enter the disbursement amount (required).
Escrow Type Select the escrow type (required).
Sub Type View the escrow sub type (display only).
Vendor View the vendor (display only).
Status View the status (display only).
Include Include indicator (display only).

5 After you record a payment in the Details block, save your entry. 

Oracle Daybreak updates the display only Total # and Total Amt fields in the Disburse-
ment Group block to record the contents of the Details block.

Note: Before you can post a escrow disbursement batch on the Disbursement Entry page, 
the contents of the display only Total # and Total Amt fields must match the contents of 
the required Total # and Total Amt fields. If not, Oracle Daybreak displays the following 
dialog box:
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6 In the Action block, choose Validate Batch.

Oracle Daybreak changes the escrow disbursement batch status from OPEN to PROCESS-
ING and submits the batch to the job service. After the batch has been processed, Oracle 
Daybreak changes the its status to POSTED or ERRORED.

If an escrow disbursement batch has a status of ERRORED, the accounts in the Details 
block with the status of ERROR must be excluded from the Disbursement Group before 
the batch can be posted.

7 Clear the include box of any accounts in the Details block with a status of ERROR, then 
choose Validate Batch again.

When an escrow disbursement batch has a status of PROCESSED, the Post Batch button in 
the Action button is available.

8 In the Action block, choose Post Batch.

Oracle Daybreak changes the status for the accounts in the Details block included in the 
escrow disbursement batch to POSTED and creates an entry on the Disbursement Mainte-
nance page.

Oracle Daybreak also creates an entry for the escrow disbursement on the AP Requisitions 
page.
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Holding and removing a hold on an escrow disbursement batch

To hold an escrow disbursement batch

Note: Only escrow disbursement batches with the status of OPEN can be put on hold.

1 On the Batch Transactions menu, choose Escrow > Disbursements > Disbursement 
Entry.

2 On the Disbursement Entry page, use the View Option block to select the batch you want 
to place on hold:

• If the batch status is OPEN, select Open Batches Only in the View Options block and 
press F8 to perform the query. 

If the batch status is ERROR, select All Batches in the View Options block, press F8 to 
perform the query. 

3 Use the Disbursement Group block to search for and select the escrow disbursement 
batch you want to hold.

4 In the Action block, choose Hold Batch.

Oracle Daybreak changes the escrow disbursement batch status from OPEN to HOLD.

To open (or remove hold) on an escrow disbursement batch

Note: Only escrow disbursement batches with a status of HOLD can be opened.

1 On the Batch Transactions menu, choose Escrow > Disbursements > Disbursement 
Entry.

2 On the Payment Entry page, use the View Options block to select All Batches, and press 
F8 to perform the query.

3 Use the Batch block to search for and select the escrow disbursement batch with the status 
of HOLD you want to open.

4 In the Action block, choose Validate Batch.

Oracle Daybreak changes the escrow disbursement batch status from OPEN to PROCESS-
ING and submits the batch to the job service. After the batch has been processed, Oracle 
Daybreak changes the its status to POSTED or ERRORED.
If an escrow disbursement batch has a status of ERRORED, the accounts in the Details 
block with the status of ERROR must be excluded from the Disbursement Group before 
the batch can be posted.

5 Clear the include box of any accounts in the Details block with a status of ERROR, then 
choose Validate Batch again.

When an escrow disbursement batch has a status of PROCESSED, the Post Batch button in 
the Action button is available.

6 In the Action block, choose Post Batch.

Oracle Daybreak changes the status for the accounts in the Details block included in the 
escrow disbursement batch to POSTED and creates an entry on the Disbursement Mainte-
nance page.
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Canceling an escrow disbursement batch

To cancel an escrow disbursement batch

Note: Only the escrow disbursement batches with the status of OPEN, PROCESSED, 
HOLD, or ERRORED can be canceled.

1 On the Batch Transactions menu, choose Escrow > Disbursements > Disbursement 
Entry.

2 On the Disbursement Entry page, use the View Options block to select the escrow dis-
bursement batch you want to cancel.

• If the batch status is OPEN, select Open Batches Only in the View Options block and 
press F8 to perform the query. 

• If the batch status is PROCESSED, HOLD, or ERRORED, select All Batches in the View 
Options block, press F8 to perform the query. 

3 Use the Disbursement Group block to search for and select the escrow disbursement 
batch you want to cancel.

4 In the Action block, choose Cancel Batch.

Oracle Daybreak changes the Status field in the Details block to VOID.

When you refresh the Disbursement Entry page, the escrow disbursement batch that you 
canceled has a batch status of CANCELLED in the Disbursement Group block.
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Escrow Disbursement Maintenance page
The Disbursement Maintenance page allows you to cancel escrow disbursement transac-
tions.

To cancel the Disbursement Maintenance

1 On the Batch Transactions menu, choose Escrow > Disbursements > Disbursement 
Maintenance.

2 On the Disbursement Maintenance page, use the enter-query mode and search for the 
disbursement you want to cancel using the Acc # field in the Disbursements block.

3 In the Disbursements block, view the following display only information:

In this field: View this:

Acc # The account number.
Title The title.
Txn Dt The disbursement date.
Amount The amount.
Escrow Type The escrow type.
Sub Type The sub type.
Vendor The vendor.
Status The status.
Include Include indicator.
Company The portfolio company.
Branch The portfolio branch.
Batch # The batch number.
Reason The reason.
Pmt Mode The payment mode.
Reference The reference.
Comment The comment.

4 Select the disbursement you want to void and choose Void in the Action block.

Oracle Daybreak changes the status of the escrow disbursement to VOID.
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To view the canceled escrow disbursement on the AP Requisition page

1 On the Interfaces menu, choose AP Transactions.

2 On the Payee Type block of the AP Requisition form, choose All.

3 On the Pmt Mode block, choose All.

4 On the Status block, choose Void.

On the AP Requisitions page, note that Oracle Daybreak changed the status of the escrow 
disbursement to VOID.
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Search master tab
The Account Search page allows you to locate the accounts on which the escrow analysis 
is to be performed. You can select accounts for an escrow analysis using the following 
attributes in the Criteria column of the Search Criteria block (Note: The client can config-
ure this list to search on other account attributes, if desired): 

• ACCOUNT NUMBER 
• ACCOUNT STATUS
• ACCOUNT STATE 
• ACCOUNT LAST ESCROW ANALYSIS DATE - This date on which an escrow analysis 

was last performed on the account.
• ESCROW ANALYSIS REQUIRED INDICATOR - If the account has not been analyzed 

for more than X number of months, where X is a system parameter, the accounts will 
be tagged as Escrow Analysis Required.

• ESCROW ANALYSIS STOPPED INDICATOR - In the Escrow block on the Loan page 
of Funding form’s Contract (5) master tab, was the Allowed box checked (Y) or 
cleared (N).

• PRODUCT

To search for an account

1 On the Batch Transactions menu, choose one of the following:

Escrow > Analysis > Analysis Entry
Escrow > Analysis > Analysis Maintenance
Escrow > Disbursements > Disbursement Entry
Escrow > Disbursements > Disbursement Maintenance

2 Choose the Search tab.

3 In the Search Criteria block, use the Comparison Operator and Value columns to enter 
the search criteria you want to use to locate an account. 
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4 Choose Search.

Oracle Daybreak displays the result of the search in the Results block at the bottom of the 
page.

In this field: View this:

Company The company.
Branch The branch.
Account # The account number.
Date The account effective date.
Title The account title.
Product The product.
Status The account status.
Producer The producer.

If the Secured box is selected, the account has a customer classified as secured.

Note: You can use the “Cut” and “Paste” commands to copy the account number to other 
text boxes on other pages on the Escrow Analysis and Disbursements form.

• If the search criteria fails to locate any accounts, Oracle Daybreak displays the following 
dialog box.

• If you choose Reset Criteria, Oracle Daybreak clears the contents of the Search Criteria 
block and refreshes with the its default values.

To search for accounts that require escrow analysis

1 On the Batch Transactions menu, choose one of the following:

Escrow > Analysis > Analysis Entry
Escrow > Analysis > Analysis Maintenance
Escrow > Disbursements > Disbursement Entry
Escrow > Disbursements > Disbursement Maintenance

2 Choose the Search tab.

3 In the Search Criteria block, complete the ESCROW ANALYSIS REQUIRED INDICATOR 
criteria with a value of Y.

4 In the Search Criteria block, complete the ESCROW ANALYSIS STOPPED INDICATOR 
criteria with a value of N.

5 Choose Search.

Oracle Daybreak displays all the accounts that require escrow analysis.
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CHAPTER 6 : ACCOUNTS PAYABLE (REQUISITIONS)
A payable requisition is a request for payment (or bill) submitted in writing. Financial 
institutions create payable requisitions to:

• Advance the money to their customers
• Make the third party payments on behalf of the customer
• Pay the producer on behalf of the customer
• Make invoice payments to vendors

The AP Transaction form allows you to view requisitions in Oracle Daybreak and com-
plete the following tasks:

• View requisitions for all payees
• Put a requisition on hold
• Close a requisition
• Cancel a requisition

This chapter explains how.

AP Requisitions page
The AP Requisitions page displays information regarding advance payments, such as 
payee type, mode of payment, status, and other details.

To view requisitions for all payees

1 On the Interfaces menu, choose AP Transactions.

The Requisitions block contains three sets of option buttons, each in its own block: 
Payee Type, Pmt Mode, and Status. These option buttons allow you to narrow the range 
of the requisitions Oracle Daybreak displays.
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The Payee Type block allows you to view requisitions according to whom the payment is 
made.

If you choose: Oracle Daybreak displays:

All All payees.
Producer Producer payees (Note: This is the default option).
Third Party Third party payees.
Vendor Vendor payees.
Customer Customer payees.

The Pmt Mode block allows you to view requisitions by how the payment is made.

If you choose: Oracle Daybreak displays:

All All requisitions.
Check Requisitions paid by check (Note: This is the default 

option).
ACH Requisitions paid by ACH.

The Status block allows you to view requisitions according to status.

If you choose: Oracle Daybreak displays:

All All requisitions.
Open Open requisitions (Note: This is the default option).
Close Closed requisitions.
Hold Requisitions on hold.
Void Canceled requisitions.

2 Use the Payee Type, Pmt Mode, and Status buttons to the select the requisitions you 
want to view.

Oracle Daybreak displays the following information for the requisitions matching your 
criteria:

In this field: Oracle Daybreak displays:

Requisition block
Company AP transaction company.
Branch AP transaction branch.
Dt AP transaction date.
Status AP transaction status (OPEN, CLOSE, HOLD, or VOID).
Payee Type AP transaction payee type (PRODUCER, THIRD PARTY, 

VENDOR, or CUSTOMER).
Payee AP transaction payee number and name.
Pmt Mode AP transaction payment mode.
Amount AP transaction payment amount.
Check Ref # AP transaction check reference number.
Check Dt AP transaction check date.
Address AP transaction payee address.

Details block
Amount Transaction detail payment amount.
Effective Dt Transaction detail effective date.
Description Transaction detail description.
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Note: An Open transaction will not have a credit reference number, as it has not been 
entered or generated. (See the screen shot above.)

3 Scroll the list to select the requisition you want to view or work with. (You can further 
limit your selection by pressing F7, entering search criteria in display fields, and pressing 
F8.)

Printing a check
You can print checks on pre-printed stationary using the AP Transaction form’s AP Requi-
sition page. The Print Check button is available for entries in the Requisitions block with 
an Open status and where Check is the mode of payment.

To print a check for a requisitions

1 On the Interfaces menu, choose AP Transactions.

2 Use the Payee Type button to the select the payee type regarding the entry for which you 
want to print a check.

3 In the Pmt Mode block, choose Check.

4 In the Status block, choose Open.

5 In the Action block, choose Print Check.

Oracle Daybreak send the check details directly to the printer.

Closing a requisition
When the transactions are paid, the requisition should be closed. When you close a requi-
sition, Oracle Daybreak marks it “closed;” it cannot be paid again. Oracle Daybreak gen-
erates the appropriate GL (general ledger) transactions.

To close a requisition

1 Open the AP Requisition form and use the Payee Type, Pmt Mode, and Status buttons 
to load the requisition you want to close.
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2 Select the requisition you want to close and in the Action block, select Close.

3 Complete the Check Ref # field with the check reference number and the Check Dt field 
with when the check was issued.

4 Save your entry.

5 In the Status block, choose Close and view the account.

Putting a requisition on hold
To ensure that the requisition is not paid or closed, you can put it “on hold.” When a requi-
sition is on hold, requisitions cannot be closed. 

To put a requisition on hold

1 Open the AP Requisition form and use the Payee Type, Pmt Mode, and Status buttons 
to load the requisition you want to hold.

2 Select the requisition.

3 In the Action buttons, select Hold.

4 Save your entry.

5 In the Status block, choose Hold and view the account.

Voiding a requisition
Voiding a requisition cancels the requisition.

To void a requisition

1 Open the AP Requisition form and use the Payee Type, Pmt Mode, and Status buttons 
buttons to load the requisition you want to void.

2 Select the requisition.

3 In the Action block, select Void.

4 Save your entry.

5 In the Status block, choose Void and view the account.
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CHAPTER 7 : CARD TRANSACTIONS

The Card Transactions form allows you to view credit card transactions and refundable 
credit card payments.

Card Transactions page
The Card Transactions page allows you to view credit card transactions involving:

• Sales
• Pre-approved sales
• Authentications
• Refunds

To view credit card transactions

1 On the Interfaces menu, choose Card Transactions.

The Card Transaction Log block contains three sets of option buttons, each in its own 
block: Card Type, Transaction Type, and Status. These option buttons allow you to nar-
row the range of the card transaction Oracle Daybreak displays.

The Card Type block allows you to view card transactions according to type of credit 
card.

If you choose: Oracle Daybreak displays:

All All credit card transactions.
Visa Visa credit card transactions.
Discover Discover credit card transactions.
AmEx American Express credit card transactions.
Diner’s Club Diner’s Club credit card transactions.
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The Transaction Type block allows you to view credit card transactions by the type of 
transaction

If you choose: Oracle Daybreak displays:

All All credit card transactions.
Sale Credit card transactions regarding sales.
Pre Approved Sale Credit card transactions regarding pre-approved sales.
Authentications Credit card transactions regarding authentications.
Refunds Credit card transactions regarding refunds.

The Status block allows you to view requisitions according to status.

If you choose: Oracle Daybreak displays:

All All credit card transactions.
Processed Processed credit card transactions.
Failed Failed credit card transactions.

2 Use the Card Type, Transaction Type, and Status buttons to the select the credit card 
transactions you want to view.

Oracle Daybreak displays the following information for the credit card transactions 
matching your criteria:

In this field: Oracle Daybreak displays:

Txn Dt The credit card transaction date.
Account Name The account number and title.
Card Type The credit card type.
Card Number The credit card number.
Expiration Dt The credit card expiration date.
Reference # The transaction reference number.
Requested Amt The requested amount.
Approval # The transaction pre-approval number.
Status The transaction status.
Processed If selected, indicates that the credit card transaction has 

been processed.

3 Scroll the list to select the requisition you want to view or work with. (You can further 
limit your selection by pressing F7, entering search criteria in display fields, and pressing 
F8.)

4 In the Response/Message block, view the processing response/message for the selected 
credit card transaction.
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Card Refunds page
The Card Refunds form allows you to view refundable credit card payments and apply a 
refund.

To refund a credit card payment

1 On the Interfaces menu, choose Card Transactions.

2 On the Card Transactions form, choose the Card Refunds tab.

In the Refundable Credit Card Payments block, view the following display only infor-
mation:

In this field: View this:

Txn Dt The credit card transaction date.
Account Name The account number and title.
Card Type The credit card type.
Card Number The credit card number.
Expiration Dt The credit card expiration date.
Reference # The transaction reference number.
Requested Amt The requested amount.
Approval # The transaction pre-approval number.

3 Select the credit card payment that you want to refund and choose Refund.
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CHAPTER 8 : TRANSACTION AUTHORIZATION (MAKER-
CHECKER)

Transaction Authorization enables you to validate transactions that were entered on the 
Customer Service form’s Maintenance (3) master tab by a different Oracle Daybreak user. 
You can view these transactions on the Transaction Authorization form before they are 
posted. This process is referred to as “Maker-Checker”, as one Oracle Daybreak user 
enters (or “makes”) the transaction on Customer Service form and another validates (or 
“checks”) the transaction on the Transaction Authorization form. 

Maker The person who posts (or makes) the transaction on the 
Maintenance (3) master tab.

Checker The person who checks the details entered by the maker 
on the Transaction Authorization form and either accepts 
or rejects the transaction.

As an example, the checker might be review transactions to determine if the transaction 
will increase the credit limit to an acceptable level or decrease the payment to an unaccept-
able level.

Note: Maker-Checker applies only to manual transactions. Automated transactions will 
continue to use existing methods.
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Customer Service form
On the Customer Service form, follow the existing process for posting transactions on the 
Maintenance (3) master tab of completing the fields in the Action block and choosing 
Post. If the Authorization check box is selected for the transaction on the Administration 
form’s Transaction page, rather than being posted, the transaction receives a status of 
WAITING FOR APPROVAL and the message TRANSACTION IN WAITING FOR 
APPROVAL appears on the Results block.

Authorization page
The Authorization page displays the transactions posted on the Customer Service form’s 
Maintenance (3) master tab requiring authorization. 

The checker uses the Authorization page to view transactions with the status WAITING 
FOR APPROVAL and then approve or reject the transaction. 

The maker uses the Authorization page to post approved transactions and modify the 
transactions with a status of ERROR or REJECT. Transaction with an ERROR status have 
failed to post for reasons such as transaction is not allowed for condition of account, or the 
parameter value is incorrect, such as a back dated date. Transaction with an REJECT have 
been rejected by the checker. In both statuses, the maker can modify the transaction and 
re-post it for the checker to review. 

Note: The same user who initiated the request cannot authorize the transaction even 
though that user might have the checker responsibility.

To authorize or reject a transaction the Authorization page

1 On the Lending menu, choose Transaction Authorization.

2 On the Transaction Authorization page, choose the Authorization tab.
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3 On the Authorization page, in the Queury block choose Checker.

4 In the View Last block, choose one of the following to limit the display of transactions in 
the Transactions block according to when the transaction was posted:

If you choose: Oracle Daybreak displays:

1 Day The transactions posted within the last one day.
2 Day The transactions posted within the last two days.
5 Day The transactions posted within the last five days.
All Days The posted transactions.

Oracle Daybreak displays transactions entered on the Maintenance (3) master tab with a 
status of ERROR or WAITING FOR APPROVAL.

Note: If you want to view all transactions with a status of ERROR in the Transactions 
block, select View Failed in the Failed block.

5 Select the transaction you want to approve or reject in the Transactions block.

Oracle Daybreak displays information from the Customer Service form’s Maintenance (3) 
master tab regarding the transaction in the Result block.

Note: When you double-click a transaction in the Transaction block, Oracle Daybreak 
opens the Customer Service form and loads the account listed in the Account # field. 

6 If you want to authorize the transaction, choose Authorize in the Transaction block.

If you want to reject the transaction, choose Reject in the Transaction block.

7 If you want to add a comment regarding the transaction and your decision, complete the 
Comments field in the Transaction block.

8 Choose Post in the Action block.

Depending on what you chose in step 6, Oracle Daybreak authorizes or rejects the transac-
tion and removes it form the Transaction block.

You can view the transaction result on the Transaction Form’s Authorization History page.

The results of decision on the can be viewed on the Customer Service form’s Maintenance 
(3) master tab.

The Oracle Daybreak user who posted the transaction on the Customer Service form’s 
Maintenance (3) master tab and received a WAITING FOR APPROVAL status can open the 
Authorization page, choose Maker in the Query block and view all the transaction they 
posted that have a status of error or reject.

If the transaction has a status of ERROR or REJECT, make the required changes to the orig-
inal transaction on the Authorization page and select Post in the Action block.

If you choose Void the Action block, Oracle Daybreak removes the transaction from the 
Transaction Authorization form.
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Review Request page
The Review Request allows for effective communication between the Maker and Checker. 
The Transaction Authorization form’s Review Request page operates the same way as the 
existing Oracle Daybreak Review Request page found on the Customer Service form. One 
difference is that the Transaction Authorization form’s Review Request page contains the 
Transaction field.

Note: Review requests created on the Transaction Authorization form can be viewed in 
the Customer Service form’s Review Request page. However, the Transaction Authoriza-
tion form’s Review Request page will only display transaction authorization requests.

For detailed instructions regarding the use of the Review Request page, please see the fol-
lowing Review Request chapter.
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Authorization History page
The Authorization History page displays the all the transactions with a status of OPEN, 
VOID, ERROR, POSTED, WAITING FOR APPROVAL, and REJECT. Aged transactions will 
not be displayed. The Search Criteria block allows you to select the transactions you want 
to view in the Results block.

To search for accounts using the Authorization History page

1 On the Lending menu, choose Transaction Authorization.

2 On the Transaction Authorization page, choose the Authorization History tab.

3 In the Search Criteria block, use the Comparison Operator and Value columns to enter 
the search criteria you want to use to locate an account. 

4 Choose Search.

Oracle Daybreak displays the result of the search in the Results block at the bottom of the 
page. 

Note: Choose Reset Criteria at any time to clear the Comparison Operator and Values 
columns on the Search page.

5 In the Results block, view the following information:

In this field: View this:

Account # The account number.
Transaction The transaction. 
Maker View the user Id of the person who entered the 

transaction on the Customer Service form. 
Initiated Date View the date and time the transaction was ini-

tially posted on the Customer Service form.
Maker View the user Id of the person who validated the 

transaction on the Authorization page. 
Authorized Dt The authorized date.
Comments Any comment attached to the transaction.
Start Date The transaction start date.
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End Date The transaction end date.
Elapsed Time The elapsed time of the transaction.

End of Day (EOD) processing
The Transaction Authorization form’s Authorization page employees the 24 x 7 accessi-
bility feature introduced in previous Oracle Daybreak releases. You can continue working 
with the Authorization page and post transactions even when end of day (EOD) batch pro-
cess is running. When you post a transaction on the Transaction Authorization form’s 
Authorization page and the transaction posting is deferred or cannot be posted at the 
present time, “SYSTEM UNDER MAINTENANCE. TRANSACTION POSTING DEFERRED” 
appears in the Results block. If transaction posting is deferred, Oracle Daybreak automati-
cally posts the transactions once it completes batch processing. 
Chapter 8 :-6   User Guide - Consumer Loans Servicing 



CHAPTER 9 : REVIEW REQUESTS

The Review Requests page is primarily a workflow tool used to flag an account for the 
attention of another Oracle Daybreak user and ask for feedback. It allows Oracle Day-
break users to send and receive messages (including e-mail) that make comments regard-
ing a specific account. 

In this chapter, you will learn how to:

• Review a request
• Send a review request
• Respond to a review request
• E-mail a review request
• Close a review request.
 
The Customer Service form’s Review Request page is nearly identical, though the 
Account # column replaces the Application # column.

Review Requests page blocks
The Review Requests pages contains the following blocks:

• Query
• Action
• Email
• Review Request

The Query block contains these option buttons:

If you choose this: Oracle Daybreak:

Originator Displays the active messages with your user id in the 
Originator column of the Review Request block. These 
are the review requests you created.

Receiver Displays the active messages with your user id in the 
Receiver column of the Review Request block. These are 
the messages you received.

Both Displays in the Review Requests block all the active 
messages you created and received with a status other 
than CLOSED.

View All Displays in the Review Requests block all the messages 
you sent and received, both the active and closed.
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The Action block contains these command buttons:

If you choose this: Oracle Daybreak:

Send Request Sends a review request to another Oracle Daybreak user.
Send Response Sends a response to a review request from another Oracle 

Daybreak user.
Close Changes the status of the message to “Closed” and 

removes it from the Review Request block. Note: You 
can view messages with a CLOSED status by selecting 
View All in the Query block.

The Email block contains these command buttons:

If you choose: Oracle Daybreak:

Originator Sends an email of the review request information to the 
person listed in the Originator column on the Review 
Request block.

Receiver Sends an email of the review request to the person listed 
in the Receiver column on the Review Request block.

Note: The email recipient cannot respond or reply to e-mails with the email system.
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Reviewing a request
When you receive a review request, Oracle Daybreak notifies you by completing the 
Pending Request parenthesis in the form’s title bar with the number of unseen messages.

If you are working loan origination and you have a review request, the Pending Request 
parenthesis in the Underwriting or Funding form will contain a number.

If you are working with an account, the Pending Request parenthesis in the Customer Ser-
vice form will contain a number.

To review requests

1 On the Lending menu, choose Underwriting or Funding if you are working in loan origi-
nation or Customer Service is your are working with accounts.

2 If the Pending Request parenthesis in the title bar contains a number, choose the Search 
(1) master tab, then choose the Review Requests tab.

3 In the Query block, choose Receiver.

In the Review Request block, Oracle Daybreak displays all open messages you have 
received. The Review Requests block contains these fields:

In this field: Do this:

Originator View the user id of the request originator (display only).
Priority View the request priority: HIGH, NORMAL, or LOW (dis-

play only).
Receiver Select the request receiver (required).
Application # (Underwriting and Funding forms only) Select the appli-

cation number which needs review (required).
Account # (Customer Service form only) Select the account number 

which needs review (required).
Reason Select the review reason (required).
Status View the request status (display only).
Date View the request creation date (display only).
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Originator Comment Enter the originator comment (optional).
Receiver Comment Enter the receiver comment (optional).

Note: If you double-click an entry in the Review Request block, Oracle Daybreak does the 
following:

On this form: Oracle Daybreak:

Underwriting Loads the application and displays the Primary Applicant 
page.

Funding Loads the application and displays the Primary Applicant 
page.

Customer Service Loads the account and displays the Account Details page.
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Sending a message
The Send Request button allows you to send a message to another Oracle Daybreak user. 
However, you must save your message before this button is available.

To send a review request

1 Using the Underwriting, Funding, or Customer Service form, load the account to which 
the message applies.

2 Choose the Search (1) master tab, then choose the Review Request tab.

3 In the Query block, choose Originator. (If necessary, press F6 to create a new record.)

The account number for the loaded account appears in the Account # field.

4 In the Priority field, select High, Normal, or Low from the LOV.

Note: This Priority field helps guide the recipient in responding to requests. It does not 
affect the order in which messages are sent or received.

5 In the Receiver field, use the LOV to select the person you want to receive the message.

6 The Account # field displays the number of the account in the form’s master block. If no  
account is currently loaded, you can use the LOV to complete the field. You can also use 
this field to reference an account other than the one currently loaded on the form.

7 In the Reason field, use the LOV to select the purpose for the review request.

8 In the Originator Comment field, type any additional message you want to send.

9 Choose Save.

10 In the Action block, choose Send Request.

In the Review Request block, the Status field changes to WAITING FOR RESPONSE and 
Oracle Daybreak sends the message.
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Responding to a message
When you receive a message, Oracle Daybreak will notify you by completing the Pending 
Request parenthesis in the form’s title bar with the number of unseen messages. In the fol-
lowing example, two messages are waiting on the Review Request page. 

To respond to a review request

1 On the Lending menu, choose Underwriting or Funding if you are working in loan origi-
nation or Customer Service is your are working with accounts.

2 Choose the Search (1) master tab, then choose the Review Requests tab.

3 In the Query block, select Receiver.

Oracle Daybreak displays the unread messages in the Review Request block.

4 In the Review Request block, double-click the request you want to view.

Oracle Daybreak loads that request’s account on the current form.

5 Perform the request from message on the account.

6 Type your response in the Receiver Comment field.

7 In the Action block, choose Send Response.

Oracle Daybreak sends your response to the originator’s workstation, where it appears on 
the Review Request page with the status RETURN TO ORIGINATOR
The recipient can view the sent response by choosing Receiver and View All in the Query 
block. (The message has a status of RETURN TO ORIGINATOR.)

Back on the originator’s Review Request page, the message appears when Originator is 
selected in the Query block. The message has a status of RETURN TO ORIGINATOR.

Note: Choose Close in the Action block to remove the message from the Review Request 
block.
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E-mailing a review request
While Oracle Daybreak updates the Pending Request number on the title bar to alert you 
of new messages, you can also e-mail a review request to either the originator or a 
receiver. Oracle Daybreak will use the e-mail address recorded in the User Definition 
block on the Administration form’s User page. 

Note: E-mail addresses must be recorded for both the originator and receiver for this fea-
ture to work.

To e-mail a review request

1 On the Lending menu, choose Underwriting or Funding if you are working in loan origi-
nation or Customer Service is your are working with accounts.

2 Choose the Search (1) master tab, then choose the Review Requests tab.

3 Select the message you want to e-mail in the Review Request block.

4 In the Email block, choose Originator to send the message to the person listed in the Orig-
inator field. 
-or-
Choose Receiver to send it to the person listed in the Receiver field.

Oracle Daybreak displays one of the following dialog boxes:

5 Choose Ok.
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Closing a message
You can close a message you created at anytime, regardless of status. However, you can 
only close messages that have your user id in the Originator field. When you close a mes-
sage, Oracle Daybreak removes if from the Review Request block.

To close a message

1 In the Review Request block, select the message you want to close.

2 In the Action block, choose Close.

Oracle Daybreak assigns the message the status of CLOSED and removes it from your 
Review Request block. 

Note: You can review closed accounts anytime by selecting View All in the Query block.
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CHAPTER 10 : IMAGE MAINTENANCE / DOCUMENT TRACKING

The Documents menu opens the Image Maintenance form and the Account Document 
Tracking form. Both allow for the paperless storage of documents within Oracle Daybreak 
with accounts during customer service.

Account Document Tracking form
The Account Document Tracking form contains two pages: the Document Tracking page 
and the Document Maintenance page. The Document Maintenance page allows you to 
attach documents to an account in the form of GIF files, PDF files, DOC files, XLS files, 
and TXT files. The Document Tracking page allows you to view these documents. Any 
documents that were attached to the account when it was still an application, (such as the 
application received as a fax and saved as a GIF file), also appear on the Document Track-
ing page.

This chapter explains how use the Image Maintenance form to:

• View an image
• Search for an image
• Split an image of more than one page
• Change the status of an image
• Combine two images into a multiple page image
• Attach an image to an existing application
• Print an image
• Attach documents to applications and then view these documents in a browser.

It also explains how to use the Account Document Tracking form to attach documents to 
accounts and then view these documents in a browser.
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Document Tracking page (Account Document Tracking form)
You can view the documents attached to a particular account by loading the account on the 
Customer Service form, then opening the Account Document Tracking form. You can also 
open the Account Document Tracking form and select from a list of all accounts with doc-
uments attached on the Document Tracking page.

To locate an account document (method one)

1 On the Documents menu, choose Account > Tracking.

The Account Document Tracking form’s Document Tracking page appears.

2 Press F7 to move to Enter-Query mode, in the Acc # field type the account number you 
want to view, and then press F8 to perform the query.
-or-
Select View All and use the scroll box to choose the account with the documents you want 
to view.

Information about the documents attached to the account appears in the Account Docu-
ment and Account Document Details blocks.

To locate an account document (method two)

1 Open the Customer Service form and load the account with the attached document you 
want to view.

2 On the Documents menu, choose Account > Document Tracking.

The Account Document Tracking form appears with the account loaded in Account block 
and information about the document in the Account Document and Account Document 
Details blocks.
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To view a document attached to an account

1 Using one of the two methods above, load the account with the document you want to 
view.

2 In the Account block, view the following information:

In this field: View this:

Acc# Account number.
Account Status Account status.
Title Account title.

3 In the Account Document block, view the following information:

In this field: Do this:

Document Type View the document type (display only).
Comment Enter comment (optional).

4 In the Account Document Details block, view the following information:

In this field: Do this:

Document Sub Type View the document sub type (display only).
Version View the version (version numbers will be incremental 

by batch job, first version will start with 1.0) (display 
only).

Page # View the page number (display only).
Document File Type View the document file type (display only).
Comment Enter comment (optional).

5 Use the Account Document and Account Document Details block to select the docu-
ment you want to view. 

• In multiple paged documents, choose 1 in the Page # field on the Account Document 
Details block to view the all the pages in the document
-or-

• Choose a specific page number to view only that page.

6 Choose View Document.

Oracle Daybreak opens a browser to display the actual document (which browser appears 
depends on what type of document you selected and what browsers are set up to work in 
conjunction with your Oracle Daybreak system).

7 If you want, add comments to the Comments field in the Account Document and 
Account Document Details blocks.

8 Save your entry.
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Document Maintenance page (Account Document Tracking form)
Oracle Daybreak supports the online attachment of document images to an account with 
the Account Document Tracking form’s Document Maintenance page. You can attach the 
documents from either a client machine or server. A default image directory can be main-
tained in Oracle Daybreak using the system parameter: UIX_DEFAULT_IMAGE_PATH. 

When you choose List File in the New Document block on the Document Maintenance 
page, Oracle Daybreak displays all available files in the selected directory in the Docu-
ment Details block. You can use the Document Maintenance and Action blocks to attach 
selected documents to a particular account.

To attach a document to an account from a server

1 On the Documents menu, choose Account > Maintenance.

The Account Document Tracking form’s Document Maintenance page appears.

2 In the Action block, choose Attach Document (Server).

3 In the Select Document block, use the default image directory in the Directory Path 
field. (The default path is the value for the system parameter 
UIX_DEFAULT_IMAGE_PATH).
-or-
In the Directory Path field, enter the full path name to the document on the server that you 
want to attach to an account.

Note: You can choose Reset Path at any time to return to the default image directory.

4 In the Select Document block, choose List File. 

Oracle Daybreak displays the files from the entry in the Select Document block’s Direc-
tory Path in the Document Details block.

5 In the Document Details block, enter the following information:

In this field: Do this:

File Name View the file name (display only).
Document Type Enter the document type (required).
Document Sub Type Enter the document sub type (required).
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Comments Enter any comment you want to associate with the docu-
ment attached to the account (optional).

Acc# Enter the account number of the account to which you 
want to attach the document (optional).

Note: If a document is attached to an account, and the account is loaded on the Customer 
Service form, when you open the Account Document Tracking form’s Document Mainte-
nance page, the account number appears in the Document Maintenance block’s Acc# field. 
You can view the document in a browser by choosing View Document in the Action 
block.

6 Select the Attach indicator to attach the file to the account.

7 Save your entry.

8 In the Action block, choose Post.

Oracle Daybreak attaches the document to the account. The document can be viewed 
using the Account Document Tracking form’s Document Tracking page.

To attach a document to an account from a client machine

1 On the Documents menu, choose Account > Maintenance.

2 In the Action block, choose Attach Document (Client).

3 In the Select Document block, choose Upload From Client. 

An Open dialog box appears.

4 In the Open dialog box, use the Look in: list box to locate the document you want to 
attach to the account.

Note: You can select multiple files by holding the CTRL or SHIFT key on your keyboard.

5 When you have located the document you want to attach to the account in the Open dialog 
box’s File name: field, choose Open.

6 Oracle Daybreak uploads the selected file to the Document Maintenance page and dis-
plays the progress in the Upload Status block.

In this field: View this:

Total File(s) The total files uploaded from client.
Last File The last uploaded file name.
Bytes Uploaded The file upload status in bytes.
File Upload Status (%) The file upload status in percentage.
Overall Upload Status (%) The overall upload status in percentage.

7 In the Document Details block, enter the following information:

In this field: Do this:

File Name View the file name (display only).
Document Type Enter the document type (required).
Document Sub Type Enter the document sub type (required).
Comments Enter any comment you want to associate with the docu-

ment attached to the account (optional).
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Acc# Enter the account number of the account to which you 
want to attach the document (optional).

8 Select the Attach indicator to attach the file to the account.

9 Save your entry.

10 In the Action block, choose Post.

Oracle Daybreak attaches the document to the account. The document can be viewed 
using the Account Document Tracking form’s Document Tracking page.

You can also view the document in a browser by choosing View Document in the Action 
block.

Copy Document
The Action block’s Copy Document command copies the document image from one 
account to another account. This command has no impact on the source account or the 
source account’s document image.

To copy a document to an account from another account

1 On the Documents menu, choose Account > Maintenance.

2 In the Action block, choose Copy Document.

3 In the Document Maintenance block, use the Acc# field to locate the account with the 
image you want to copy.

4 In the Document Maintenance block, choose Search. 

Oracle Daybreak displays the files attached to that account in the Document Details block.

5 In the Document Details block, select the document you want to copy.

6 In the Copy/Move Acc # field, enter the account number of the account to which you want 
to copy the document.

7 Save your entry.

8 In the Action block, choose Post. 

Move Document
The Action block’s Move Document command moves an existing document image from 
one account to another account. This command detaches the document image from the 
source account and attach to second account. 

To move a document to an account from another account

1 On the Documents menu, choose Account > Maintenance.

2 In the Action block, choose Copy Document.

3 In the Document Maintenance block, use the Acc# field to locate the account with the 
image you want to move.
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4 In the Document Maintenance block, choose Search. 

Oracle Daybreak displays the files attached to that account in the Document Details block.

5 In the Document Details block, select the document you want to move.

6 In the Copy/Move Acc # field, enter the account number of the account to which you want 
to move the document.

7 Save your entry.

8 In the Action block, choose Post.
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CHAPTER 11 : CORRESPONDENCE

Oracle Daybreak features two types of correspondence: predefined correspondence tem-
plates for loans included in the baseline system and ad-hoc correspondence that you create 
yourself. The predefined correspondence address matters regarding customer service and 
collections for accounts. They also enable financial organizations to manage bulk mail-
ings.

Servicing: WELCOME LETTER
ACCOUNT STATEMENT
PAYOFF QUOTE LETTER
PAID IN FULL LETTER
RATE CHANGE INFORMATION LETTER
CUSTOM LETTER 1
CUSTOM LETTER 2

Ad-hoc correspondence allows you to include information from accounts in documents 
templates you create yourself without manually transferring the data. Ad-hoc documents 
can be generated as either Microsoft Word or PDF files.

Note: Predefined correspondence templates are stored on the Product Setup form’s Letters 
tab’s pages (Setup > Products > Loan > Letters > Loan Letters).
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Request page
Ad-hoc correspondence can be viewed on the Request page when you have opened an 
account. The page allows you to generate a new letter or view a previously generated let-
ter.

To generate an ad hoc correspondence

1 On the Lending menu, choose Funding, Underwriting, or Customer Service and load 
the account for which you want to generate the ad hoc correspondence.

2 On the Letters menu, choose Ad-hoc.

3 In the Correspondence Request block, the following information appears regarding the 
account currently loaded:        

In this field: View this:

Level The correspondence type.
Number/Title The entity number and title.
Company The entity company.
Branch The entity branch.

4 In the Correspondence block, use the Correspondence field’s LOV to select the type of 
correspondence you want to generate.

Oracle Daybreak displays the following information in the Correspondence block for the 
selected type of correspondence:

In this field: View this:

Id View the correspondence id (display only).
Correspondence Select the correspondence you want to generated 

(required).
Date View the correspondence generation date (display only).
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5 Press F10 to save your entry.

The Documents block displays all the types of documents available for the type of corre-
spondence you selected. 

6 In the Documents block, view the following information for each document:

In this field: View this:

Document Id The document Id.
Document The document description.
Recipient The recipient description.
E-Form Source The e-form source.
Source Type The source type.
Generated If selected then Oracle Daybreak generated the docu-

ment.

7 In the Documents block, select the correspondence you want to view.

The Elements block displays the elements Oracle Daybreak used to generate the corre-
spondence. 

• If you choose All, Oracle Daybreak displays all elements in the correspondence.

• If you choose User Defined, Oracle Daybreak displays user-defined elements in the corre-
spondence.

8 In the Elements block, view the following information:

In this field: Do this:

Element View the element description.
Content Enter/view the value of the element.

9 Choose User Defined and complete the Content fields for the Element fields you want to 
include in the correspondence.

10 Choose Generate.

Oracle Daybreak “locks” the information included in the correspondence and prevents it 
from being changed.

11 Choose View.

Oracle Daybreak displays a PDF of the ad hoc correspondence.
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Samples of Oracle Daybreak LS predefined correspondence

Servicing: Welcome letter
The predefined loan Welcome letter is automatically sent a configurable number of days 
after an account is activated after the loan origination process.

The Welcome letter is available for loans (fixed and variable rate).

To generate the Welcome letter

1 On the Customer Service form, load the account you want to receive the Welcome letter.

2 On the Letters menu, choose Pre-defined.

3 On the Run submenu, choose how you want to view the correspondence (Print or Pre-
view).

4 On the Servicing sub menu, choose Welcome.
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Example of the Welcome letter (loan - fixed and variable rate)
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Servicing: Payoff Quote
The predefined Payoff Quote is sent if a payoff quote is requested for an account. Payoff 
quotes can be manually generated using the Maintenance (3) master tab on the Customer 
Service form with the Payoff Quote transaction.

To generate the Payoff Quote

1 On the Customer Service form, load the account you want to receive the Payoff Quote.

2 On the Letters menu, choose Pre-defined.

3 On the Run submenu, choose how you want to view the correspondence (Print or Pre-
view).

4 On the Servicing sub menu, choose Payoff Quote.
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Example of the Payoff Quote letter (loan - fixed and variable rate)
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Servicing: Paid in Full letter
The predefined Paid in Full letter is automatically sent a configurable number of days after 
an account is fully paid off on the Customer Service form.

The Paid in Full letter is available for loans.

To generate the Paid in Full letter

1 On the Customer Service form, load the account you want to receive the Paid in Full let-
ter.

2 On the Letters menu, choose Pre-defined.

3 On the Run submenu, choose how you want to view the correspondence (Print or Pre-
view).

4 On the Servicing sub menu, choose Paid In Full.
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Example of the Paid in Full letter (loan - fixed and variable rate)
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Servicing: Rate Change Intimation Letter
For loans with interest rates based on index (variable rate loans), it is standard practice to 
inform the borrower about upcoming interest rate changes due to a change in the rate 
index. Oracle Daybreak can print pre-rate change intimation letters both automatically and 
manually. The Rate Change Intimation letter informs borrowers that their rate index has 
changed. All borrowers with the changed index may receive a rate revision on the next 
rate change, which is due after X days (X is a company parameter that can be set with pre-
process days). 

The Rate Change Intimation letter is available only for variable rate loans and lines of 
credits.

To generate the Rate Change Intimation letter

1 On the Customer Service form, load the account you want to receive the Paid in Full let-
ter.

2 On the Letters menu, choose Pre-defined.

3 On the Run submenu, choose how you want to view the correspondence (Print or Pre-
view).

4 On the Servicing sub menu, choose Rate Change Intimation Letter.
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Example of the Rate Change Intimation letter (loan - variable rate)
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CHAPTER 12 : USER PRODUCTIVITY

The User Productivity form is a supervisor feature that allows you to monitor the daily 
performances of Oracle Daybreak users completing loan origination and loan servicing 
tasks. These tasks are categorized as either underwriting/funding tasks (loan origination) 
or customer service/collection tasks (loan servicing). 

Note: Oracle Daybreak updates this display only form every day.

Using the User Productivity form, you can review the following daily tallies: 

• Number of accounts worked and call activities, by user
• Number of accounts worked and call activities, by queue.

This chapter explains how to use the User Productivity form to view this information.
Chapter 12 :-1   User Guide - Consumer Loans Servicing 



Viewing the Customer Service/Collection tasks
Daily tallies from the Customer Service module appear on the following pages:

• Collector Activity
• Queues Status

Collector Activity page
The Collector Activity page displays the number of accounts worked and call activities by 
collector for the day. It also displays details regarding calls and total number of calls per 
queue.

To view the Collector Activity page

1 On the Monitor menu, choose Users > Productivity > Customer Service/Collection.

2 Choose the Collector Activity tab.

3 In the User block, view the following information:

In this field: View this:

User User code.
Name User name.
Accounts Number of accounts worked.
Call Activities Number of call activities.

4 In the Activity Details block, view the following information for the selected user:

In this field: View this:

Queue Name Queue name.
Left Messages Left message activity count.
Promise To Pay Promise to pay activity count.
No Answer No answer activity count.
Other Other activity count.
Total Total activity count.
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Queues Status page
The Queues Status page displays daily information regarding queues, such as the number 
of accounts worked, number of call activities, number of accounts pending, and totals 
number of accounts in the queue. It also displays information about the users who worked 
these queues and details of the call activities.

To view the Queues Status page

1 On the Monitor menu, choose Users > Productivity > Customer Service/Collection.

2 Choose the Queues Status tab.

3 In the Queues block, view the following information:

In this field: View this:

Company Company.
Branch Branch.
Queue Name Queue name.
Accounts Number of accounts worked.
Activities Number of call activities.
Pending Number of accounts pending.
Total Number of total accounts.

4 In the Activity Details block, view the following information for the selected queue:

In this field: View this:

User User code.
Name User name.
Left Messages Left message activity count.
Promise To Pay Promise to pay activity count.
No Answer No answer activity count.
Other Other activity count.
Total Total activity count.
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CHAPTER 13 :  ACCOUNT BOARDING

The Oracle Daybreak DLS Open Interface module is designed to allow businesses to con-
vert accounts (either approved or partially completed), from an existing system into Ora-
cle Daybreak. At the end of the process, a new account is created in Oracle Daybreak 
which can be viewed on the Customer Service form.It also allows you to board new 
accounts. There are two methods to enter this information into Oracle Daybreak; either a 
data file upload or manual data entry. 

The Conversion App/Ac form
Oracle Daybreak offers the Conversion App/Acc form for converting accounts. This 
form allow you to:

• Record customer details (including employment and address information), contract 
information, and collateral information

• Use edits to verify the completeness of data with a Verification page.
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Master block
In using the Conversion App/Acc form, the first step in converting an account is to com-
plete the master block. 

IMPORTANT:
The conversion process does not create the underlying general ledger (GL) entries at any 
time.

To complete the master block

1 On the Interfaces menu, choose Conversion > Account.

2 Complete the form’s master tab.

In this field: Do this:

App # Enter the account number (required).
Product Select the product associated to this account (required).
Dt Enter the date (the date the account was originally 

received) (required).
Joint Select if the account is joint (optional).
Cos Select if the account is co-signed (optional).
Purpose Select the purpose (optional).
Priority Select the account priority (required).
Status Select the account status and sub status from 
Sub Status (unlabeled) the following two choices (required):

CONVERSION ACCOUNT CREATED
CONVERSION API ACCOUNT
Note: In beginning the conversion process, choose API 
ACCOUNT. After the verification process, you will 
change the status to ACCOUNT CREATED. (See the Veri-
fication section for more information.)

Company Select the portfolio company to which this account 
belongs (required).

Branch (unlabeled) View the portfolio branch to which this account belongs 
(display only).

Existing Customer Select if one of the applicants is an existing customer 
(optional).
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Dup Select if the account is a duplicate account (optional).
Contact Enter the contact (optional).
Channel Select the account channel (required).
Producer Select the producer type and producer (required).
Underwriter View the underwriter name (display only).
Xref Enter the account number (if converting an existing 

account) or the account number (if you need to create an 
account for the funded application). This will help to ref-
erence back to the legacy system. (required).

Conversion Dt Enter the conversion date (required).
New Account Select box if account doesn’t exist in the legacy system.

IMPORTANT: Clear this box if the account transactions 
need to be converted. If this box is selected, data entered 
on the Transaction sub page of the Account master tab 
will not convert.

Conversion Status View the status of the conversion (display only).

3 Save the information you entered on the master block.
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Applicants (2) master tab
The Applicants (2) master tab allows you to record information regarding applicants asso-
ciated with the account. In this section, you will use the information supplied on the appli-
cation, complete the Primary Applicant page and sub pages (Address, Employments, 
Telecoms, and Financials sub pages). If this is a joint account, complete the Others page 
as well. 

To complete the Applicants (2) master tab

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account to which you want to add applicant information. 

3 Choose the Applicants (2) master tab, then choose the Primary tab

4 Enter the following information on the Primary page:

In this field: Do this:

First Name Enter the applicant’s first name (required).
MI Enter the applicant’s middle initial (optional).
Last Name Enter the applicant’s last name (required).
Suffix Select the name suffix/generation (optional).
SSN Enter the applicant’s social security number. Note: If the 

organizational parameter 
UIX_HIDE_RESTRICTED_DATA is set to Y, this appears 
as a masked number; for example, XXX-XX-1234 
(required).

Birth Dt Enter the applicant’s date of birth (required).
Disability Select if the applicant has a disability (optional).
Existing Customer View if this is an existing customer (optional).
Prior Applicant View if this is a prior applicant (optional).
Gender Select the gender of the applicant (optional).
Language Select the applicant’s native language (required).
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Prior Bankruptcy Select if prior bankruptcy exists (optional).
Bankruptcy Discharge Dt Enter the discharge date of prior bankruptcy (if exists).
Existing Customer Select the existing customer (optional).
Marital St Select the marital status of the applicant (optional).
License # Enter the applicant’s license number (optional).
State Select the state of applicant's license (optional).
Email Enter the applicant’s email address (optional).
Class Select the applicant’s classification (required).
Dependents Enter the number of dependants (optional).
Mother’s Maiden Name Enter the mother’s maiden name (optional).
ECOA Select the ECOA code (optional).
Ethnicity Select the applicant’s ethnicity (optional).
Race Select the applicant’s race or national origin (optional).
Time Zone Select the applicant’s time zone (optional).

5 Save your entry.

6 Choose the Address sub tab

7 Enter the following information on the Address sub page:

In this field: Do this:

Address Information block
Mailing Address Select if this is the mailing address (optional).
Current Select if this is the current address (optional).
Type Select the address type (required).
Postal Type Select the postal address type (required).
# Enter the building number (optional).
Pre Select the street prefix (directional) (optional).
Street Name Enter the street name (optional).
Street Type Select the street type (optional).
Post Select the street postfix (directional) (optional).
Apt # Enter the apartment number (optional).
Address View the address as entered on line 1 (optional).
Address 2 (unlabeled) Enter address line 2 (optional).
City Enter the city (optional).
St Select the state code (required).
Zip Select the zip code (required).
Zip Extension (unlabeled) Enter the zip + 4 extension (optional).
Country Select the country (required).
Ph Enter the phone number (required).
Own/Rent Select the own/rent type (required).
Landlord Enter the landlord’s name (optional).
Ph Enter the landlord’s phone number (optional).
Contact Enter the landlord’s main contact (optional).
Title Enter the contact’s title (optional).
Ph Enter the contact’s phone number (optional).
Ext Enter the contact’s phone extension (optional).
Census Tract Enter census tract/BNA (block numbering area) code 

(optional).
MSA Code Enter the metropolitan statistical area (MSA) code 

(optional).
Comment Enter a comment (optional).
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Stated/Actual block
Stated Yrs Enter the stated number of years at residence (required).
Stated Mths Enter the stated number of months at residence 

(required).
Stated Pmt Amt Enter the stated payment amount (required).
Stated Freq Select the stated payment frequency (required).
Actual Yrs Enter the actual years at residence (required).
Actual Mths Enter the actual months at residence (required).
Actual Pmt Amt Enter the actual payment amount (required).
Actual Freq Select the actual payment frequency (required).
Verify Dt Enter the date residence data was verified (optional).
Verify By View the user who verified the data (optional).

8 Save your entry.

9 Choose the Employment sub tab

10 Enter the following information on the Employment sub page:

In this field: Do this:

Employment Information block
Current Select if this is the current employment (optional).
Type Select the occupation (required).
Employer Enter the employer's name (required).
Title Enter the title (optional).
Occupation Select the occupation (optional).
Address Enter the building number (optional).
Address 1 (unlabeled) Enter the address line 1 (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
City Enter the city (optional).
St Select the state (optional).
Zip Select the zip code (optional).
Zip Extension (unlabeled) Enter the zip extension (optional).
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Country Select the country (required).
Ph Enter the work phone number (required).
Extn Enter the work phone number extension (optional).
Contact Enter the contact name (optional).
Title Enter the contact title (optional).
Ph Enter the contact person’s phone number (optional).
Ext Enter the contact person’s phone extension (optional).
Comment Enter a comment (optional).

Stated/Actual block
Stated Yrs Enter the stated number of years with the employer 

(required).
Stated Mths Enter the stated number of months with the employer 

(required).
Stated Income Enter the stated income (required).
Stated Freq Select the frequency (required).
Actual Yrs Enter the actual number of years with the employer 

(required).
Actual Mths Enter the actual number of months with the employer 

(required).
Actual Income Enter the actual income (required).
Actual Freq Select the frequency (required).
Verify Dt Enter the date employment data was verified (optional).
Verify By View the user who verified the data (display only).

11 Save your entry.

12 Choose the Telecoms sub tab

13 Enter the following information on the Telecoms sub page:

In this field: Do this:

Telecom Type Select the telecommunication type (required).
Phone Enter the phone number (required).
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Extn Enter the phone extension (optional).
Start Time Enter the best time to call start time (optional).
Time Period (unlabeled) Select the time period for the best time to call start time, 

AM or PM (optional).
End Time Enter the best time to call end time (optional).
Time Period (unlabeled) Select the time period for the best time to call end time, 

AM or PM (optional).
Time Zone Select the applicant’s time zone (optional).
Current Select if this telecom number is current (optional).

14 Save your entry.

15 Save your entry.

16 Complete the Others page and sub pages (Address, Employments, and Telecoms sub 
pages).

Note: The Other Applicants page only needs to be completed if a secondary or joint appli-
cant exists. If not, this page can be left blank. The Others page contains the same fields 
and the Primary page, with the addition of the Type box. Use it to select the relation of the 
other applicant to the primary. The Other Applicants sub pages are the same as the Pri-
mary Applicant sub pages.

17 Save your entry.
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Decision (3) master tab
On the Decision (3) master tab, Oracle Daybreak records information gathered during the 
underwriting process. Depending on the type of account you are working with, Oracle 
Daybreak will display either the Loan page. These pages all share the following sub pages: 
Stipulations, Itemization (Conversion form only), and Checklist (Conversion form only). 

To complete the Decision (3) master tab

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account to which you want to add underwriting information.

3 Choose the Decision (3) master tab.

• If you are converting a fixed rate loan, use the Loan page to record the following informa-
tion:

In this field: Do this:

Requested block
Advance Enter the requested advance amount (required).
Down % Enter the approximate down payment percentage 

(required).
Pmt Enter the requested payment amount (required).
Down Pmt Enter the approximate down payment amount (required).
Rate Enter the requested interest rate (required).
Approx Prc Enter the approximate cash price (required).
Term Enter the requested term (required).
Promotion Select the requested promotion (required).

System Recommendation block
Decision View the system recommended decision (display only).
Grade View the system recommended grade (display only).
Score View the system recommended score (display only).

Pricing block
Current View current decision indicator (display only).
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Pricing View the pricing (display only).
Decision Dt View the decision date (display only).
Status View the account status (display only).
Sub Status View the account sub-status (display only).
Underwriter View the underwriter id (display only).

• If you are converting a variable rate loan, use the following Loan page to record the fol-
lowing information:

In this field: Do this:

Requested block
Advance Enter the requested advance amount (required).
Down % Enter the approximate down payment percentage 

(required).
Pmt Enter the requested payment amount (required).
Down Pmt Enter the approximate down payment amount (required).
Rate Enter the requested interest rate (required).
Approx Prc Enter the approximate cash price (required).
Term Enter the requested term (required).
Promotion Select the requested promotion (required).
Rescheduled Method View the reschedule method (display only).
Reschedule Value View the reschedule value (display only).

System Recommendation block
Decision View the system recommended decision (display only).
Grade View the system recommended grade (display only).
Score View the system recommended score (display only).

Pricing block
Current If selected, indicates that this is the current decision (dis-

play only).
Pricing View the pricing (display only).
Decision Dt View the decision date (display only).
Status View the application status (display only).
Sub Status View the application sub-status (display only).
Underwriter View the underwriter id (display only).

4 On the Loan page, choose Select Pricing.

Oracle Daybreak validates the pricing information against the information you supplied 
and performs an edits check.

5 If the loan has been approved, complete the Approved block.

• If you are converting a fixed rate loan, record the following information in the Approved 
block:

In this field: Do this:

Term Enter the approved term (required).
Rate Enter the approved rate (required).
Pmt Enter the approved payment amount (required).
Promotion View the approved pricing promotion (display only).
Maturity Rate Enter the maturity rate (required).
Grade Select the credit grade (required).
Score Enter the credit score (required).
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Down Pmt % Enter the approved down payment percentage (required).
Amt Enter the approved down payment amount (required).
Max Advance % Enter the approved advance percentage (required).
Or Amt Enter the approved advance amount (required).
Max Financed % Enter the maximum amount financed percentage 

(required).
Or Amt Enter the maximum amount financed (required).
Collateral Value View the collateral value (display only).
LTV1 View the loan to value ratio (display only).
LTV2 View the loan to value ratio (display only).

• If you are converting a variable rate loan, record the following information in the 
Approved block:

In this field: Do this:

Term Enter the approved term (required).
Rate View the approved rate (display only).
Pmt Enter the approved payment amount (required).
Index Select the approved index (required).
Index Rate Select the approved index rate (display only).
Margin Enter the approved margin rate (required).
Promotion View the approved pricing promotion (display only).
Maturity (Index) Select the approved post maturity index (required).
Maturity (Margin) Enter the maturity rate (required).
Grade Select the credit grade (required).
Score Enter the credit score (required).
Down Pmt % Enter the approved down payment percentage (required).
Amt Enter the approved down payment amount (required).
Max Advance % Enter the approved advance percentage (required).
Or Amt Enter the approved advance amount (required).
Max Financed % Enter the maximum amount financed percentage 

(required).
Or Amt Enter the maximum amount financed (required).
Collateral Value View the collateral value (display only).
LTV1 View the loan to value ratio (display only).
LTV2 View the loan to value ratio (display only).
Bureau 1 Select the bureau 1 (optional).
Bureau 2 Select the bureau 2 (optional).

The Decision (3) master tab’s Loan pages all share the Stipulations and Rate Schedule sub 
pages.

6 Use the Stipulations sub page to add any stipulations you want to attach to the account. 
Stipulations are items that need to be addressed before the loan can be funded.

In this field: Do this:

Type Select the reason type.
Code Select the reason.
Comment Ages of the oldest and newest trades, as well as the aver-

age age of the open and total trades.

7 On the Rate Schedule sub page, view the following display only information:

In this field: View this:
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Rate Schedule block
Seq The rate adjustment sequence number.
Adjustment Frequency Type The rate adjustment frequency type.
Period The rate adjustment period for the frequency.
# of Adjustments The number of rate adjustments for the frequency.

The Rate Schedule sub page displays the rate adjustment frequency information based on 
product setup.

Note: The Rate Schedule sub page is only available for variable rate loans.

8 On the Subvention sub page, view or complete the following fields:

In this field: Do this:

Subvention block:
Plan Enter the subvention plan code (required).
Description View the subvention plan description (display only).
Sub PlanDescription Enter the subvention plan (required).
Subvention Type View the subvention type (display only).
Subvention Amount View the subvention amount for the plan (display only).
Include Select to include the subvention entry (display only).
Participants block:
Participant Enter the participant (required).
Participant Type View the participant type (display only).
Subvention Amt Enter the subvention amount (required).
Rate Enter the subvention rate (required).
Rent factor View the subvention rent factor (display only).
Collection Method Enter the collection method (required).

Refund block:
Method (Paid off) Enter the method if the account is paid-off early 

(required).
Basis (Paid off) Enter the basis if the account is paid-off early (required).
Period (Paid off) Enter the refund period in which the subvention will be 

refunded to the producer (required).
Chapter 13 :-12   User Guide - Consumer Loans Servicing 



Percent (Paid off)                Enter the refund percentage if the account is charged-off 
(required).

Method (Chg off) Enter the method if the account is charged-off (required).
Basis (Chg off) Enter the basis if the account is charged-off (required).
Period (Chg off) Enter the refund period in which the subvention will be 

refunded to the producer (required).
Percent (Chg off) Enter the refund percentage if the account is charged-off 

(required).

Amortization block:
Balance Type Enter the amortize balance type (required).
Method Enter the amortization calculation method (required).
Frequency Enter the amortization frequency (required).
Cost/Fee Enter the amortization fee method (required).
Include Select to include the amortization entry.

Total Subvention Rate View the total subvention rate shared by all participants 
(display only).

Total Subvention Amount View the total subvention amount for current account 
(display only).

9 Save your entry.

10 Save the changes you made to this account.
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Contract (4) master tab
The Contract (4) master tab allows you to perform the important task of completing the 
truth-In-lending details. These pages include information mandated by Regulation Z; 
information about the financed amount, the payment schedule, the total of these payments, 
the finance charge, and the resulting annual percentage rate (calculated according to Fed-
eral guidelines; that is, within .125% of the Treasury OCC calculated APR). 

In completing the truth-in-lending details on the Contract (4) master tab, you will com-
plete the either the Loan page. The truth-in-lending details must be completed before a 
loan can be funded.

To complete the Contract (4) master tab

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account to which you want to add contract information.

3 Choose the Contract (4) master tab.

• If the application you opened is for a fixed rate loan, the following Loan page appears. 
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• If the application you opened is for a variable rate loan, the following Loan page appears. 

4 Using the information from the account you are converting, complete the Contract block.

• On the Loan page for fixed rate loans, the Contract block contains the following fields:

In this field: Do this:

Contract Dt Enter the contract date (required).
Amt Financed Enter the amount financed (required).
Term Enter the term/number of payments (required).
Rate Enter the rate (required).
Balloon Method View the balloon payment method (display only).
Balloon Amt Enter the balloon amount (required).
Due Day Enter the due day (required).
1st Pmt Dt Enter the first payment date (required).
Maturity Dt Enter the maturity date (required).
Finance Chg Enter the finance charge (required).
Total of Pmts Enter the total of payments (required).
Down Pmt Enter the down payment amount (required).
Total Sale Price Enter the total sales price (required).
Payment Amt Enter the payment amount (required).
Final Pmt Amount Enter the final payment amount (required).
APR Enter the APR (required).
Rcvd Dt Enter the contract received date (required).
Verify Dt Enter the contract verification date (optional).
Verified By View the user id who verified the contract (display only).

• On the Loan page for variable rate loans, the Contract block contains the following fields:

In this field: Do this:

Contract Dt Enter the contract date (required).
Amt Financed Enter the amount financed (required).
Term Enter the term/number of payments (required).
Index Select the index (required).
Index Rt View the index rate (display only).
Margin Rt Enter the margin rate (required).
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Rate View the interest rate (display only).
Balloon Method View the balloon payment method (display only).
Balloon Amt Enter the balloon amount (required).
Due Day Enter the due day (required).
1st Pmt Dt Enter the first payment date (required).
Maturity Dt Enter the maturity date (required).
Finance Chg Enter the finance charge: the amount of interest, prepaid 

finance charge, and certain insurance premiums (if any) 
that the borrower will be expected to pay over the life of 
the loan (required).

Total of Pmts Enter the total of payments (required).
Down Pmt Enter the down payment amount (required).
Total Sale Price Enter the total sales price (required).
Payment Amt Enter the payment amount (required).
Final Pmt Amount Enter the final payment amount.This amount will be 

same as that in the Payment Amt field when the install-
ment method is EQUAL PAYMENTS.(required).

APR Enter the annual percentage rate (required).
Rcvd Dt Enter the contract received date (required).
Verify Dt Enter the contract verification date (optional).
Verified By View the user id who verified the contract (display only).
Principal Balance View the principal balance (display only).

5 If applicable, enter information regarding any promotion associated with the account in 
the Promotion block.

• On the Loan page for fixed rate loans, the Promotion block contains the following fields:

In this field: Do this:

Promotion Select the promotion (required).
Type View the promotion type (display only).
Period Type View the period type (display only).
Period View the promotion term (display only).
Tolerance amt View the tolerance amount (display only).

• On the Loan page for variable rate loans, the Promotion block contains the following 
fields:

In this field: Do this:

Promotion Select the promotion (required).
Type View the promotion type (display only).
Dlq Days View the delinquency days (display only).
Period Type View the period type (display only).
Period View the promotion period (display only).
Tolerance amt View the tolerance amount (displays only).
Index View the promotion index (displays only).
Index Rt View the promotion index rate (displays only).
Margin Rt View the promotion margin rate (displays only).
Rate View the promotion rate (display only).

6 Choose Select Instrument and use the LOV to select the predefined contract instrument 
you want use to fund this account.

Oracle Daybreak loads all the rules established by the company that are required at the 
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time of funding; for example, the accrual method, billing method, type of billing, toler-
ance, due dates, extensions, and so on.

• On the Loan page for fixed rate loans, Oracle Daybreak displays the following informa-
tion:

In this field: Do this:

Instrument View the instrument (display only).
Accrual Mthd View the accrual calculation method (display only).
Start Days View the accrual start days (display only).
Start Dt Basis View the accrual start basis (display only).
Base Mthd View the accrual base method (display only).
Bill Mthd View the billing method (display only).
Bill Type View the billing type (display only).
Time Counting Mthd View the time counting method (display only).
Installment Mthd View the installment methods (display only).

Escrow block
Allowed View the escrow allowed indicator. If selected, escrow is 

allowed for this account (display only).
Opt Out Select if you want to decline all escrow options for this 

loan instrument.

Post Maturity block
Default Rate If selected, indicates the default rate is available.
Maturity Rate Enter the past maturity rate (required).

Others block
1st Pmt Deduction View the first payment deduction indicator. If selected, 

the first payment deduction is in use (display only).
Days View the first payment deduction days (display only).

1st Pmt Refund View the first payment refund indicator. If selected, the 
first payment refund is in use.

Days View the first payment refund days (display only).
Pre-Payment Penalty View the prepayment penalty indicator. If selected, a pre-

payment penalty can be applied (display only).
% Term View the prepayment penalty percentage of term (display 

only).
Recourse View the recourse indicator. If selected, there is a 

recourse associated with the loan (display only).
Max % View maximum recourse percentage (display only).
Payoff Fee View the payoff fee indicator. If selected, a payoff fee can 

be applied to the loan (display only).

Rebate block
Rebate Mthd View the rebate calculation method (display only).
Rebate Term Mthd View the rebate term method (display only).
Value View the minimum finance charge value (display only).
Acquisition Charge Amt View the acquisition charge amount (display only).
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• On the Loan page for variable rate loans, Oracle Daybreak displays the following infor-
mation:

In this field: Do this:

Instrument View the instrument (display only).
Accrual Mthd View the accrual calculation method (display only).
Start Days View the accrual start days (display only).
Start Dt Basis View the accrual start basis (display only).
Base Mthd View the accrual base method (display only).
Bill Mthd View the billing method (display only).
Bill Type View the billing type (display only).
Time Counting Mthd View the time counting method (display only).
Installment Mthd View the installment methods (display only).

Escrow block
Allowed View the escrow allowed indicator. If selected, escrow is 

allowed for this account (display only).
Opt Out Select if you want to decline all escrow options for this 

loan instrument.

Post Maturity block
Default Rate If selected, indicates the default rate is available.
Index Select the post maturity index (required).
Maturity Rt Enter the past maturity rate (required).

Others block
1st Pmt Deduction View the first payment deduction indicator. If selected, 

the first payment deduction is in use (display only).
Days View the first payment deduction days (display only).

1st Pmt Refund View the first payment refund indicator. If selected, the 
first payment refund is in use.

Days View the first payment refund days (display only).
Pre-Pmt Penalty View the prepayment penalty indicator. If selected, a pre-

payment penalty can be applied (display only).
% Term View the prepayment penalty percentage of term (display 

only).
Recourse View the recourse indicator. If selected, there is a 

recourse associated with the loan (display only).
Max % View maximum recourse percentage (display only).
Payoff Fee View the payoff fee indicator. If selected, a payoff fee can 

be applied to the loan (display only).

Rate Caps and Adjustments
Increase (Per Adj.) View the maximum rate increase allowed in a year (dis-

play only).
Increase (Max Lifetime) View the maximum rate increase allowed in the life of 

the loan (display only).
Increase (Floor) View the rate cap (minimum) (display only).
Increase (Ceiling) View the rate cap (maximum) (display only).
Decrease (Per Adj.) View the maximum rate decrease allowed in a year.
Decrease (Max Lifetime) View the maximum rate decrease allowed in the life of 

the loan (display only).
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# of Adjs. (Per Adj.) View the maximum number rate changes allowed in a 
year (display only).

# of Adjs. (Max Lifetime)View the maximum number of rate changes allowed in the life 
of the loan (display only).

You are now ready to complete the Contract (4) master tab’s sub pages.
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Completing the Contract (4) master tab (truth-in-lending details) sub 
pages

The Loan page share the following sub pages:

• Contract
• Contract (2)
• Itemizations
• Insurance
• ESC
• Escrow
• Compensation (loan)
• Subvention
• Proceeds
• Disbursement
• Fee
• ACH
• Coupon
This section describes how to complete each one.

Contract sub page
The Contract sub page records the application’s servicing branch and collector. It also dis-
plays additional information regarding the contract not covered on the Loan page, such as 
the tolerance, delinquencies, due dates, billings, and extensions.

To complete the Contract sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account you want to work with.

3 Choose the Contract (4) master tab, then choose the Contract sub tab.

4 On the Contract sub page, view or complete the following fields:
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In this field: Do this:

Servicing Branch Select the servicing branch (required).
Collector Select the default collector (required).

Misc block
Link To Existing Customer Select to link the application to the existing customer
Anniversary Period View the anniversary term (display only).
Default Pmt Spread View the spread (display only).

Billing block
Pre Bill Days View the pre billing days (display only).
Bill Cycle View the billing cycle (display only).

HMDA block
Lien Status Select the lien status (required).
HOEPA Select the home owner equity protection act (HOEPA) 

code (required).
Rate Spread Enter the rate spread. You can calculate this spread from 

a tool on the Home Mortgage Disclosure Act (HMDA) 
website (required).

Tolerance block
Refund View the refund allowed indicator. If selected, the refund 

policies in this block are in use (display only).
Refund Tolerance View the refund tolerance amount (display only).
Pmt Tolerance View the payment tolerance percentage (display only).
Pmt Tolerance (%) View the payment tolerance percentage (display only).
Writeoff Tolerance View the write-off tolerance amount (display only).

Delinquency block
Late Charge Grace Days View the late charge grace days (display only).
Delq Grace Days View the delinquency grace days (display only).
Delq Cat Mthd View the delinquency category method (display only).

Due Date block
Max Due Day Chg Days View the maximum due days (display only).
Min Due Day View the minimum due day (display only).
(Due Day) Max View the maximum due day (display only).
Max Due Day Chg Yr View the maximum due day changes allowed (year) (dis-

play only).
(Max Due Day Chg) Life View the maximum due day changes allowed (life) (dis-

play only).

Extension block
Max Extn Period Yr View the maximum extension allowed (year) (display 

only).
(Max Extn Period) Life View the maximum extension allowed (life) (display 

only).
Max # Extn Yr View the maximum number of extensions allowed (year) 

(display only).
(Max # Extn) Life View the maximum number of extensions allowed (life) 

(display only).

4 Save any changes you made to the application.
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Contract (2) sub page
The Contract (2) sub page records the application’s advance information, repayment 
schedule, and skipped repayment months for variable rate loans.

To complete the Contract (2) sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account you want to work with.

3 Choose the Contract (4) master tab, then choose the Contract (2) sub tab.

4 On the Contract (2) sub page, view or complete the following fields:

In this field: Do this:

Advance block
Multi Disbursement Allowed If selected, indicates that multiple disbursements are 

allowed.
Draw End Dt Enter the advance draw end date (optional).
Initial Advance (Min) View the minimum initial advance amount (display 

only).
Initial Advance (Max) View the maximum initial advance amount (display 

only).
Advance (Min) View the minimum subsequent advance amount (display 

only).
Advance (Max) View the maximum subsequent advance amount (display 

only).
Late Charge Allowed If selected, late charge is allowed during the disburse-

ment period.
Billing Allowed If selected, billing is allowed during the disbursement 

period.
Billing Method View the billing method during the disbursement period 

(display only).
Rate Enter the applicable interest rate during the disbursement 

period (required).
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Repayment block
Flexible Repayment Allowed If selected, indicates that a flexible repayment schedule is 

allowed.
Type Select repayment type (optional).
Skip Months block
Jan If selected, indicates that repayment is skipped for Janu-

ary.
Feb If selected, indicates that repayment is skipped for Febru-

ary.
Mar If selected, indicates that repayment is skipped for 

March.
Apr If selected, indicates that repayment is skipped for April.
May If selected, indicates that repayment is skipped for May.
Jun If selected, indicates that repayment is skipped for June.
Jul If selected, indicates that repayment is skipped for July.
Aug If selected, indicates that repayment is skipped for 

August.
Sep If selected, indicates that repayment is skipped for Sep-

tember.
Oct If selected, indicates that repayment is skipped for Octo-

ber.
Nov If selected, indicates that repayment is skipped for 

November.
Dec If selected, indicates that repayment is skipped for 

December.
Schedule block
Seq Enter the payment sequence number (required).
Pmt Amt Enter the payment amount (required).
# of Pmts Enter the number of payments (required).
Generated If selected, indicates that the schedule is system gener-

ated.
Enabled If selected, indicates that the schedule is enabled.
Extendable Balloon block
Max Term Enter the maximum number of terms for the extendable 

balloon payment (optional).
Payment Change Schedule block
Seq Enter the sequence number in which the repayment is 

calculated (required). 
Note: This prioritizes the calculation.

Option Type Select the repayment option type: STEP UP, STEP DOWN, 
and BULLET (required).

Frequency Select the frequency of payment. The default value is 
TERM (required).

Period Enter the period of each adjustment (required).
# of Adj. Enter the number of times the STEP UP, STEP DOWN, or 

BULLET needs to happen (required).
Value Enter the value. For STEP DOWN, value ranges from 1 to 

99. For STEP UP, value ranges from 1 to 990. For BUL-
LET, value ranges from 1 to 99999999.

5 Save any changes you made to the application.
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Itemizations sub page
Oracle Daybreak lists the distribution of the loan proceeds on the Itemization sub page 
when you choose Select Instrument on the Loan page. It lists amounts paid to the borrower 
directly, amount paid to the borrower’s account, and amount’s given on the borrower’ 
behalf to third parties. Some of the data in the Itemization column, such as compensation, 
comes from information on the Contract page sub page. Itemizations are categorized 
according to advances, finance fees, prepaid fees, producers, or escrows.

To complete the Itemizations sub page 

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account you want to work with.

3 Choose the Contract (4) master tab, then choose the Itemizations sub tab.

4 On the Itemization sub page, view the following information:

In this field: Do this:

Itemization View the itemization (display only).
+/- View whether the itemization is added or subtracted (dis-

play only).
Approved View the approved amount. This is information recorded 

on the Underwriting form (required).
Tax View whether the itemization is taxable (Sales) if box is 

selected.

5 Choose the option button for the type of itemization you want to use: Advance, Financed 
Fees, Pre-Paid Fees, Producer, or Escrow.

6 In the Amount column, enter the amount corresponding with what is listed in the Itemiza-
tion column.

7 If you choose, use the Comment field to add remarks.

8 Save any changes you made on the application.
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Insurance sub page
If there is any information regarding an itemized insurance amount, enter the details on the 
Insurance sub page. The Insurance sub page also allows you to calculate the commission if 
there is a commission rule defined during Contract setup.

To complete the Insurance sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account you want to work with.

3 Choose the Contract (4) master tab, then choose the Insurance sub tab.

4 On the Insurance sub page, view or complete the following information in the Policy 
Information block:

In this field: Do this:

Insurance Plan Enter the insurance plan (optional).
Insurance Type View the insurance type (display only).
Sub Type Select the insurance sub type (required).
Insurance Company Enter the insurance company (optional).
Policy Number Enter the insurance policy number (required).
Phone No Enter the insurance company’s primary phone number 

(optional).
Ext Enter the insurance company’s primary phone extension 

(optional).
Effective Dt Enter the insurance effective date (required).
Expiration Dt Enter the insurance expiry date (optional).
Phone No Enter the insurance company’s alternate phone number 

(optional).
Ext Enter the insurance company’s alternate phone extension 

(optional).
Premium Amt Enter the insurance premium amount (optional).
Term Enter the insurance term (required).
Commission Rule View the insurance premium amount (display only).
Commission Amt View the insurance commission amount (display only).
Primary Enter the primary beneficiary of the insurance (optional).
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Secondary Enter the secondary beneficiary of the insurance 
(optional).

Comment Enter a comment (optional).

5 In the Cancellation/Refund block, view the following information:

In this field: Do this:

Allowed If selected, a refund is allowed. A selected box indicates 
that the insurance premium can be rebated to the cus-
tomer in case of early payoff.

Grace Days   View the number of grace days allowed for cancellation 
without charging a cancellation fee.

Calculation Method View the insurance premium refund/rebate calculation 
method to be used when insurance is cancelled.

Grace Day's Cancellation If selected, indicates that cancellation fees during grace
Fee Allowed period is allowed.
Cancellation Fee View the amount of the cancellation fee to be charged 

when the insurance is cancelled.

6 Save any changes you made to the application.

ESC sub page
If there is information regarding an itemized extended service contract or warranty 
amount, enter the details on the ESC sub page.

To complete the ESC (extended service contracts) sub page 

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account you want to work with.

3 Choose the Contract (4) master tab, then choose the ESC sub tab.
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4 On the ESC sub page, view or complete the following information in the Warranty Infor-
mation block:

In this field: Do this:

Service Contract View the extended service contract type (display only).
Warranty Company Enter the ESC company’s name (optional).
Policy Number Enter the ESC number (required).
Phone No Enter the ESC company’s primary phone number 

(optional).
Ext Enter the ESC company’s primary phone extension 

(optional).
Effective Dt Enter the ESC effective date (required).
Expiration Dt Enter the ESC expiry date (optional).
Phone No Enter the ESC company’s alternate phone number 

(optional).
Ext Enter the ESC company’s alternate phone extension 

(optional).
Premium Amt View the ESC premium amount (display only) (optional).
Term Enter the ESC term (required).
Comment Enter a comment (optional).

5 Save any changes you made to the application.

Escrow sub page
If there is escrow information selected on the Itemization sub page, enter information 
about it on the Escrow sub page. The Escrow sub page records escrow details regarding 
disbursement, insurance, and property tax -- information that is parsed to the Customer 
Service form on the Customer Service (2) master tab, where it is available for mainte-
nance.

Note: This sub tab is available if escrow is allowed for the instrument selected on the Loan 
page.

The Escrow Analysis page allows you to view and perform the initial escrow analysis. 
You can perform multiple analyses; however, Oracle Daybreak records only the most 
recent analysis.

To complete the Escrow sub page 

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account you want to work with.

3 Choose the Contract (4) master tab, then choose the Escrow sub tab.
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4 The Escrow Information block displays information regarding the escrow recorded on 
the Itemization sub page. In the Escrow Information block, view the following informa-
tion:

In this field: View:

Escrow The escrow itemization code and description (display 
only).

Escrow Type The escrow type (display only).
Escrow Sub Type The escrow sub type (display only).
Advance Amt The advance amount (display only).
Required Escrow If selected, indicates that escrow itemization is required 

(display only).
Cushion Allowed If selected, indicates that cushion is allowed (display 

only).
5 Select the Opt Out box only if you want to ignore this particular escrow. 

6 In the Disbursement block, enter the following information:

In this field: Do this:

Rule Select disbursement rule (required).
Yearly Amt Enter yearly disbursement amount (required).
Account # Enter reference account number for vendor. Note: If the 

organizational parameter 
UIX_HIDE_RESTRICTED_DATA is set to Y, this appears 
as a masked number; for example, XXXXX1234 
(optional).

Vendor Enter the vendor name (required).
Maturity Dt Enter the maturity date, if one exists (optional).

7 If this escrow involves an insurance, use the Insurance block to enter the following infor-
mation:

In this field: Do this:

Coverage Type Enter the coverage type (optional).
Coverage Term Enter the coverage term (required).
Coverage Amt Enter the coverage amount (required).
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Policy Nbr Enter the policy number (required).
Effective Dt Enter the effective date (required).
Expiration Dt Enter the expiration date (optional).
Comment Enter a comment (optional).

8 If this escrow involves a tax, use the Tax block to enter the following information:

In this field: Do this:

Property Tax Type Enter property tax code (optional).

9 Save your entry.

Compensation (loan) sub page
The Compensation (loan) sub page records and displays the terms of compensation 
between the finance company and the dealer for loan transactions. 

To complete the Compensation (loan) sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account you want to work with.

3 Choose the Contract (4) master tab, then choose the Compensation (loan) sub tab.

4 Choose Load.

The Compensation Plan LOV dialog box appears.

5 Use the LOV to select the compensation plan you want to load and choose OK.

Oracle Daybreak loads the following information on the Compensation sub page:

In this field: Do this:

Compensation Plan View the compensation plan (display only).
Disbursement Method View the compensation payment method (display only).
Calculation Method View the compensation calculation method (display 

only).

Chargeback block
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Paid Calc Method View the charge back calculation method (early payoff) 
(display only).

Paid % View the charge back percentage (early payoff) (display 
only).

Paid Basis View the charge back basis (early payoff) (display only).
Paid Term View the charge back term (early payoff) (display only).
Paid Days View the charge back days (early payoff) (display only).
Charge off Calc Method View the charge back calculation method (charge off) 

(display only).
Charge off % View the charge back percentage (charge off) (display 

only).
Charge off Basis View the charge back basis (charge off) (display only).
Charge off Term View the charge back term (charge off) (display only).
Charge off Days View the charge back days (charge off) (display only).

Calculation block
Spread Formula View the compensation spread formula (display only).
Buy Rate Enter the buy rate (required).
Factor View the compensation factor (display only).
Addl Factor View the additional compensation factor (display only).
Max Spread Percent View the maximum spread or percent allowed (display 

only).
Upfront % View the upfront compensation percentage (display 

only).
OR Flat Amt View the flat amount (display only).
Upfront Compensation Amt View the compensation amount paid upfront (display 

only).
Remaining Compensation Amt View the compensation amount remaining (display only).
Compensation Amt View the compensation amount (display only).

6 Make any necessary changes in the Buy Rate field.

7 Choose Calculate.

Oracle Daybreaks displays the details and amounts for this compensation plan.

8 Save the changes on the application.
Chapter 13 :-30   User Guide - Consumer Loans Servicing 



Subvention sub page

With the Subvention sub page, you can enter subvention information regarding an 
application.

To complete the Subvention sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account you want to work with.

3 Choose the Contract (4) master tab, then choose the Subvention sub tab.

4 On the Subvention sub page, view or complete the following fields:

In this field: Do this:

Subvention block:
Plan Enter the subvention plan code (required).
Description View the subvention plan description (display only).
Sub PlanDescription Enter the subvention plan (required).
Subvention Type View the subvention type (display only).
Subvention Amount View the subvention amount for the plan (display only).
Include Select to include the subvention entry (display only).

Participants block:
Participant Enter the participant (required).
Participant Type View the participant type (display only).
Subvention Amt Enter the subvention amount (required).
Rate Enter the subvention rate (required).
Rent factor View the subvention rent factor (display only).
Collection Method Enter the collection method (required).

Refund block:
Method (Paid off) Enter the method if the account is paid-off early 

(required).
Basis (Paid off) Enter the basis if the account is paid-off early (required).
Period (Paid off) Enter the refund period in which the subvention will be 

refunded to the producer (required).
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Percent (Paid off)                Enter the refund percentage if the account is charged-off 
(required).

Method (Chg off) Enter the method if the account is charged-off (required).
Basis (Chg off) Enter the basis if the account is charged-off (required).
Period (Chg off) Enter the refund period in which the subvention will be 

refunded to the producer (required).
Percent (Chg off) Enter the refund percentage if the account is charged-off 

(required).
Amortization block:
Balance Type Enter the amortize balance type (required).
Method Enter the amortization calculation method (required).
Frequency Enter the amortization frequency (required).
Cost/Fee Enter the amortization fee method (required).
Include Select to include the amortization entry.

Total Subvention Rate View the total subvention rate shared by all participants 
(display only).

Total Subvention Amount View the total subvention amount for current account 
(display only).

5 Save any changes you made to the application.

Proceeds sub page
The Proceeds sub page displays the payment amount due to the dealer, based on the Com-
pensation and Itemization sub pages. It is a view only sub page, though you can record 
comments.

To use the Proceeds sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account you want to work with.

3 Choose the Contract (4) master tab, then choose the Proceeds sub tab.
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4 On the Proceeds sub page, view or enter the following information:

In this field: Do this:

Proceed View the proceed itemization (display only).
+/- View whether the itemization is added to or subtracted 

from the total proceeds (display only).
Amount Enter the amount (display only).
Comment Enter a comment (optional).

5 Save any changes you made to the application.

Disbursement sub page
The Disbursement sub page records how the loan payment is disbursed and records pay-
ments to third parties, such as the Department of Motor Vehicles. This sub page needs to 
be completed if there is an itemized disbursement.

To complete the Disbursement sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account you want to work with.

3 Choose the Contract (4) master tab, then choose the Disbursement sub tab.

4 On the Disbursement sub page, view or complete the following fields:

In this field: Do this:

Disbursement block
Description View the disbursement description (display only).
Validate Payee View the validate payee indicator. If selected, indicates 

that the payee needs to be validated.
Number Enter the disbursement party’s number (optional).
Name Enter the company name (required).
Amount View the payment amount (display only).
Address Enter the address line 1 (required).
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Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Enter the zip code (required).
City Enter the city (required).
St Select the state (required).
Extension (unlabeled) Enter the zip extension (optional).
Country Select the country (required).
Phone Enter the primary phone number (optional).
Extn Enter the primary phone extension (optional).
Phone Enter the alternate phone number (optional).
Extn Enter the alternate phone extension (optional).
Comment Enter a comment (optional).
Payment Mode Select the payment mode (required).
Account # Enter the account number (optional).
ACH Bank Enter the bank number (optional).
ACH Routing # Enter the routing number (optional).
ACH Account Type Enter the account type (optional).
ACH Account # Enter the account number. Note: If the organizational 

parameter UIX_HIDE_RESTRICTED_DATA is set to Y, 
this appears as a masked number; for example, 
XXXXX1234 (optional).

5 Save any changes you made to the application.

Fee sub page
The Fee sub page is a view-only table displaying what fees on the loan instrument are in 
use, based on the contract.

To view the Fee sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account you want to work with.

3 Choose the Contract (4) master tab, then choose the Fee sub tab.
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4 In the Fee sub page, view the following information:

In this field: Do this:

Fee View the fee type (display only).
Fee Calc Method View the fee calculation method (display only).
Txn Amt From View the minimum transaction amount (display only).
Percent View the maximum percentage (display only).
Min Amt View the minimum fee amount (display only).
Max Amt View the maximum fee amount (display only).
Enabled If selected, the fee rule is enabled (optional).

ACH sub page
The ACH sub page records details about automatic clearinghouse, if this is a direct deposit 
payment account; otherwise, it remains empty. This information is used to receive pay-
ments, primarily when working with the Consumer Lending (Advance and Payment) 
form.

To complete the ACH sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account you want to work with.

3 Choose the Contract (4) master tab, then choose the ACH sub tab.

4 On the ACH sub page, enter the following information:

In this field: Do this:

Bank Information block
ACH If selected, the ACH is enabled.
Bank Enter the bank name (required).
Start Dt Enter the ACH start date (required).
Routing # Enter the routing number (required).
Account Type Select the account type (required).
Chapter 13 :-35   User Guide - Consumer Loans Servicing 



Account # Enter the account number. Note: If the organizational 
parameter UIX_HIDE_RESTRICTED_DATA is set to Y, 
this appears as a masked number; for example, 
XXXXX1234 (required).

ACH Debit Amt Enter the payment amount (required).
Debit Freq Select the payment frequency (required).
Debit Day Enter the payment day (required).

5 Save any changes you made to the application.

Coupon sub page 
The Coupon sub page allows you to order (or re-order) new coupon books. Note: This sub 
page is only available if the bill type for this application is a coupon payment, not a state-
ment.

To complete the Coupon sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Load the application/account you want to work with.

3 Choose the Contract (4) master tab, then choose the Coupon sub tab.

4 On the Coupon Book Information sub page, enter or view the following information:

In this field: Do this:

Order Select to order coupon book (optional).
Order Dt Enter the coupon book order date (required).
Ordered By Select the user id of the user who ordered the coupon 

book (optional).
# of Coupons Enter the number of coupons (required).
First Pmt Dt Enter the first payment date (required).
Coupon Starting # Enter the starting number of the coupon book (required).
First Coupon Dt View the first coupon date (display only).
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Coupon Ending # View the ending number of the coupon book (display 
only).

Last Coupon Dt View the last coupon date (display only).

5 Save any changes you made to the application.
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Collateral (5) master tab
The Collateral (5) master tab allows you to record information regarding collateral associ-
ated with the account. 

To complete the Collateral page

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account to which you want to add collateral information.

3 Choose the Collateral (5) master tab.

• If the account’s collateral is a vehicle, the Vehicle page appears: 

• If the account’s collateral is a home, the Home page appears: 
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• If the account’s collateral is neither a vehicle nor a home, the Other page appears: 

• If you are using the Vehicle page, complete the Vehicle block:

In this field: Do this:

Asset Class Select the asset class (required).
Asset Type Select the asset type (required).
Sub Type Select the asset sub-type (required).
Identification Number Enter the identification number (optional).
Registration # Enter the registration number (required).
Status Select the asset status (required).
Year Enter the year of the vehicle (required).
Make Select the make of the vehicle (optional).
Model Select the model of the vehicle (optional).
Body Enter the body of the vehicle (optional).
Desc View the vehicle description (display only).
Condition Select the vehicle condition (optional).
Address (#) Enter the building number (optional).
Address 1 (unlabeled) Enter the address line 1 (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (optional).
City Enter the city (optional).
St Select the state (optional).
Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country code (required).
County Select the county (optional).
Oracle Daybreak validates the VIN if you add or modify the Identification Number field 
on the Customer Service form’s Vehicle page. 
Chapter 13 :-39   User Guide - Consumer Loans Servicing 



Interface with VINTEK (If interface is installed)
Using the Vintek interface, Oracle Daybreak retrieves the year, make, model, and body of 
the vehicle on the Vehicle page of the Underwriting, Funding, Customer Service, and Con-
version App/Acc forms’ Collateral master tab when you choose Vehicle Details. This time 
saving feature reduces data entry errors. Using the VIN entered in the Identification Num-
ber field, Oracle Daybreak populates the following fields in the Vehicle block:

• Year
• Make
• Model
• Body 

If the Vintek interface is unable to retrieve information based on the VIN entered in the 
Identification Number field, Oracle Daybreak displays an error message.

• If you are using the Home page, complete the Home block:

In this field: Do this:

Asset Class Select the asset class (required).
Asset Type Select the asset type (required).
Sub Type Select the asset sub type (required).
Occupancy Select owner occupancy type (optional).
Id # Enter the home identification number (optional).
Census Tract/BNA Code Enter census tract/BNA (block numbering area) code 

(optional).
MSA Code Enter the metropolitan statistical area (MSA) code 

(optional).
Geo Enter the geographical code for the property (optional).
Year Enter the year when the property was built (required).
Make Enter the make of the home (optional).
Model Enter the model of the home (optional).
W Enter the asset width (optional).
L Enter the asset length (optional).
Description Enter a description of the home (optional).
PO# Enter the asset purchase order number (optional).
Address (#) Enter the building number (required).
Address 1 (unlabeled) Enter the address line 1 (required).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (required).
City Enter the city (required).
St Select the state (required).
Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country (required).
Legal Description Enter the legal description.
Lot Enter the asset lot.
Sub Division Enter the asset sub division.
Parcel ID Enter the parcel id of the home.
Metes-Bounds Select to indicate the home is considered Metes-Bounds.
Flood Zone Select to indicate the home is in a flood zone.

• If you are using the Other page, complete the Other block:

In this field: Do this:
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Asset Class Select the asset class (required).
Asset Type Select the asset type (required).
Sub Type Select the asset sub-type (required).
Identification Number Enter the identification number (optional).
Registration # Enter the registration number (required).
Status Select the asset status (required).
Year Enter the year of the collateral (required).
Make Select the make of the collateral (optional).
Model Select the model of the collateral (optional).
Body Enter the body of the collateral (optional).
Desc View the collateral description (display only).
Condition Select the collateral condition (required).
Address (#) Enter the building number (optional).
Address 1 (unlabeled) Enter the address line 1 (optional).
Address 2 (unlabeled) Enter the address line 2 (optional).
Zip Select the zip code (optional).
City Enter the city (optional).
St Select the state (optional).
Zip Extension (unlabeled) Enter the zip extension (optional).
Country Select the country code (required).
County Select the county (optional).

4 Save your entry.
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Valuation sub page
With the Valuation sub page, you can change the collateral or asset valuation for an 
account. In this process, you reassess the current value of the collateral (which has been 
used to secure the loan). This helps companies determine if the risk of delinquency or 
charge off is worth the asset securing it.

To add the collateral or asset valuation for an account

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account to which you want to add asset valuation information.

3 Choose the Collateral (5) master tab.

4 On the available page (Vehicle, Home, or Other), choose the Valuation sub tab.

5 If the Valuation sub page already contains information, press F6 to clear it.

6 On the Valuation page, enter the following information in the Value block:

In this field: Do this:

Current Select if this is the current valuation (required).
Valuation Dt Enter the valuation date (required).
Source Select the valuation source (required).
Supplement Enter the valuation supplement (optional).
Edition Enter the valuation edition (optional).
Base (Wholesale) Enter the wholesale value (required).
Usage Enter the usage. This pertains to loans and usually is 

entered as the current mileage on the vehicle (required).).
Base (Retail) Enter the retail value (required).
Addons + View the add-ons value (display only).
Usage Value + Enter the usage value; that is, the monetary effect that the 

current mileage has on the value of the vehicle (required).
Total Value = View the total value (display only).

7 Save your entry. 

Note: Assets can have exactly one current valuation. NADA and Kelly Blue Book Inter-
faces are available only in the Client/Server environment.
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Tracking sub page
With the Tracking sub page, you can add the collateral or asset tracking details for an 
account. This allows you to track additional data related to an asset: such as the title.

To add the collateral or asset tracking for an account

1 On the Interfaces menu, choose Conversion > Account.

2 Load the /account to which you want to add asset-tracking information.

3 Choose the Collateral (5) master tab.

4 On the available page (Vehicle, Home, or Other), choose the Tracking sub tab.

5 Choose Load Details.

6 Enter or select the tracking details in the Tracking Items block.

In this field: Do this:

Tracking Items block
Tracking Item View the tracking type (display only).
Disposition Select the disposition (required).
Start Dt Enter the tracking start date (required).
End Dt Enter the tracking end date (optional).
Followup Dt Enter the next follow-up date (required).
Enabled Select to track the information from the start date in the 

Start Dt field. (required).
Comment Enter a comment (optional).

Tracking Items Details block
Parameter View parameter (display only).
Value Enter the tracking parameter value (optional).

7 Save your entry.

CAUTION
It is very important to recognize that the tracking details can be loaded only once, at the 
beginning of the project. Every time tracking details are reloaded, the existing data is 
replaced. Therefore, it is i-flex solutions recommends that the client team give careful con-
sideration when defining the details. 
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Account (6) master tab
The Conversion App/Acc form Account (6) master tab allows you to view and add com-
ments regarding an account at any time. 

To complete the Account Details page

1 On the Interfaces menu, choose Conversion > Account and load the account to which 
you want to add account information.

2 Choose the Account (6) master tab.

3 Enter the following information in the Account block:

In this field: Do this:

Account# View the value entered in “Xref” field (display only).
Status Select the account status (required).
Effective Dt Enter the effective date of the account (required).
Paid Off Dt Enter the paid off date of the PAID account (optional).
Pool Enter the pool the account is in (optional).
30 Enter the number of times 30 days delinquent over the 

life of the account (required).
60 Enter the number of times 60 days delinquent over the 

life of the account (required).
90 Enter the number of times 90 days delinquent over the 

life of the account (required).
120 Enter the number of times 120 days delinquent over the 

life of the account (required).
Next Due Dt Enter the Next Due date (required).
Last Pmt Amt Enter the last payment amount (required).
Due Day Enter the due day of the account (required).
Last Activity Dt Enter the date of last activity on the account (optional).
Maturity Dt Enter the maturity date of the account (required).
Last Pmt Dt Enter the date the last payment was received (optional).
Excess Amt Pd Enter the amount paid that needs to be applied towards 

future due dates (optional).
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4 Enter the following information in the Extensions block:

In this field: Do this:

# of Extensions (Year) Enter the number of times extensions granted (year) 
(optional).

# of Extensions (Life) Enter the number of times extensions granted (life) 
(optional).

# of Extension Term (Year) Enter the number of terms extensions granted (year) 
(optional).

# of Extension Term (Life) Enter the number of terms extensions granted (life) 
(optional).

Last Extn Dt View the last extension date (optional).

5 Enter the following information in the Due Dates block:

In this field: Do this:

Due Dt 1 Enter the latest due date for which the account is due 
(optional).

Amt Due 1 Enter the amount due on the latest due date of the account 
(optional).

Amt Paid 1 Enter the amount paid on the latest due date of the 
account (optional).

Due Dt 2 Enter the (latest - 1) due date of the account (optional).
Amt Due 2 Enter the amount due on the (latest -1) due date of the 

account (optional).
Amt Paid 2 Enter the amount paid on the (latest - 1) due date of the 

account (optional).
Due Dt 3 Enter the (latest - 2) due date of the account (optional).
Amt Due 3 Enter the amount due on the (latest -2) due date of the 

account (optional).
Amt Paid 3 Enter the amount paid on the (latest - 2) due date of the 

account (optional).
Due Dt 4 Enter the (latest - 3) due date of the account (optional).
Amt Due 4 Enter the amount due on the (latest -3) due date of the 

account (optional).
Amt Paid 4 Enter the amount paid on the (latest - 3) due date of the 

account (optional).
Due Dt 5 Enter the (latest - 4 cycle) due date of the account 

(optional).
Amt Due 5 Enter the total due amount less the sum of the last 4 due 

amounts on the account (optional).
Amt Paid 5 Enter the amount paid on the account till date less the 

value in paid buckets 1 through 4 (optional).

6 Enter the following information in the Conditions block:

In this field: Do this:

Condition View the condition (required).
Start Dt View the start date (required).
Followup Dt View the next follow-up date (optional).

7 Save your entry.
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Escrow tab
The Escrow page allows you to record escrow details such as the escrow amount due, cur-
rent escrow payment, escrow balances, and whether escrow analysis is required. The 
Escrow page contains the Escrow Details sub page.

To complete the Escrow page

1 On the Interfaces menu, choose Conversion > Account and load the account to which 
you want to add account information.

2 Choose the Account (6) master tab, then choose the Escrow tab.

3 Enter the following information in the Account block:

In this field: Do this:

Escrow Amt Due Enter the escrow amount due on the account belonging to 
the escrow balance type (this is the sum of Amt due 1 to 
Amt due 5) (required).

Excess Amount Enter the excess amount (required).
Due Dt (1) Enter the due date (required).
Amt (1) Enter the amount due (required).
Due Dt (2) Enter the due date (required).
Amt (2) Enter the amount due (required).
Due Dt (3) Enter the due date (required).
Amt (3) Enter the amount due (required).
Due Dt (4) Enter the due date (required).
Amt (4) Enter the amount due (required).
Due Dt (5) Enter the due date (required).
Amt (5) Enter the amount due (required).

4 Enter the following information in the Escrow block:

In this field: Do this:

Escrow Allowed Select to indicate that escrow is allowed for this account.
Opt Out Select to indicate that the customer has optioned out of 

escrow.
Analysis Run Date Enter the run date analysis (required).
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5 Enter the following information in the Escrow Payment block:

In this field: Do this:

Escrow Amt Pmt Enter the escrow amount payment (required).
Current Escrow Pmt The current escrow payment amount. This is the standard 

escrow installment due every term (required).
6 Enter the following information in the Escrow Balance block:

In this field: Do this:

Opening Balance Enter the amount (required).
Balance Enter the balance amount (required).
Balance Pd Enter the amount (required).
Adjusted (+) Enter the amount (positive).
Adjusted (-) Enter the amount (negative).

7 Save your entry.

8 Choose the Escrow Details sub page.

9 In the Details block, view the following information:

In this field: Do this:

Escrow Type View the escrow type (display only).
Sub Type View the escrow sub type (display only).
Required Escrow If selected, indicates that escrow is required.
Cushion Allowed If selected, indicates that cushion is allowed.
Opt Out If selected, indicates the customer has opted out 

of escrow
Current If selected, indicates that the escrow on display is 

current.
10 In the Disbursement block, enter the following information:

In this field: Do this:

Rule View the escrow disbursement rule type (display 
only).

Vendor View the vendor name (display only).
Account # Enter the account number (required).
Maturity Dt Enter the escrow maturity date (required).
Yearly Amt Enter the yearly escrow amount (required).
Next Disb Dt Enter next disbursement date (required).
Last Disb Dt Enter the last disbursement date (required).

11 In the Insurance block, enter the following information:

In this field: Do this:

Coverage Type Select coverage type (display only).
Policy # Enter the policy number (required).
Coverage Amt Enter the coverage amount (required).
Coverage Term Enter the coverage term (required).
Effective Dt Enter the effective date (required).
Expiration Dt Enter the expiration date (display only).

12 In the Tax block, enter the property tax in the Property Tax field.

13 Save your entry.
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Account (6) master tab sub pages
The Account (6) master tab contains the Account Details page and the following sub 
pages:

• Balances
• YTD Balances
• Other Balances
• Other YTD Bal... (Balances)
• Amortize Balan... (Balances)
• Transactions
• ACH 
• Bankruptcy
• Chargeoff
• Compensation
• Loan Details
• LoC Details
• Tracking Attribu... (Attributes)

This section explains how to complete each one.

To complete the Balances sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Choose the Account (6) master tab, and then choose the Account Details tab.

3 Choose the Balances sub tab.

4 On the Balances sub page, enter the following information:

In this field: Do this:

Balances
Balance (Adv Bal) Enter the original advance balance on this account 

(required).
Paid (Adv Bal) Enter the advance balance that has been paid on this 

account (required).
Waive (Adv Bal) Enter the advance that has been waived off on this 

account (required).
Chapter 13 :-48   User Guide - Consumer Loans Servicing 



Charge Off (Adv Bal) Enter the advance that has been charged off (required).
Recovered (Adv Bal) Enter the advance that has been recovered for this 

account (required).
Adjusted (+) (Adv Bal) Enter any positive adjustments that were made to the 

advance (required).
Adjusted (-) (Adv Bal) Enter any negative adjustments that were made to the 

advance (required).
ADB Bal Enter the advance average daily balance (required).
Balance (Interest) Enter the original interest balance on this account 

(required).
Paid (Interest) Enter the interest balance that has been paid on this 

account (required).
Waive (Interest) Enter the interest that has been waived off on this account 

(required).
Charge Off (Interest) Enter the interest that has been charged off (required).
Recovered (Interest) Enter the interest that has been recovered for this account 

(required).
Adjusted (+) (Interest) Enter any positive adjustments that were made to the 

interest (required).
Adjusted (-) (Interest) Enter any negative adjustments that were made to the 

interest (required).
Balance (Late Charge) Enter the original late charge balance on this account 

(required).
Paid (Late Charge) Enter the late charge balance that has been paid on this 

account (required).
Waive (Late Charge) Enter the late charge that has been waived off on this 

account (required).
Charge Off (Late Charge) Enter the late charge that has been charged off (required).
Recovered (Late Charge) Enter the late charge that has been recovered for this 

account (required).
Adjusted (+) (Late Charge) Enter any positive adjustments that were made to the late 

charge (required).
Adjusted (-) (Late Charge) Enter any negative adjustments that were made to the late 

charge (required).
Balance (NSF) Enter the original NSF balance on this account 

(required).
Paid (NSF) Enter the NSF balance that has been paid on this account 

(required).
Waive (NSF) Enter the NSF that has been waived off on this account 

(required).
Charge Off (NSF) Enter the NSF that has been charged off (required).
Recovered (NSF) Enter the NSF that has been recovered for this account 

(required).
Adjusted (+) (NSF) Enter any positive adjustments that were made to the 

NSF (required).
Adjusted (-) (NSF) Enter any negative adjustments that were made to the 

NSF (required).
Balance (Overage) Enter the original over limit fee balance on this account 

(required).
Paid (Overage) Enter the over limit fee balance that has been paid on this 

account (required).
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Waive (Overage) Enter the over limit fee that has been waived off on this 
account (required).

Charge Off (Overage) Enter the over limit fee that has been charged off 
(required).

Recovered (Overage) Enter the over limit fee that has been recovered for this 
account (required).

Adjusted (+) (Overage) Enter any positive adjustments that were made to the 
over limit fee (required).

Adjusted (-) (Overage) Enter any negative adjustments that were made to the 
over limit fee (required).

Balance (Pre-Payment) Enter the original prepayment penalty balance on this 
account (required).

Paid (Pre-Payment) Enter the prepayment penalty balance that has been paid 
on this account (required).

Waive (Pre-Payment) Enter the prepayment penalty that has been waived off on 
this account (required).

Charge Off (Pre-Payment) Enter the prepayment penalty that has been charged off 
(required).

Recovered (Pre-Payment) Enter the prepayment penalty that has been recovered for 
this account (required).

Adjusted (+) (Pre-Payment) Enter any positive adjustments that were made to the pre-
payment penalty (required).

Adjusted (-) (Pre-Payment) Enter any negative adjustments that were made to the 
prepayment penalty (required).

Balance (Fee Adv) Enter the original advance transaction fee balance on this 
account (required).

Paid (Fee Adv) Enter the advance transaction fee balance that has been 
paid on this account (required).

Waive (Fee Adv) Enter the advance transaction fee that has been waived 
off on this account (required).

Charge Off (Fee Adv) Enter the advance transaction fee that has been charged 
off (required).

Recovered (Fee Adv) Enter the advance transaction fee that has been recovered 
for this account (required).

Adjusted (+) (Fee Adv) Enter any positive adjustments that were made to the 
advance transaction fee (required).

Adjusted (-) (Fee Adv) Enter any negative adjustments that were made to the 
advance transaction fee (required).

Balance (Membership) Enter the original membership fee balance on this 
account (required).

Paid (Membership) Enter the membership fee balance that has been paid on 
this account (required).

Waive (Membership) Enter the membership fee that has been waived off on 
this account (required).

Charge Off (Membership) Enter the membership fee that has been charged off 
(required).

Recovered (Membership) Enter the membership fee that has been recovered for this 
account (required).

Adjusted (+) (Membership) Enter any positive adjustments that were made to the 
membership fee (required).

Adjusted (-) (Membership) Enter any negative adjustments that were made to the 
membership fee (required).
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Balance (Ext) Enter the original extension fee balance on this account 
(required).

Paid (Ext) Enter the extension fee balance that has been paid on this 
account (required).

Waive (Ext) Enter the extension fee that has been waived off on this 
account (required).

Charge Off (Ext) Enter the extension fee that has been charged off 
(required).

Recovered (Ext) Enter the extension fee that has been recovered for this 
account (required).

Adjusted (+) (Ext) Enter any positive adjustments that were made to the 
extension fee (required).

Adjusted (-) (Ext) Enter any negative adjustments that were made to the 
extension fee (required).

5 Save your entry.

To complete the YTD Balances sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Choose the Account (6) master tab, and then choose the Account Details tab.

3 Choose the YTD Balances sub tab.

4 On the YTD Balances sub page, enter the following information:

In this field: Do this:

YTD Balance (Adv Bal) Enter the YTD original YTD advance balance on 
this account (required).

YTD Paid (Adv Bal) Enter the YTD advance balance that has been 
paid on this account (required).

YTD Waive (Adv Bal) Enter the YTD advance that has been waived off 
on this account (required).

YTD Charge Off (Adv Bal) Enter the YTD advance that has been charged off 
(required).

YTD Recovered (Adv Bal) Enter the YTD advance that has been recovered 
for this account (required).
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YTD Adjusted (+) (Adv Bal) Enter any YTD positive adjustments that were 
made to the advance (required).

YTD Adjusted (-) (Adv Bal) Enter any YTD negative adjustments that were 
made to the advance (required).

YTD Balance (Interest) Enter the YTD original interest balance on this 
account (required).

YTD Paid (Interest) Enter the YTD interest balance that has been 
paid on this account (required).

YTD Waive (Interest) Enter the YTD interest that has been waived off 
on this account (required).

YTD Charge Off (Interest) Enter the YTD interest that has been charged off 
(required).

YTD Recovered (Interest) Enter the YTD interest that has been recovered 
for this account (required).

YTD Adjusted (+) (Interest) Enter any YTD positive adjustments that were 
made to the interest (required).

YTD Adjusted (-) (Interest) Enter any YTD negative adjustments that were 
made to the interest (required).

YTD Balance (Late Charge) Enter the YTD original late charge balance on 
this account (required).

YTD Paid (Late Charge) Enter the YTD late charge balance that has been 
paid on this account (required).

YTD Waive (Late Charge) Enter the YTD late charge that has been waived 
off on this account (required).

YTD Charge Off (Late Charge) Enter the YTD late charge that has been charged 
off (required).

YTD Recovered (Late Charge) Enter the YTD late charge that has been recov-
ered for this account (required).

YTD Adjusted (+) (Late Charge) Enter any YTD positive adjustments that were 
made to the late charge (required).

YTD Adjusted (-) (Late Charge) Enter any YTD negative adjustments that were 
made to the late charge (required).

YTD Balance (NSF) Enter the YTD original NSF balance on this 
account (required).

YTD Paid (NSF) Enter the YTD NSF balance that has been paid 
on this account (required).

YTD Waive (NSF) Enter the YTD NSF that has been waived off on 
this account (required).

YTD Charge Off (NSF) Enter the YTD NSF that has been charged off 
(required).

YTD Recovered (NSF) Enter the YTD NSF that has been recovered for 
this account (required).

YTD Adjusted (+) (NSF) Enter any YTD positive adjustments that were 
made to the NSF (required).

YTD Adjusted (-) (NSF) Enter any YTD negative adjustments that were 
made to the NSF (required).

YTD Balance (Overage) Enter the YTD original over limit fee balance on 
this account (required).

YTD Paid (Overage) Enter the YTD over limit fee balance that has 
been paid on this account (required).

YTD Waive (Overage) Enter the YTD over limit fee that has been 
waived off on this account (required).
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YTD Charge Off (Overage) Enter the YTD over limit fee that has been 
charged off (required).

YTD Recovered (Overage) Enter the YTD over limit fee that has been recov-
ered for this account (required).

YTD Adjusted (+) (Overage) Enter any YTD positive adjustments that were 
made to the over limit fee (required).

YTD Adjusted (-) (Overage) Enter any YTD negative adjustments that were 
made to the over limit fee (required).

YTD Balance (Pre-Payment) Enter the YTD original prepayment penalty bal-
ance on this account (required).

YTD Paid (Pre-Payment) Enter the YTD prepayment penalty balance that 
has been paid on this account (required).

YTD Waive (Pre-Payment) Enter the YTD prepayment penalty that has been 
waived off on this account (required).

YTD Charge Off (Pre-Payment) Enter the YTD prepayment penalty that has been 
charged off (required).

YTD Recovered (Pre-Payment) Enter the YTD prepayment penalty that has been 
recovered for this account (required).

YTD Adjusted (+) (Pre-Payment) Enter any YTD positive adjustments that were 
made to the prepayment penalty (required).

YTD Adjusted (-) (Pre-Payment) Enter any YTD negative adjustments that were 
made to the prepayment penalty (required).

YTD Balance (Fee Adv) Enter the YTD original advance transaction fee 
balance on this account (required).

YTD Paid (Fee Adv) Enter the YTD advance transaction fee balance 
that has been paid on this account (required).

YTD Waive (Fee Adv) Enter the YTD advance transaction fee that has 
been waived off on this account (required).

YTD Charge Off (Fee Adv) Enter the YTD advance transaction fee that has 
been charged off (required).

YTD Recovered (Fee Adv) Enter the YTD advance transaction fee that has 
been recovered for this account (required).

YTD Adjusted (+) (Fee Adv) Enter any YTD positive adjustments that were 
made to the advance transaction fee (required).

YTD Adjusted (-) (Fee Adv) Enter any YTD negative adjustments that were 
made to the advance transaction fee (required).

YTD Balance (Membership) Enter the YTD original membership fee balance 
on this account (required).

YTD Paid (Membership) Enter the YTD membership fee balance that has 
been paid on this account (required).

YTD Waive (Membership) Enter the YTD membership fee that has been 
waived off on this account (required).

YTD Charge Off (Membership) Enter the YTD membership fee that has been 
charged off (required).

YTD Recovered (Membership) Enter the YTD membership fee that has been 
recovered for this account (required).

YTD Adjusted (+) (Membership) Enter any YTD positive adjustments that were 
made to the membership fee (required).

YTD Adjusted (-) (Membership) Enter any YTD negative adjustments that were 
made to the membership fee (required).

YTD Balance (Ext) Enter the YTD original extension fee balance on 
this account (required).
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YTD Paid (Ext) Enter the YTD extension fee balance that has 
been paid on this account (required).

YTD Waive (Ext) Enter the YTD extension fee that has been 
waived off on this account (required).

YTD Charge Off (Ext) Enter the YTD extension fee that has been 
charged off (required).

YTD Recovered (Ext) Enter the YTD extension fee that has been recov-
ered for this account (required).

YTD Adjusted (+) (Ext) Enter any positive YTD adjustments that were 
made to the extension fee (required).

YTD Adjusted (-) (Ext) Enter any negative YTD adjustments that were 
made to the extension fee (required).

5 Save your entry.

To complete the Other Balances sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Choose the Account (6) master tab, and then choose the Account Details tab.

3 Choose the Other Balances sub tab.

4 On the Other Balances sub page, enter the following information:

In this field: Do this:

Balances
Txn Code (1) Enter transaction type code (required).
Balance (1) Enter the advance balance (required).
Paid (1) Enter the advance paid (required).
Waive (1) Enter the advance waived (required).
Charge Off (1) Enter the advance charged off (required).
Recovered (1) Enter the advance recovered (required).
Adjusted (+) (1) Enter the advance positive adjustment (required).
Adjusted (-) (1) Enter the advance negative adjustment (required).
Txn Code (2) Enter transaction type code (required).
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Balance (2) Enter the advance balance (required).
Paid (2) Enter the advance paid (required).
Waive (2) Enter the advance waived (required).
Charge Off (2) Enter the advance charged off (required).
Recovered (2) Enter the advance recovered (required).
Adjusted (+) (2) Enter the advance positive adjustment (required).
Adjusted (-) (2) Enter the advance negative adjustment (required).
Txn Code (3) Enter transaction type code (required).
Balance (3) Enter the advance balance (required).
Paid (3) Enter the advance paid (required).
Waive (3) Enter the advance waived (required).
Charge Off (3) Enter the advance charged off (required).
Recovered (3) Enter the advance recovered (required).
Adjusted (+) (3) Enter the advance positive adjustment (required).
Adjusted (-) (3) Enter the advance negative adjustment (required).

Non Performing Balances
Xrf Balance Enter nonperforming balance to be transferred (required).
Xrf Balance Paid Enter nonperforming balance paid (required).
Balance Enter current balance (required).
Paid Enter balance paid (required).
Waive Enter balance waived (required).
Adjusted (+) Enter balance adjusted (+) (required).
Adjusted (-) Enter balance adjusted (-) (required).
Paid Excess Enter excess balance paid (required).
Interest Enter interest (required).
Interest Paid Enter interest paid (required).

5 Save your entry.

To complete the Other YTD Balances sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Choose the Account (6) master tab, and then choose the Account Details tab.

3 Choose the Other YTD Balan... sub tab.
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4 On the Other YTD Balances sub page, enter the following information:

In this field: Do this:

Balances
Txn Code (1) Enter transaction type code (required).
YTD Balance (1) Enter the YTD advance balance (required).
YTD Paid (1) Enter the YTD advance paid (required).
YTD Waive (1) Enter the YTD advance waived (required).
YTD Charge Off (1) Enter the YTD advance charged off (required).
YTD Recovered (1) Enter the YTD advance recovered (required).
YTD Adjusted (+) (1) Enter the YTD advance positive adjustment (required).
YTD Adjusted (-) (1) Enter the YTD advance negative adjustment (required).
YTD Txn Code (2) Enter transaction type code (required).
Balance (2) Enter the YTD advance balance (required).
YTD Paid (2) Enter the YTD advance paid (required).
YTD Waive (2) Enter the YTD advance waived (required).
YTD Charge Off (2) Enter the YTD advance charged off (required).
YTD Recovered (2) Enter the YTD advance recovered (required).
YTD Adjusted (+) (2) Enter the YTD advance positive adjustment (required).
YTD Adjusted (-) (2) Enter the YTD advance negative adjustment (required).
Txn Code (3) Enter transaction type code (required).
YTD Balance (3) Enter the YTD advance balance (required).
YTD Paid (3) Enter the YTD advance paid (required).
YTD Waive (3) Enter the YTD advance waived (required).
YTD Charge Off (3) Enter the YTD advance charged off (required).
YTD Recovered (3) Enter the YTD advance recovered (required).
YTD Adjusted (+) (3) Enter the YTD advance positive adjustment (required).
YTD Adjusted (-) (3) Enter the YTD advance negative adjustment (required).

5 Save your entry.
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To complete the Amortize Balances sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Choose the Account (6) master tab, and then choose the Account Details tab.

3 Choose the Amortize Balances sub tab.

4 In the Amortize Balances sub page, enter the following information: 

In this field: Do this:

Txn Enter the transaction code for the amortization balance. 
Five different balance types can be entered in the rows 
marked 1...5 (optional).

Balance Enter the original balance amount (required).
Earned Enter the amount of the balance earned as of previous 

month-end. This should be what was passed in the 
month-end GL (required).

Writeoff Enter the amount of the balance written off as of the pre-
vious month-end (required).

FASB Rate Enter the amortize balance federal accounting standard 
board rate (required).

FASB Balance Enter the amortize balance federal accounting standard 
board balance (required).

FASB Effective Balance Enter the amortize balance federal accounting standard 
board effective balance (required).

5 Save your entry and choose Update Account.
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To complete the Transactions sub page

Note: If the New Account box on the master block is selected, data entered on the Trans-
action sub pages does not convert to the Oracle Daybreak system.

1 On the Interfaces menu, choose Conversion > Account.

2 Choose the Account (6) master tab, and then choose the Account Details tab.

3 Choose the Transactions sub tab.

4 On the Transactions sub page, enter the following information:

In this field: Do this:

Seq Enter the transaction sequence number (required).
Post Dt Enter the date of posting this transaction (required).
Dt Enter the effective date of this transaction (required).
Txn Enter the transaction code (required).
Balance Amt Enter the principal/advance (Note balance in case of PC) 

balance value after this transaction was executed 
(required).

Txn Amt Enter the amount involved in this transaction (required).
Reference Enter the reference for this transaction (optional).
Mode Select the mode in which the transaction was performed 

(optional).
Reason Select the reason code for this transaction (optional).
Ext Amt Enter the part of the payment that was allocated towards 

the extension fee (required).
Mem Amt Enter the part of the payment that was allocated towards 

the membership fee (required).
Ovr Amt Enter the part of the payment that was allocated towards 

the over limit fee (required).
Fee Adv Enter the part of the payment that was allocated towards 

the advance transaction fee (required).
Pre-Payment Enter the part of the payment that was allocated towards 

the prepayment penalty (required).
Spread Code Enter the spread code used if this is a payment transac-

tion (optional).
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Advance Enter the part of the payment that was allocated towards 
the advance balance (required).

Interest Enter the part of the payment that was allocated towards 
the interest balance (required).

Late Charge Enter the part of the payment that was allocated towards 
the late charge balance (required).

NSF Enter the part of the payment that was allocated towards 
the NSF balance (required).

Overage Enter the amount that has been overpaid. Used in the case 
of the last payment received that pays off all the balances 
(required).

Comment Enter any comments associated with this transaction 
(optional).

5 Save your entry and choose Update Account.

To complete the ACH sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Choose the Account (6) master tab, and then choose the Account Details tab.

3 Choose the ACH sub tab.

4 In the ACH sub page, enter the following information in the Bank Information block:

In this field: Do this:

ACH Select to enable ACH (optional).
Bank Enter the current ACH bank name (optional).
Routing # Enter the current ACH bank routing number (optional).
Next Process Dt Enter the ACH next process date (optional).
Account Type Select the current ACH account type (optional).
Start Dt Enter the ACH start date (optional).
Account # Enter the current ACH account number. Note: If the 

organizational parameter 
UIX_HIDE_RESTRICTED_DATA is set to Y, this appears 
as a masked number; for example, XXXXX1234 
(optional).
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ACH Debit Amt Enter the current ACH payment amount (optional).
Debit Freq Select the current ACH payment frequency (optional).
Debit Day Enter the current ACH payment day (optional).

5 Save your entry.

To complete the Bankruptcy sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Choose the Account (6) master tab, and then choose the Account Details tab.

3 Choose the Bankruptcy sub tab.

4 On the Bankruptcy sub page, enter the following information:

In this field: Do this:

Bankruptcy Select if account has declared a bankruptcy currently 
(optional).

Disposition Select the bankruptcy disposition (optional).
Start Dt Enter the bankruptcy start date (optional).
Type Select the bankruptcy type (optional).
Comment Enter a comment relevant to the bankruptcy of the 

account (optional).

5 Save your entry.

To complete the Chargeoff sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Choose the Account (6) master tab, and then choose the Account Details tab.

3 Choose the Chargeoff sub tab.
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4 In the Chargeoff sub page, enter the following information:

In this field: Do this:

Charged-off Select if account has been declared as a charge off 
(optional).

Disposition Select the charge-off disposition (optional).
Chargeoff Dt Enter the charge-off start date (optional).
Type Select the charge-off type (optional).
Comment Enter a comment relevant to the bankruptcy of the 

account (optional).

5 In the Repo/Forc sub page, enter the following information:

In this field: Do this:

Repo/Forc Select if foreclosure or repossession proceedings are 
underway for this account (optional).

6 Save your entry.

To complete the Compensation sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Choose the Account (6) master tab, and then choose the Account Details tab.

3 Choose the Compensation sub tab.
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4 On the Compensation sub page, enter the following information:

In this field: Do this:

Amt Earned Enter the transaction code for the amortization balance 
Five different balance types can be entered in the rows 
marked 1...5 (optional).

Int Amt Earned Enter the original balance amount (optional).
Amt Paid Enter the amount of the balance earned as of previous 

month-end (optional).
Amt Writeoff Enter the amount of the balance written off as of the pre-

vious month-end (optional).
Next Pmt Dt Enter the amount of the balance written off as of the pre-

vious month-end (optional).
Last Pmt Dt Enter the amount of the balance written off as of the pre-

vious month-end (optional).
Chbk Amt Enter the amount of the balance written off as of the pre-

vious month-end (optional).

5 Save your entry.
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To complete the Loan Details sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Choose the Account (6) master tab, and then choose the Account Details tab.

3 Choose the Loan Details sub tab.

4 In the Additional Loan Details block, enter the following information:

In this field: Do this:

Current Rate Enter the current rate (required).
Current Pmt Enter the current payment amount (required).
Stop Accrual Select if the interest accrual is stopped on this account 

(optional).
Balloon Amt Enter the balloon amount (required).
Current Term Enter the current term (required).
Paid Term Enter the paid term (required).
Last Accrual Dt Enter the last accrual date for this account (optional).

5 In the Non Performing Rebate block, enter the following information:

In this field: Do this:

Non Performing Type Code Enter the non performing type code (required).
Interest Rebate Enter the interest rebate (required).
Promotion End date Enter the promotion end date (optional).
Non Perform Indicator Select to indicate that this is a non performing account 

(required).
6 Save your entry.

To complete the Tracking Attributes sub page

1 On the Interfaces menu, choose Conversion > Account.

2 Choose the Account (6) master tab, and then choose the Account Details tab.

3 Choose the Tracking Attributes sub tab.
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4 Choose Create Tracking.

Oracle Daybreak loads all the Customer Service (2) account attributes tracking parame-
ters.

5 Sub Attribute field, only attributes in a particular group appear in the Parameter display.

6 Complete the Tracking Details block by entering the requested parameter in the Value 
field.

7 Save any changes you made to the account.
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Comment (7) master tab
The Comment (7) master tab allows you to view and add comments regarding an account 
or account at any time.

To add a comment

1 On the Interfaces menu, choose Conversion.

2 Load the /account to which you want to add a comment.

3 Choose the Comment (7) master tab.

4 In the Type block, use the LOV to select the type of comment you are adding.

5 In the Sub Type block, use the LOV to select the sub type of comment you are adding.

6 In the Comments block, type your comment.

7 If you want Oracle Daybreak to recognize this comment as an alert, select Alert. 

Note: If you select the Alert box, the comment appears on the Customer Service form’s 
Account Details page in the Comment sub page.

8 Save your entry.
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Verification (8) master tab
Oracle Daybreak can be configured to automatically validate portions of an application 
when you attempt to change its status. The results of this data check appear on the Verifi-
cation (8) master tab’s Edit page as an ERROR, a WARNING, or an OVERRIDE. 

If it is an Error, Oracle Daybreak will not allow you change the application's status and 
approve the loan until you fix all the errors. 

If it is a Warning, Oracle Daybreak allows you to change an application’s status without 
correcting the matter. While you should still investigate the problem, Warning messages 
are of a lesser importance than Error messages. 

If it is an Override, Oracle Daybreak displays a dialog box informing you that an override 
is needed; your responsibility level does not have the authority required to process this 
step. (Choose Yes on the dialog box to move the application to the queue of the user with 
the required authority.) 

Oracle Daybreak can be configured to verify different sets of information; for example, 
Oracle Daybreak could check one set of data when checking application entries for com-
pleteness and another when approving auto loans. Each one of these “edit types” has its on 
set of “edit details.”

To verify the data required for decisioning the account

1 On the Interfaces menu, choose Conversion > Account.

2 Load the account you want to validate.

3 Choose the Verification (8) master tab, then choose the Edits tab.

4 In the Edit Type block, select the type of edit you want to verify.

Note: If the verification process you want to perform doesn’t appear in the Edit Type 
block, use the Edit Type field’s LOV to select and load it.

5 Choose Check Edits.

Oracle Daybreak checks the data for the verification process selected in the Edit Type 
block and displays the results in the Edit Details block.
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6 In the Edit Details block, view the verification results and begin making corrections on 
the conversion form.

7 When you are finished correcting errors, change the status in the master block Status field 
from API ACCOUNT to ACCOUNT CREATED.

After entering the existing data and successfully changing the status of the account, the 
conversion process is over. 

At this point the account information you entered in this module can be viewed on the 
Lending menu’s Customer Service form.

Note: Accounts, cannot be viewed in Oracle Daybreak at this point. They need to have the 
set-aai run prior to account creation.
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APPENDIX A : ORACLE DAYBREAK INTERFACE

This appendix explains the Oracle Daybreak’s graphical user interface (GUI). It defines 
the components commonly found on a GUI, provides an overview of their functions, and 
explains how to:

• Use Oracle Daybreak’s windows and forms
• Work with the parent-child relationships between blocks
• Navigate within the Oracle Daybreak system.

Oracle Daybreak’s graphical user interface
All the forms in Oracle Daybreak appear as graphical user interfaces (GUIs). To use Ora-
cle Daybreak, you need to understand the components found on a GUI, as well as their 
functions. 

Windows and forms
Oracle Daybreak uses two basic GUIs in completing tasks: windows and forms.

Oracle Daybreak Lending Suite uses two windows, the iAS window and the Oracle Day-
break window. The Oracle Daybreak window is the java applet that is running Oracle 
Daybreak. The iAS window is the browser that launched the applet. In this sense, the iAS 
window is the parent of the Oracle Daybreak window. 
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Windows can be maximized, minimized, opened, closed, and repositioned. More than one 
window can be opened on your desktop; windows can overlap or appear adjacent to each 
other. The window that you are currently using, or is currently selected, is the “active” 
window. It appears on the top of the overlapping windows. Windows that are open but not 
selected are “inactive.” The title bar of an active window is a different color than the other 
inactive windows.

For more information on window components, see the Window components section of 
this chapter.

Oracle Daybreak uses forms to complete tasks. A form is an organized display of a mod-
ule’s fields, contained within a window. Forms allow you to enter, view, and update infor-
mation in the Oracle Daybreak system. Each module has its own form. Forms are opened 
from the Oracle Daybreak menu. For example, on the Lending menu, the Underwriting 
command opens the Underwriting form, the Funding command opens the Funding form, 
and the Customer Service command opens the Customer Service form. You can open mul-
tiple forms simultaneously. The forms that are available to you are based on your assigned 
responsibility.

Windows and forms have a very similar appearance, as forms always appear within win-
dows. An easy way to distinguish a window from a form is that a window contains the 
Minimize, Maximize, and Close buttons in the upper right corner, while a form does not. 

For more information on form components, see the Form components section of this 
chapter.
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Window components
This section presents an overview of the components found on windows, as well as their 
use.

Window title bar A horizontal bar containing the name of the window. The active 
window has a different colored title bar to distinguish it from 
other inactive windows.

The title bar also contains the Minimize, Maximize, and Close 
buttons.

The Minimize button reduces the Oracle Daybreak LS applica-
tion to a taskbar button on your desktop’s status bar.

The Maximize button allows you to resize Oracle Daybreak’s 
window on your desktop. (Note: You may have to choose the 
Maximize button to ensure Oracle Daybreak’s window is not cov-
ered by your desktop’s status bar.)

The Close button will quit Oracle Daybreak without logging off. 
(Note: Do not use the Close button to end a Oracle Daybreak ses-
sion.)

Menu bar The horizontal bar containing the menu names. The menu bar is 
located beneath the title bar and contains commands that allow 
you to open, view, and maintain a form. 

Note: You view the contents of a menu by clicking it or pressing 
ALT + [THE UNDERLINED LETTER IN THE MENU NAME]. 
For example, ALT + R opens the Reports menu. Commands can 
be selected using the mouse or by pressing the key of the under-
lined letter in the command name.

The following menus are available from the Oracle Daybreak menu bar. 

File Contains the following commands: 
Save - Records the current data on a form in the 
database.
Re-Logon - Closes the current Oracle Daybreak 
session and refreshes the Login form, allowing 
you to re-log on to Oracle Daybreak without 
leaving the system.
Change Responsibility - Allows you to change 
your Oracle Daybreak responsibility. Responsi-
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bilities determine what Oracle Daybreak features 
are available.
Change Password - Allows you to change your 
Oracle Daybreak password.
Clear Form - Clears the active form of its 
unsaved data.
Print - Prints the contents of an active form.
Exit - Closes the Login form and ends your cur-
rent Oracle Daybreak session.

Edit Contains the following commands:
Cut - Removes selected text from a form and 
stores it in the clipboard buffer.
Copy - Copies selected text from a form and 
stores it in the clipboard buffer.
Paste - Moves data from the clipboard buffer to 
a selected field on a form.
Edit Field - Opens the Editor dialog box with the 
contents of a selected field. 
List of Values - Opens a field’s List of Values 
dialog box, if one exists.

Query Contains the following commands:
Enter - Changes Oracle Daybreak to Enter-
Query mode. This allows you to search the data-
base.
Execute - Performs the query entered during 
Enter-Query mode.
Cancel - Changes Oracle Daybreak back to user 
mode.
Last Criteria - Repeats the most recently per-
formed query entered in Enter-Query mode.
Count Hits - Displays the number of records the 
current query produced in the message line.
Get Next Set - Retrieves the next set of records 
using the most recent query entered while in 
Enter-Query mode.

Navigation Contains the following commands:
Block - Allows you to navigate to the previous 
or next block, or clear the current block.
Record - Allows you to navigate between the 
previous and next record, scroll up and down 
between records, insert or remove a record, or 
duplicate or clear a record.
Field - Allows you to navigate between the pre-
vious and next field, as well as clear or duplicate 
a field.

Lending Contains the following commands:
Customer Service - Opens the Customer Ser-
vice form.
Collection - Opens the Customer Service form 
designed for a Oracle Daybreak user focussing 
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on collections, as the Bankruptcy (4), Repo/Fore-
closure (5), and Deficiency (6) master tabs are 
unavailable.
Repossession/Foreclosure - Opens the Cus-
tomer Service form designed for a Oracle Day-
break user focussing on repossessions or 
foreclosures, as the Bankruptcy (4), and Defi-
ciency (6) master tabs are unavailable.
Bankruptcy - Opens the Customer Service form 
designed for a Oracle Daybreak user focussing 
on bankruptcies, as the Repo/Foreclosure (5) and 
Deficiency (6) master tabs are unavailable.
Deficiency - Opens the Customer Service form 
designed for a Oracle Daybreak user focussing 
on deficiencies, as the Bankruptcy (4) and Repo/
Foreclosure (5) master tabs are unavailable.
Collateral - Opens the Collateral form (currently 
unavailable).
Producers - Opens the Producer Management 
form.
Vendors - Allows you to open the Vendor Man-
agement form at the Vendors, Work Orders, or 
Invoices tab.
Securitization - Opens the Securitization form at 
the Loan tab.
Tools - Opens the Calculator Tools form at the 
Loan Calculator tab.
Transaction Authorization - Opens the Trans-
action Authorization form at the Authorization 
tab.
Custom Forms - [This is a placeholder for any 
forms customized (or added) by the client.]

Letters Contains the following commands:
Pre-defined - Allows you to generate a pre-
defined letter, either as a file or a printed docu-
ment, or preview it as a PDF file.
Ad-hoc - Opens the Correspondence form.

Documents Contains the following commands:
Application - Allows you to open the Image 
Maintenance form at either the Application 
Image Maintenance or Application Document 
Maintenance master tab.
Account - Allows you to open the Account Doc-
ument Tracking form at either the Document 
Tracking or Document Maintenance master tab.

Reports Contains the following commands:
Run - Allows you to generate a wide array or 
predefined reports. 
Print - Modifies the Run command to generate a 
predefined report, either as a file or a printed 
document.
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Preview - Modifies the Run command to gener-
ate a predefined report and view it as a PDF file 
with a browser.

Interfaces Contains the following commands:
GL Transactions - Opens the General Ledger 
form.
AP Transactions - Opens the AP Transactions 
form.
Card Transactions - Opens the Card Transac-
tions form.
Conversions - Opens the Conversion App/Acc 
form.

Batch Contains the following commands:
Transactions Advances - Allows you to open the Consumer 

Lending (Advance and Payment) form at either 
the Advance Entry or Advance Maintenance tab.
Payments - Allows you to open the Consumer 
Lending (Advance and Payment) form at either 
the Payment Entry or Payment Maintenance tab.
Escrow - Allows you to open the Escrow Analy-
sis and Disbursements form at the Escrow Anal-
ysis, Escrow Analysis Maintenance, Escrow 
Disbursement Entry, or Escrow Disbursement 
Maintenance master tabs.

Monitor Contains the following commands:
System - Allows you to open the Utilities form 
at the Setup, Monitor Batch Jobs, Monitor Jobs, 
Monitor Users, Services, Log Files, or Parked 
Transactions master tab.
User - Allows you to open the Utilities form at 
the Monitor Users master tab or open the User 
Productivity form at the Underwriting/Funding 
or Customer Service/Collection master tab.

Setup Contains the following commands:
Administration - Allows you to open the 
Administration form at the System or User mas-
ter tab.
Products - Allows you to open the Product 
Setup form at the Setup and Loan master tab.
Queues - Allows you to open the Queue Setup 
form at the Setup, Origination, or Customer Ser-
vice master tab.
Correspondence - Opens the Correspondence 
form.
Events - Allows you to open the Events form at 
the Loan master tab.
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Credit Bureau - Allows you to open the Credit 
Bureau Setup form at the Request or Reporting 
master tab.
Batch Jobs - Opens the Utilities form. 
Producers - Opens the Producer Management 
form.
Vendors - Opens the Vendor Management form.
Subvention - Opens the Subvention form at the 
Loan  master tab.
Escrow - Opens the Escrow Setup form at the 
Loan master tab.
Securitization - Opens the Securitization form.
General Ledger - Opens the General Ledger 
form.

Window Contains the following commands:
Cascade - Arranges the open forms on your 
screen so that they overlap, with the active form 
on top.
Tile Horizontally - Arranges the open forms on 
your screen so that they appear one on top of 
another.
Tile Vertically - Arranges the open forms on 
your screen so that they appear one next to 
another.
Note: The lower portion of the menu displays the 
Oracle Daybreak forms you have opened. You 
can use this menu to move between forms by 
selecting a specific form.

Help Contains the following commands:
Keys - Opens the Keys dialog box, containing a 
listing of all the hot keys available for the current 
form in use. Hot keys are shortcuts that perform 
Oracle Daybreak tasks with a minimum of key-
strokes.
Display Error - Displays information about 
recently encountered Oracle errors. (i-flex solu-
tions Corp. requests that you create a screen shot 
of this information and send it to us when you 
have a system error.)
Debug - Contains two commands: Set On and 
Set Off.
Oracle Daybreak Help - Allows you to open a 
browser and view .pdfs of either the User Guide 
or Setup Guide.
Oracle Daybreak On the Web - Allows you to 
open the i-flex solutions home page and report to 
Technical Support department when you encoun-
ter an error.
About Oracle Daybreak and Audit - Opens the 
About Oracle Daybreak dialog box, displaying 
version and audit information such as object data 
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and recent updates. It also allows you access the 
column audit.

Oracle Daybreak toolbarThe row beneath the menu bar containing 19 icon buttons used 
to perform tasks and carry out commands. The toolbar buttons are 
labeled with the action they perform. To view the label, use the 
mouse to place the mouse pointer on the button without clicking 
and the label appears.

If you choose: (hot key) Oracle Daybreak will:

[A] Save Changes (F10) Save any pending changes on the 
form.

[B] Print (SHIFT + F8) Print the current screen.
[C] Exit (CTRL + E) Close the current form or exits the 

application.
[D] Cut (CTRL+X) Remove selected text and stores it 

on the clipboard.
[E] Copy (CTRL+C) Copy selected text and stores in on 

the clipboard.
[F] Paste (CTRL+V) Insert text stored on the clipboard 

in a selected field.
[G] Enter Query (F7) Change Oracle Daybreak to Enter-

Query mode.
[H] Execute Query (F8) Perform the query entered while in 

Query mode.
[I] Cancel Query (CTRL+Q) Change Oracle Daybreak back to 

user mode.
[J] First Record Display the first record.
[K] Previous Record (SHIFT + UP) Display the previous record.
[L] Next Record (SHIFT + DOWN) Display the next record.
[M] Last Record Display the last record.
[N] Insert Record (F6) Create a new record.
[O] Remove Record Delete the current record from the 

database.
[P] Clear Record (SHIFT+F4) Clear the current record from the 

form. 
[Q] Lock/Unlock Record Lock and unlocks a record.
[R] Copy with Details Record Copy the selected record to the 

clipboard.
[S] Help (CTRL + H) Display help for the selected item.

Note: Depending on the context of the selected field, some toolbar buttons may not be 
available. For example, if you select a field that does not allow a query, the Enter Query 
button is unavailable.

Message lineThe message line is located in the lower left corner of the Oracle Daybreak 
window and displays field prompts, error messages, or additional details about a field. In 
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the illustration below, the message line contains the error message: “Query caused no 
records to be retrieved.”

Status line The status line appears below the message line and displays status 
information about the current form or field. A status line can con-
tain the following indicators:

Enter-Query Indicates that Oracle Daybreak is in Enter-Query 
mode, allowing you to specify search criteria for 
a query.

List of Values Appears when a List of Values (LOV) is avail-
able for the selected field.

Form components
This section presents an overview of the components found on forms and how to use them.

Tab Oracle Daybreak uses tabs as a primary navigation tool. 

Tabs are small flaps used for quick access to pages of informa-
tion, not unlike the tabs on a folder in your file cabinet. There are 
three types of tabs in Oracle Daybreak system: master tab, tab, 
and sub tab. 

Master tabs are the highest level of tab. If present on a form, they 
are usually numbered and appear near the top of the form. Master 
tabs are used primarily to navigate to other pages. 

Tabs and sub tabs open pages that contain information. 

Sub tabs, if present, appear at the bottom of the form.
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Page (or tabbed page) The information items associated with a tab (blocks, records, 
check boxes, command buttons, and so on) are located on a page. 
The name of the page is the same as the name of the tab. The 
information associated with a sub tab is a sub page. 

In the illustration below, the Primary page and Address sub pages 
are is circled.
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Block A frame, or box, that encloses a set of related functions or data. A 
shadowed line marks a block’s perimeter. The title of the block 
appears across the top of the block in bold, black text. 

Command button A rectangle button that initiates a predefined action. Buttons do 
not contain values as fields do. A button is usually labeled with 
text noting the action that it performs. In the illustration below, 
the Loan page contains six command buttons: “Calculate,” 
“Amortize,” “Initialize,” “Copy to Decision,” “Copy to Con-
tract,” and “Print Report.” All three are located in the Action 
block.

Note: The “Copy to Contract” button is unavailable.

Field A box on a form used to enter, view, update, or delete informa-
tion. Each page contains fields. Fields can display values in dif-
ferent formats; including text, numbers, and dates.

Text field A field that stores characters and numbers.

Number field Number fields store only numbers, often dollar 
figures, with or without decimals.

Date field Date fields store dates and sometimes time val-
ues.

IMPORTANT: 
When you select a field, messages appear in the message area in 
the lower left corner of the Oracle Daybreak window. The mes-
sages describe the field or what type of information can be 
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entered in the field. (See Message line and Status line later in this 
section for more information.)

Option button A round button used to select an action from a group of options. 
You can select only one option button in a group at a time. In the 
illustration below, option buttons are used to select whether Ora-
cle Daybreak calculates payment or calculates interest rate. 

Check box A check box indicates a state for a particular field, such as 
enabled/disabled, primary/secondary, and current/not current. For 
that reason, check boxes are sometimes called “indicators.” The 
title of the check box indicates what it controls. A check denotes 
that the check box is selected. Click a selected check box to 
“clear” it. 

Note: One or more check boxes can be selected, since each one 
acts independently.

List of Values (LOV) A dialog box linked to a field that enables you to select a single 
item from a predefined list. To view a field's List of Values, press 
F9. Move the blue highlighted bar using the UP or DOWN ARROW 
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keys or the slide bar on the LOV dialog box to the value you want 
to select. In the example below, 55001 AFTON MN is selected. 
Some LOV contain lists long enough to require a scroll bar to 
view the entire contents. Choose OK, press ENTER, or double-
click the LOV item to populate the field with the selected value. 

Blue square (cursor) Oracle Daybreak uses a blue square as a cursor. The blue square 
indicates the active item, usually a field or record. You can move 
the blue square using the arrow keys on your keyboard or by 
clicking an item with the mouse.

Record A logically related collection of fields within a block about one 
person, place, or thing.

There are two types of records in Oracle Daybreak; table records 
and block records. A scroll bar allows you view records not cur-
rently displayed. The message bar informs you of the total num-
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ber of records in the table block, as well as the record you are 
currently viewing.

Table records Appear as a grid, where each record is a single 
row of related data.

Block records Record appears as a single block.

Record line Located in the lower left corner of the Oracle 
Daybreak window, the record line displays how 
many records exist within the record on display.

Next Record/ The presence of a record scroll bar indicates that 
Previous there are records above or below the one on
Record which you are working. If the scroll bar does not
scroll bar stretch the entire length between the two arrows, 

this indicates there are additional records avail-
able. If the scroll bar stretches the entire length 
between the two arrows this indicates no other 
records are available. Click the arrows to view 
these records. Click the up ( ) or left ( ) arrow 
for previous records. Click the down ( ) or right 
( ) arrow for following records.

Hint box A yellow box that appears when the mouse pointer is moved over 
a field. The hint box will display a description of the field’s con-
tent. If the field is associated with a List of Value dialog box, the 
hint box displays the Lookup Type of the LOV.

Using colors as a guide
Fields appear in different colors to indicate what type of information the field contains. 

Aqua Required - Information is required in an aqua field to complete a 
form.

White Optional - A white field is not required to contain information 
when completing a form. 

IMPORTANT:
Some optional fields may be required by your organization. Such 
fields, though not mandatory on the form, must be completed dur-
ing edit verification.

Gray Display only - Data cannot be entered in these fields. 

Note: Aqua, white, and gray are the default colors in the Oracle 
Daybreak system. Your organization may have selected different 
colors during implementation.
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Understanding parent-child relationships
A parent-child relationship is an association between a master block and one or more 
detail pages. The master-detail relationship is arranged in the shape of a pyramid, from the 
top of the form to the bottom. The top block contains the basic, or master, information. 
The detail pages then expand on the contents of the master block. Detail pages themselves 
can serve as master blocks for other sub detail pages that follow. When a block and pages 
are linked in a master-detail relationship, the following conditions exist:

1 The detail page displays only those records that are associated with the current record 
in the master block.

2 Querying between the master block and detail pages is always coordinated.

When a record is displayed in a master block, the detail pages contain information that 
corresponds to that record. If you perform query or change information in the master 
block, Oracle Daybreak updates the detail pages to match the new record in the master 
block. If you use the master block to perform a query and gain access to the records for a 
different application, the detail pages refresh to display information for the new record in 
the master block.

Note: You can perform a query from a detail page if the master block (or page) is com-
pleted. Otherwise, it is not possible to directly query from a detail page.

Example: Parent-child relationship
In the illustration below, note that the Underwriting form is divided into three sections. 
The top section (the Application block) is the master page. It contains such information as 
application number, product, and other items related to a specific application. The Appli-
cants (2) master tab has been selected to display the Primary page and Address Informa-
tion sub page. These detail pages contain further information about the application; in this 
case, the application’s primary applicant and that person’s address information.
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APPENDIX B :NAVIGATING AND QUERYING IN ORACLE DAY-
BREAK

This appendix explains how to use Oracle Daybreak to complete these frequently com-
pleted tasks:

• Navigate within and between forms
• Print a form
• Save an entry
• Edit data (including cutting, copying, and pasting data)
• Clear data
• Duplicate data
• Create and delete records
• Use the Editor dialog box
• Enter and query data using the List of Values (LOV) dialog box
• Use additional LOV tools (auto reduction, long-list, list search, and power list)
• Query data
• Use query operators and wildcard characters (including Query by example, Query/

Where, and Query count)
• Use hot keys.
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Navigating within a form
The following procedures can be used to navigate within a Oracle Daybreak form. Choose 
the one you are most comfortable using:

• Move the cursor with your mouse
• Select a command from the menu bar (Navigation menu)
• Select a command from the Oracle Daybreak toolbar
• Enter a keyboard shortcut (hot key)

The Navigation menu
The Navigation menu contains the following commands, all of which allow you to navi-
gate within a form: Block, Record, and Field.

The Block command contains the following sub commands:

If you choose: (hot key) Oracle Daybreak will:

Previous (CTRL + PAGE UP) Move the cursor to the previous block (if one 
exists).

Next (CTRL + PAGE DOWN) Move the cursor to the next block (if one exists).
Clear (SHIFT + F5) Clear the block currently containing the cursor.

The Record command contains the following sub commands:

If you choose: (hot key) Oracle Daybreak will:

Previous (SHIFT + F8) Display the previous record (if one exists).
Next (SHIFT + DOWN) Display the next record (if one exists).
Scroll Up (PAGE UP) Perform that same action as pressing PAGE UP.
Scroll Down (PAGE DOWN) Perform that same action as pressing PAGE 

DOWN.
Insert (F6) Create a new record.
Remove (SHIFT + F6) Remove the current record.
Duplicate (F4) Duplicate the current record.
Clear (SHIFT + F4) Clear the current record.

The Field command contains the following sub commands:

If you choose: (hot key) Oracle Daybreak will:

Previous (SHIFT + TAB) Move the cursor to the previous field (if one 
exists).

Next (TAB) Move the cursor to the next field (if one exists).
Clear (CTRL + U) Clear the current field.
Duplicate (F4) Duplicate the current field.

IMPORTANT:
The TAB and ENTER keys move the cursor between fields. F8 refreshes the record.
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Navigating between forms
You can open multiple forms in each window and navigate between them with the Win-
dow menu. The lower part of the Window menu lists the forms that are currently open. 
Selecting the form’s option button moves you to that form.

To navigate between forms

1 On the Oracle Daybreak menu bar, choose Window.

2 Select the form you want to move to by selecting it with one of the following methods:

• Click the option button for the corresponding form. 
-or-

• Move the cursor on the open Windows menu with the UP and DOWN ARROW keys and press 
ENTER to open a highlighted form.
-or-

• Type the number on the Windows menu next to the form you want to open.

Oracle Daybreak displays the form you selected.

Common Oracle Daybreak tasks
This section explains tasks common to many Oracle Daybreak modules and forms. Here 
you will learn how to:

• Print a form
• Save your work
• Editing data
• Using the Editor dialog box
• Close a form/leave Oracle Daybreak

Printing a form
You can print a form at any time. Make sure a printer driver is installed and at least one 
printer is defined before printing. (Contact your system administrator for information on 
how to install printer drivers and define printers.)

To print a window

• On the File menu, choose Print
-or-

• Click Print on the Oracle Daybreak tool bar.
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Saving your entry
When you save your work, the database is updated with all changes made since the last 
time the data was saved. 

To save your work in Oracle Daybreak

• On the File menu, choose Save
-or-

• On the Oracle Daybreak tool bar, choose Save (the yellow disk icon)
-or-

• Press F10.

When you save an entry, the message line at the bottom of your screen displays a “Trans-
action complete” message to inform you of the changes.

Editing data
In this section, you will learn how to use Oracle Daybreak to edit data. You will learn how 
to:

• Cut, copy, and paste data
• Clear data
• Duplicate data
• Create and delete records
• Use the Editor dialog box

Cutting, copying, and pasting data
The cut, copy, and paste commands on the Oracle Daybreak menu bar allow you to move 
and edit data. 

To cut, copy, and paste with the Oracle Daybreak menu bar

1 Open the form and select the data in the field you want to edit. (You can either drag your 
mouse over the data or double-click the data to select it.)

2 On the Edit menu, select Cut or Copy. (Copy leaves the data in the field while copying it; 
Cut clears the field when it copies the data.)

3 Move the cursor to the field where you want to place the copied data. 

4 On the Edit menu, choose Paste.

Oracle Daybreak pastes the cut or copied data in the new field.
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Keyboard guide for the previous steps

These three tasks can also be completed with the keyboard by doing the following:

Press this: To do this:

CTRL+X Cut
CTRL+C Copy
CTRL+V Paste

Clearing data
You can clear data from a form at any time. The data you clear is simply erased from the 
form, not deleted from the database. You can clear fields, records, blocks, or entire forms. 
This is particularly useful when you went to add an new entry to a record, block, or form 
that appears “full.”

If the data is new and has never been saved in the database, it will be permanently lost 
when you clear it from the form. Some items cannot be cleared of information. If you 
attempt to clear an item that cannot be cleared, the error message “Field is protected 
against update” appears in the message line.

To clear a field

• Select the field you want to clear and use one of the following methods to clear data:

On the Navigation menu, choose Field > Clear.
-or-
Select and type over the existing data, or use the BACKSPACE or DELETE key to remove the 
data.
-or-
Press CTRL+U.

IMPORTANT:
The data you clear from the field is not available for pasting into another field. If you want 
to paste the data elsewhere, use the Copy or Cut commands on the Edit menu.

To clear a record 

• Select the record you want to clear and use one of the following methods to clear data:

On the Navigation menu, choose Record > Clear.
-or-
On the Oracle Daybreak tool bar, choose the Clear Record icon.
-or-
Press SHIFT+F4.

Oracle Daybreak clears the values in all the fields of your current record and returns the 
cursor to the first field of the next record.

To clear the current block

• Select a field in the block you want to clear and use one of the following methods to clear 
data:

On the Navigation menu, choose Block > Clear.
-or-
Press SHIFT+F5.
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Oracle Daybreak clears the block and returns your cursor to the first field in the current 
block.

IMPORTANT: 
If the current block is a multi-record block, this action erases all records displayed in the 
block.

To clear a form

• Open the application of the form you want to clear and press SHIFT+F7.

Oracle Daybreak clears the data from all the fields of the current form and returns your 
cursor to the first field of the form.

Duplicating data
If data needs to be repeated in a new record, you can duplicate data from a previous 
record.

To copy a field from a previous record

1 Depending on the form you are using, enter a new record or query an existing record.

2 On the Navigation menu, choose Record > Insert
-or-
On the Oracle Daybreak tool bar, choose the Insert Record icon
-or-
Press F6.

Oracle Daybreak inserts a new record after the existing record.

3 Move the cursor to the field you want to duplicate in the new record.

4 On the Navigation menu, choose Field > Duplicate.
-or-
Press F3.

Oracle Daybreak copies the field value from the previous record to the current record.

To copy all fields from a previous record

1 Enter a new record, or query an existing record in your form.

2 On the Navigation menu, choose Record > Insert
-or-
On the Oracle Daybreak tool bar, choose the Insert Record icon
-or-
Press F6.

Oracle Daybreak inserts a new record after the existing record.

3 On the Navigation menu, select Record > Duplicate.

-or-
Press F4.
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IMPORTANT: 
If your current block requires all records to be unique, the Duplicate command does not 
duplicate those fields that must be unique.

To copy all information on a page and its sub pages

1 Move the cursor to the first field on the page you want to duplicate.

2 On the Oracle Daybreak tool bar, choose the Copy with Details Record icon.

Note: For this process to work, the entry has to be locked (lock parameter set to y)

3 Make the changes you desire to the details in the duplicate entry to make it unique.

4 Choose the Copy with Details Record icon to complete sub tabs.

5 Make the changes you desire to the sub page details in the duplicate entry to make it 
unique.

6 Save your new entry.

Creating and deleting records
You can enter new records in the database or delete existing records from the database. 
Only users who have the appropriate permissions set up in their user responsibility can 
create or delete records.

To create a new record

1 On the Navigation menu, choose Record > Insert.
-or-
On the Oracle Daybreak tool bar, click Insert Record.
-or-
Press F6.

Note: When you create a record in a multi-record block, Oracle Daybreak inserts a new 
blank row below the selected row. In a single-record block, Oracle Daybreak clears the 
fields in the block. 

2 Once the selected field is cleared, enter the data for the new record. 

3 On the File menu, choose Save.
-or-
On the Oracle Daybreak tool bar, click Save.
-or-
Press F10.

Oracle Daybreak saves the record in the database.

IMPORTANT: 
If you exit the form without saving your work, the record is not added to the database.
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To delete a record 

1 Select the record you want to delete. 

2 Use one of the following methods to delete data from a field:

On the Navigation menu, choose Record > Remove.
-or-
On the Oracle Daybreak tool bar, choose the Remove Record icon.

Oracle Daybreak erases the current record from your form and returns your cursor to the 
first field of the next record; however, the record is not yet deleted.

3 On the File menu, choose Save.
-or-
On the Oracle Daybreak tool bar, click Save.
-or-
Press F10.

IMPORTANT:
If you exit the form without saving your work, the record is not deleted from the database.
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Using the Editor dialog box
You can use the Editor dialog box to view, enter, or update the entire contents of an entry 
field. The Editor dialog box is especially useful for editing scrollable text fields. A scrolla-
ble text field is a field whose actual width is longer than its display width and whose con-
tent you can view by scrolling through the field. Searches performed in the Editor dialog 
box are case-sensitive.

IMPORTANT:
If a text field is set up to use a default system editor, then the following procedures open 
the editor determined by the profile option “Editor (Character).”

To use the Editor dialog box

1 Open the form and select the field you want to edit.

2 On the Edit menu, choose Edit Field.

The Editor dialog box appears with the text from the field you selected.

Note: You can also open the Editor dialog box by pressing CTRL+E.

3 Enter a new text or edit the existing text in the Editor dialog box and choose Ok.

IMPORTANT: 
If the current field is a display-only field, then the Editor dialog box appears in display-
only mode.

To search for a phrase and replace it with another phrase

1 On the Edit menu, choose Edit Field.

The Editor dialog box appears.

2 Choose Search.

The Search/Replace dialog box appears.
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3 In the Search for field, type the text or characters you want to find on the form.

If you want to replace that data with other data, type the new data in the Replace with 
field.

4 Choose the Search button to search for the value.
-or-
Choose Replace to search for the value and replace the first occurrence.
-or-
Choose Replace All to search for the value and replace all occurrences.

5 To close the Search/Replace dialog box, choose Cancel.

6 When you are finished editing the value in the Editor window, choose Ok.

The Editor dialog box closes the window and the edited value appears in the field.

Exiting a form/leaving Oracle Daybreak
You can close a Oracle Daybreak form, or end a Oracle Daybreak session, using the mouse 
or keyboard.

To save exit a form/leave Oracle Daybreak

• On the File menu, choose Exit
-or-

• On the Oracle Daybreak tool bar, choose Exit (the blue door icon)
-or-

• Press CTRL + Q.

Oracle Daybreak will end a Oracle Daybreak session when you perform one of these 
actions from the Login form.

Entering and querying data
This chapter explains how to use the List of Values dialog boxes and search for data while 
using a form.

List of Values (LOV) dialog box
Many fields on Oracle Daybreak forms are linked to a List of Values (LOV) dialog box. 
An LOV displays all possible entries that Oracle Daybreak will accept for a particular 
field. You can select data from the LOV to complete the field instead of having to search 
for acceptable entries. Likewise, a field that is associated with an LOV only accepts 
entries found on the list of values. Using the LOV increases accuracy and productivity, as 
it ensures uniformity and efficiency during data entry.

Note: If you are in Enter-Query mode, the LOV cannot be used.
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When an LOV is available for a field, “List of Values” appears on the status line. Also, 
when you move the cursor to the field with an LOV from a Lookup field in the Setup 
menu, a yellow hint box appears, citing the lookup type for the LOV.

When you open an LOV from an entry field, the field’s LOV dialog box appears.

An example of a List of Values box. This one appears from the Street Type field on an 
Address block.
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An LOV might contain more than one column of information. Most LOVs provide a 
descriptive heading at the top of each column. 

To select data from an LOV

1 Move the cursor to an entry field with an LOV.

“List of Valu...” appears on the status line.

2 On the Edit menu, choose List of Values.
-or-
Press F9.

When the LOV appears, you can either use the mouse to scroll through the list box and 
double-click on a value to select it, or press the UP ARROW or DOWN ARROW keys to high-
light a value with the blue bar. 

If you choose Cancel, the LOV closes and no entry appears in the field.

3 Press ENTER or choose OK to select the value.

Once you select a value, the LOV dialog box closes and the selected value appears in the 
field. 
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Additional LOV tools 
In addition to allowing you to select a field value, LOVs provide tools to simplify entering 
data and working with long lists. Auto Reduction lets you view a condensed portion of the 
entire list of values. Power List allows you to quickly enter data without opening the LOV.

In some cases, an LOV is too large to fit entirely in the list box and the Long-List LOV 
appears. 

Auto reduction
Using Auto Reduction, you can shorten an LOV. With a shortened list, you only need to 
scan a subset of the original values. 

To use the Auto reduction feature

• In the Find field on the LOV dialog box, type the first character(s) of a value you want to 
locate. (A percent sign appears by default in the Find field.)

Oracle Daybreak automatically reduces the list to just those values in the first column that 
match the characters you enter. 

Note: To return to the entire contents of the LOV, type the wildcard character % in the 
Find field and press ENTER.

List search
If you do not know the initial characters of your value, but do know that your value con-
tains a certain word or set of characters, you can perform a list search to find the values 
that contain those words or characters.

To perform a list search

1 In the Find field on the LOV dialog box, enter any group of characters as search criteria. 
Use wildcard characters, such as the percent sign (%), which represents any number of 
characters, or underline ( _ ), which represents a single character in your search criteria.

IMPORTANT:
The criteria you enter for a list search is not case-sensitive. For example, to reduce a 
search list to just those values containing the word “schedule,” enter %schedule% in the 
Find field.

2 Choose Find. 

A reduced list appears, containing just those values that match the search criteria.
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Long-list
Long-List is the other tool you can use to shorten an LOV. Long-List works similarly to 
Auto Reduction. The Long-List dialog box appears when a field has a list too large for 
Auto Reduction. 

To perform a list search

1 In the Find field on the long list LOV dialog box, type the first few characters that occur in 
your value in the Find field

2 Choose Find.

Oracle Daybreak reduces the long list to a smaller sub set of values meeting the search cri-
teria in the Find field in a regular LOV.

3 Select the value you want to use and choose Find. 

 Other LOV features
You do not have to use a field’s LOV to complete a field. If your entry appears in the 
field’s’ LOV, Oracle Daybreak will accept it when you type it in the field.

The Auto Reduction logic that applies to the LOV also applies to your entry in a field with 
an LOV. If you type the first letter of your entry and press TAB, Oracle Daybreak will auto-
matically complete the field if there is a single match in the LOV.

If more than one entry in the LOV share the characters you typed, Oracle Daybreak will 
open the LOV displaying only the entries beginning with those characters.

If no entry in the LOV matches the characters you typed, Oracle Daybreak opens the LOV 
displaying all of its entries when you press TAB.
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Querying data
Oracle Daybreak provides you with search options to locate information when working 
with a form. You can retrieve and review all available information in your database with-
out having to remember the information from a previously displayed form or printing 
lengthy reports to view an item. Instead, you can perform a search to obtain and review the 
information you want.

This section describes the methods you can use to locate and retrieve records in Oracle 
Daybreak. These include:

• Using query operators
• Query-by-example
• Query/Where
• Using query count

Note: If you are in Enter-Query mode, the LOV cannot be used.

IMPORTANT: 
Searches cannot be performed in forms that require using the Search page to retrieve infor-
mation. These forms (for example, the Underwriting form, the Funding form, and Cus-
tomer Service form) only display run-time output, or only run specific processes. The 
following message appears in the message line if you attempt to search such a form: 
“Function key not allowed. Press Ctrl+F1 for list of valid keys.”

Using query operators
Query operators are used to create search criteria to limit searches to specific information. 
The query operators available in most fields include:

Operator Meaning Example Expression

= equal to = 'Janet' or = 107
!= not equal to != 'Bob' or != 107
> greater than > 99 or > '01-JAN-93'
>= greater than or equal to >= 55
< less than < 1000.00
<= less than or equal to <= 100
#BETWEEN between two values #BETWEEN 1 AND 1000

The query operator expressions retrieve results according to character-ordering rules for 
character fields and numeric-ordering rules for numeric fields. For example, look at the 
following field values:

002, 003, 004, 005, 078, 123, 253, 441, 576, 775, 1274, 3298, 
4451, 5600, 9578, 10500, 58437, 708445
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These values are shown in the order you expect for numeric values, where 005 is between 
004 and 078. If the field is defined as a numeric field, then the phrase “#BETWEEN 004 
AND 078” would retrieve 004, 005, and 078.

However, if the field is defined as a character field, then the phrase “#BETWEEN 4 AND 
7” would retrieve the values 441, 576, 4451, 5600, and 58437, which all start with 
characters between 4 and 7. The values 775 and 005 would not appear because 775 is 
lexically greater than 7, and 0 is lexically less than 4.

Some fields contain date values that are actually “Date-format” character values. These 
fields act like character fields in that the value 01-FEB-92 would be lexically less than 01-
JAN-92, because F precedes J in a character set.

IMPORTANT: 
Sometimes you cannot instantly determine if a field containing numeric values is defined 
as a character or numeric field. To identify what the field type is, you may have to enter 
and experiment with different search criteria expressions and see what results are returned.

Tips for using Query Operators
• Use single quotation marks ('  ') to enclose the character or date value in your 

expression. For example:

'Texas'
'01-MAY-93'

• Query operators cannot be used in time fields.

When you use the #BETWEEN query operator, the search criteria “#BETWEEN value1 
AND value2” retrieves all records containing values between and including value1 and 
value2. The same applies to dates. For example, using the search criteria “#BETWEEN 
'01-JAN-93' AND '01-MAR-93'” in a date field retrieves all records with dates between 
and including January 1, 1993 and March 1, 1993.

Finding patterns with wildcard characters
In addition to query operators, you can include wildcard characters in your search criteria. 
Wildcard characters search for particular patterns in your data. Use the percent (%) wild-
card character within a field to represent any number of characters (including no charac-
ters), or use the underline ( _ ) wildcard character to represent any single character. 

For example, if you want to retrieve all records that contain the word “XXX” in a specific 
field, you would enter the search criteria %XXX% in that field.
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Enter-Query mode
If you want to retrieve a group of records in a Oracle Daybreak from using search criteria, 
you can use Enter-Query mode.The Enter-Query mode may be used to specify complex 
search criteria in any of the fields on your current block. 

The search criteria can include:

• Specific values
• Phrases containing wildcard characters
• Phrases containing query operators 
• Any combination of the three to help you pinpoint the data of interest.

IMPORTANT: 
When your application is in Enter-Query mode, you will not be able to navigate out of the 
current form. To navigate from the form, you must exit Enter-Query mode by choosing 
Cancel Query or Exit on the task bar or pressing CTRL+Q.

To user Query-by-example

1 On the Query menu, choose Enter
-or-
Press F7
-or-
On the Oracle Daybreak toolbar, click the Enter Query icon.

Oracle Daybreak switches from data entry mode to Enter-Query mode and clears the form. 
The Enter-Query message appears in the status line. 

2 Enter search criteria in any of the fields, using wildcard characters and query operators as 
necessary. You can also choose Last Criteria on the Query menu to display the search cri-
teria used in your last search, if there was one.   

Note: Pressing F7 twice will also display the search criteria from your last search.

IMPORTANT: 
While in Enter-Query mode, all check boxes are in a neutral state; that is, they are neither 
selected nor cleared as a default. If you want your search criteria to include a selected 
check box, you have to select it, regardless of whether it already appears to be checked. 
Similarly, if you want your search criteria to include a cleared check box, you have to clear 
it, regardless of how it currently appears. (To clear it, first select the check box to activate 
it, then select it again to clear it.)

3 On the Query menu, choose Execute
-or-
Press F8
-or-
On the Oracle Daybreak toolbar, click the Execute Query icon.

IMPORTANT: 
To retrieve all the database records for a block, you can bypass steps 1 and 2 and select 
Execute on the Query menu. This is known as a blind query. To retrieve all records for a 
block, press F7, then press F8 to perform the query.
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4 To leave the Enter-Query mode, choose Cancel from the Query menu
-or- 
Press CTRL+Q
-or-
On the Oracle Daybreak toolbar, click the Cancel Query icon.

Query/where 
An even more sophisticated search method is to use Query/where. Query/where allows 
you to modify a query by using a SQL Plus statement as your search criteria.

To use Query/where

1 On the Query menu, choose Enter
-or-
Press F7
-or-
On the Oracle Daybreak toolbar, click the Enter Query icon.

Oracle Daybreak switches to Enter-Query mode.

2 Enter the character & (or a blind variable) in the field from which you want to run the 
query.

3 On the Query menu, choose Execute
-or-
Press F8
-or-
On the Oracle Daybreak toolbar, click the Execute Query icon.

The Query/Where dialog box appears.

4 Type the search criteria in the format of a SQL Plus statement in the window. 

For example, the following Query/Where search criteria:

:P like '%VEH%' and :A in ('0000000374', '0000000532')

Would produce the following results:

The two loan loans, 0000000374 and 0000000532.

5 Choose OK to execute the query. 
-or-
Choose Cancel to close the Query/Where dialog box without running a query. 

Note: If you have a long statement as your search criteria, you can use a field editor to 
make changes to your statement by choosing Search. 
Appendix B :-18   User Guide - Consumer Loans Servicing 



Query count 
If you do not need to retrieve the records from a query-by-example search, but only want 
to know how many records match your search criteria, you can perform a query count.

To obtain a count of the number of records

1 On the Query menu, choose Enter
-or-
Press F7
-or-
On the Oracle Daybreak toolbar, click the Enter Query icon.

2 Enter the search criteria in the field you want to perform the query.

3 On the Query menu, choose Count Hits.
-or-
Press SHIFT+F2.

Oracle Daybreak counts your query. A message appears on the message line displaying 
the number of records query-by-example would retrieve if you ran the search.

IMPORTANT: 
If you select Count Hits on the Query menu without specifying any search criteria in a 
block, query count displays the total number of records in the database for that block.
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Hot keys
“Hot keys” are keystroke shortcuts that perform navigation and data entry tasks. A dialog 
box containing a form’s available hot keys can be viewed by selecting Help > Keys on the 
Oracle Daybreak menu bar. Below is a list of these keys:

Function Key(s)
Block Menu F5
Cancel Query CTRL + Q
Clear Block SHIFT + F5
Clear Field CTRL + U
Clear Form SHIFT + F7
Clear Record SHIFT + F4
Copy CTRL + C
Count Query SHIFT + F2
Cut CTRL + X
Delete Record SHIFT + F6
Display Error SHIFT + F1
Down DOWN ARROW
Down CTRL + L
Duplicate Item F3
Duplicate Previous Record F4
Exit CTRL + E
Enter Query F7
Execute Query F8
Help CTRL + H
Insert Record F6
List Tab Pages F2
Move between master tabs

Master tab 1 SHIFT + CTRL + F1
Master tab 2 SHIFT + CTRL + F2
Master tab 3 SHIFT + CTRL + F3
Master tab 4 SHIFT + CTRL + F4
Master tab 5 SHIFT + CTRL + F5
Master tab 6 SHIFT + CTRL + F6
Master tab 7 SHIFT + CTRL + F7
Master tab 8 SHIFT + CTRL + F8
Master tab 9 SHIFT + CTRL + F9
Master tab 10 SHIFT + CTRL + F10

Move to next page/sub page CTRL+TAB
Move to previous page/sub page CTRL+SHIFT+TAB
Next Block/Page to sub page CTRL + PAGE DOWN
Next Field TAB
Next Primary Key SHIFT + F3
Next Record SHIFT + DOWN ARROW
Next Set of Records SHIFT + CTRL + PAGE DOWN
Paste CTRL + V
Previous Block/Sub page to page CTRL + PAGE UP
Previous Field SHIFT + TAB
Previous Record SHIFT + UP ARROW
Print SHIFT + F8
Return ENTER
Save changes F10
Scroll Down PAGE DOWN
Scroll Up PAGE UP
Scroll Keys CTRL + F1
Up CTRL + P
Up UP ARROW

Update Record CTRL + U
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APPENDIX C : TRANSACTION PARAMETERS

The Customer Service form Maintenance (3) master tab allows you to post an array of 
monetary and nonmonetary transactions for any given account. The transactions that are 
available depend on the responsibility of the Oracle Daybreak user, the nature of the 
account, and whether the account is a loan.

This appendix catalogues the baseline transaction codes and parameters available on the 
Customer Service form’s Maintenance (3) master tab. Instructions on how to use the 
Maintenance (3) master tab are located in the Customer Service chapter of this User 
Guide.

Loan monetary transactions
This section catalogues the transaction codes and parameters required to complete the fol-
lowing monetary tasks for loan:

• Apply, adjust, or waive servicing expenses
• Adjust or waive late charges
• Adjust or waive nonsufficient funds
• Apply, adjust, or waive repossession expenses
• Apply, adjust, or waive bankruptcy expenses
• Apply or adjust phone pay fees
• Change an index/margin rate
• Apply, adjust, or cancel financed insurance
• Generate a payoff quote
• Payoff an account
• Charge-off an account
• Close an account
• Adjust, charge-off, or waive the advance/principal balance
• Adjust the interest balance
• Stop interest accrual
• Indicate a borrower as on or off active military duty
• Change a due date 
• Apply, adjust, or waive an extension fee
• Change payment amount
• Adjust or waive a prepayment penalty
• Reschedule an escrow payment
• Adjust or waive an escrow payment
• Adjust or waive a payoff quote fee
• Place an account in a nonperforming condition
• Reverse a nonperforming condition
• Reschedule precompute loan to interest bearing loan
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Servicing expenses
Service expenses are any expenses incurred to service an account; for example, employing 
a courier to send documents, such as payoff quotes or balance statements. Servicing 
expenses appear in the Other Due field on the Dues block of the Account Details page. 
This is the first page to appear on the Customer Service form when you load an account.

To post a servicing expense
Transaction Parameters
SERVICING EXPENSES TXN DATE

AMOUNT

To adjust a servicing expense
Transaction Parameters
ADJUSTMENT TO SERVICING EXPENSES - ADD TXN DATE

AMOUNT

ADJUSTMENT TO SERVICING EXPENSES - SUBTRACT TXN DATE
AMOUNT

To waive a servicing expense
Transaction Parameters
WAIVE SERVICING EXPENSES TXN DATE

AMOUNT
Appendix C :-2   User Guide - Consumer Loans Servicing 



Late charges
Late charges occur when payment is not made within the grace period or by the day after 
payment is due. The due date is determined by the contract. Late charges cannot be 
assessed by a user, they are assessed automatically by Oracle Daybreak.

Late charges appear in the LC Dues field on the Dues block of the Account Details page. 
This is the first page to appear on the Customer Service form when you load an account.

To adjust a late charge 
Transaction Parameters
ADJUSTMENT TO LATE CHARGE - ADD TXN DATE

AMOUNT

ADJUSTMENT TO LATE CHARGE - SUBTRACT TXN DATE
AMOUNT

To waive a late charge
Transaction Parameters
WAIVE LATE CHARGE TXN DATE

AMOUNT
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Nonsufficient fund fees
Nonsufficient fund fees are posted when a payment does not cover the amount owed. The 
fee that Oracle Daybreak automatically applies to an account is recorded during setup.

Nonsufficient fund fees appear in the NSF Due field on the Dues block of the Account 
Details page. This is the first page to appear on the Customer Service form when you load 
an account.

To adjust a nonsufficient funds
Transaction Parameters
ADJUSTMENT TO NONSUFFICIENT TXN DATE
     FUND FEE - ADD AMOUNT

ADJUSTMENT TO NONSUFFICIENT TXN DATE
     FUND FEE - SUBTRACT AMOUNT

To waive a nonsufficient funds
Transaction Parameters
WAIVE NONSUFFICIENT FUND FEE TXN DATE

AMOUNT
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Repossession expenses
Repossession expenses include any costs incurred while obtaining the asset, including 
legal fees or storage costs.

Repossession expenses appear in the Other Due field on the Dues block of the Account 
Details page. This is the first page to appear on the Customer Service form when you load 
an account.

To post a repossession expense 
Transaction Parameters
REPOSSESSION EXPENSES TXN DATE

AMOUNT

To adjust a repossession expense
Transaction Parameters
ADJUSTMENT TO REPOSSESSION TXN DATE
     EXPENSES - ADD AMOUNT

ADJUSTMENT TO REPOSSESSION    TXN DATE
     EXPENSES - SUBTRACT AMOUNT

To waive a repossession expense
Transaction Parameters
WAIVE REPOSSESSION EXPENSES TXN DATE

AMOUNT
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Bankruptcy expenses
Bankruptcy expenses include any costs incurred when an account holder declares bank-
ruptcy, such as legal fees or additional collection costs.

Bankruptcy expenses appear in the Other Due field on the Dues block of the Account 
Details page. This is the first page to appear on the Customer Service form when you load 
an account.

To post a bankruptcy expense 
Transaction Parameters
LEGAL BANKRUPTCY EXPENSES TXN DATE

AMOUNT

To adjust a bankruptcy expense
Transaction Parameters
ADJUSTMENT TO BANKRUPTCY TXN DATE
     EXPENSES - ADD AMOUNT

ADJUSTMENT TO BANKRUPTCY TXN DATE
     EXPENSES - SUBTRACT AMOUNT

To waive a bankruptcy expense
Transaction Parameters
WAIVE LEGAL BANKRUPTCY EXPENSES TXN DATE

AMOUNT
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Phone pay fees
Phone pay fees are where a borrower calls the lender and arranges for a debit to their 
checking or savings account to make a payment on a loan account.

Phone pay fees appear in the Other Due field on the Dues block of the Account Details 
page. This is the first page to appear on the Customer Service form when you load an 
account.

To adjust a phone pay fee
Transaction Parameters
ADJUSTMENT TO PHONE PAY FEE - ADD TXN DATE

AMOUNT

ADJUSTMENT TO PHONE PAY FEE - SUBTRACT TXN DATE
AMOUNT

To waive a phone pay fee
Transaction Parameters
WAIVE PHONE PAY FEE TXN DATE

AMOUNT
Appendix C :-7   User Guide - Consumer Loans Servicing 



Financed insurances
You can add financed insurance to an existing account with the INSURANCE ADDITION 
transaction. This transaction adds the insurance premium amount to advance/principal bal-
ance on the loan and adjusts the loan receivables accordingly. The transaction also triggers 
the process to re-compute the repayment amount for the loan. After you post the transac-
tion, the loan will be billed for the newly computed payment amount and will be consid-
ered for delinquencies and fees calculations based on information on the Contract (7) 
master tab. The newly added insurance information can be viewed on Customer Service 
form’s Insurances page. 

To add financed insurance
Transaction Parameters
INSURANCE ADDITION TXN DATE

INSURANCE TYPE
SINGLE/JOINT
INSURANCE MODE
INSURANCE PLAN
COMPANY NAME
PHONE #1
EXTN #1
PHONE #2
EXTN #2
POLICY #
POLICY EFFECTIVE DATE
PREMIUM AMOUNT
EXPIRATION DATE
PRIMARY BENEFICIARY
SECONDARY BENEFICIARY
COMMENT

You can cancel financed insurance on an existing account with the INSURANCE CANCEL-
LATION transaction. When you post this transaction, Oracle Daybreak computes the pre-
mium refund amount based on the refund method associated with the insurance item. If 
you enter a value for the PREMIUM AMOUNT parameter, Oracle Daybreak overrides the 
calculated refund amount and adjusts the advance/principal balance and the loan receiv-
ables accordingly. The INSURANCE CANCELLATION transaction re-computes the repay-
ment amount for the loan based on remaining balances.   After posting the transaction, the 
loan will be billed for the newly computed payment amount according information on the 
Contract (7) master tab. The insurance cancellation information can be viewed on the Cus-
tomer Service form’s Insurances page on the Customer Service (2) master tab.

To cancel a financed insurance
Transaction Parameters
INSURANCE ADDITION TXN DATE

INSURANCE TYPE
POLICY EFFECTIVE DATE
INSURANCE REFUND
     AMOUNT
INTEREST REFUND
     AMOUNT
PAYMENT AMOUNT
CANCELLATION REASON
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You may rectify possible errors resulting from incorrect information entered on the 
INSURANCE ADDITION transaction (such as an incorrect premium account) with the 
monetary transaction INSURANCE MODIFICATION. 

When you post the INSURANCE MODIFICATION transaction, Oracle Daybreak re-com-
putes the repayment amount using the new premium amount and adjusts the advance/prin-
cipal balance on the loan and the loan receivables.

To modify financed insurance information
Transaction Parameters
INSURANCE MODIFICATIONS TXN DATE   

INSURANCE TYPE   
POLICY EFFECTIVE DATE   
PREMIUM AMOUNT   

Index/margin rates
You can change the current index rate type and margin rate of a variable rate loan using the 
INDEX / MARGIN RATE CHANGE monetary transaction.

To change an index/margin rate
Transaction Parameters
INDEX/MARGIN RATE CHANGE EFFECTIVE DATE

INDEX
MARGIN RATE
REASON
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Payoff quotes
A payoff quote is the amount still owed on the account or the amount needed to satisfy the 
loan. It can be generated anytime and may be requested during a call from a customer, 
dealer, or insurance agent. The payoff quote appears in the Results block of the Mainte-
nance (3) master tab.

To generate a payoff quote for an account (Loan)
Transaction Parameters
PAYOFF QUOTE TXN DATE

PAYOFF QUOTE VALID UP 
     TO DATE
ASSESS PAYOFF QUOTE FEE
PAYOFF QUOTE LTR PRINT
COMMENT
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Account payoff
An account is automatically paid off or marked for payoff processing by Oracle Daybreak 
with a batch transaction when the account balance is $0.00. You can also manually payoff 
an account with the Maintenance (3) master tab. Note: You can also pay off an account 
using the Consumer Lending (Advance and Payment) form. (For more information, see 
the Batch Transactions chapter.)

When you payoff an account, Oracle Daybreak changes the account’s status to PAID OFF. 
The date the account was paid off appears in the Activity block’s Paid Off Dt field on the 
Account Details page.

Oracle Daybreak also notes the amount of the principal that was waived when the account 
was paid off in the Waived column on the Balances page.

To pay off an account
Transaction Parameters
PAID OFF TXN DATE

If you reverse the payoff payment using the Customer Service form, then the pay-off is 
automatically reversed. Oracle Daybreak changes the account’s status from PAID OFF to 
ACTIVE when you refresh the account.
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Account charge off
Charging off an account refers to when a lender decides to take a loss on an account, sig-
naling that attempts to recover the loan have failed. In calculating a charge off, Oracle 
Daybreak considers the total compensation amount (up front compensation plus remaining 
compensation amount). 

When you charge off account, Oracle Daybreak changes the status to CHARGED OFF. The 
balance on the account appears on the Customer Service form’s Balance page when you 
choose Deficiency Balance in the Balance Group block.

The date of the charge off appears on the Account Details page in the Activity block’s 
Chargeoff Dt field.

Note: Charging off is a process of writing off a loss on a loan which is not repaid by the 
customer. It is different from the waive off process since a waive off is a concession 
offered to the customer on payment of some component, such as a late fee. The repayment 
of the original loan still continues in waive off process.

To charge off an account
Transaction Parameters
CHARGED OFF TXN DATE

Account closure
Oracle Daybreak automatically closes an account when its status changes to PAID or 
VOID. It is manually closed on charge off accounts. Accounts marked as CLOSED are not 
processed and after a period of time are purged from Oracle Daybreak.

Note: The ACCOUNT CLOSE transaction can not be processed on accounts with an 
ACTIVE status. Accounts with a status of CHARGE OFF can be closed.

To close an account
Transaction Parameters
ACCOUNT CLOSE TXN DATE

Advance (principal) balance
The advance (or principal) balance is posted automatically when you fund the contract on 
the Funding form or when you activate in the account in the Conversion App/Acc form. 
You are not allowed to post the advance with the Customer Service form. However, you 
can waive, charge off or adjust the advance or principal.

The adjustments will appears in corresponding column of the Customer Service form’s 
Balances page for the ADVANCE / PRINCIPAL Balance Type-- Waive, Charged Off, 
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Adjusted (-), or Adjusted (+) -- depending on which of the following the transactions you 
perform.

To adjust the advance/principal balance
Transaction Parameters
ADJUSTMENT TO ADVANCE/PRINCIPAL - ADD TXN DATE

AMOUNT

ADJUSTMENT TO ADVANCE/PRINCIPAL - SUBTRACT TXN DATE
AMOUNT

To charge off the advance/principal balance
Transaction Parameters
CHGOFF ADVANCE/PRINCIPAL TXN DATE

AMOUNT

To waive the advance/principal balance
Transaction Parameters
WAIVE ADVANCE/PRINCIPAL TXN DATE

AMOUNT
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Interest
The interest is accrued or posted automatically when you post the payment on the Con-
sumer Lending (Advance and Payment) form. You cannot post the interest in the Cus-
tomer Service form; however, you can adjust or waive interest.

The adjustments will appears in corresponding column of the Customer Service form’s 
Balances page for the INTEREST Balance Type-- Waive, Adjusted (-), or Adjusted (+) -- 
depending on which of the following the transactions you perform.

To adjust the interest 
Transaction Parameters
ADJUSTMENT TO INTEREST - ADD TXN DATE

AMOUNT

ADJUSTMENT TO INTEREST - SUBTRACT TXN DATE
AMOUNT

To waive the interest 
Transaction Parameters
WAIVE INTEREST TXN DATE

AMOUNT
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Interest accrual
You can start or stop interest accrual on either a loan.

To start interest accrual for an account
Transaction Parameters
START ACCURAL TXN DATE

To stop interest accrual for an account
Transaction Parameters
STOP ACCURAL TXN DATE 

On the Customer Service (2) master tab, on the Loan Details or LoC Details sub pages of 
the Balances, Transactions, and Tracking Attributes pages, the Stop Accrual box is 
selected in the Interest and Accruals block.

Note: To remove the Stop Accrual indicator, post the START ACCURAL transaction.

Active military duty
The Servicemembers Civil Relief Act of 2003 (SCRA), formerly known as the Soldiers 
and Sailors Civil Relief Act of 1940 (SSCRA), is a federal law that gives military mem-
bers some important rights as they enter active duty military service. The law is designed 
for active duty military personnel and reservists (and their spouse -- if applicable for joint 
credit accounts) to receive, as a result of military service economic hardship(s), an interest 
rate reduction (currently at 6.000%) for certain consumer and mortgage-related debt that 
was incurred prior to entering military service, for the period of time that the servicemem-
ber is on active duty. Under the law, the term’s interest includes service charges, renewal 
charges, fees, or any other charges (except bona fide insurance) with respect to an obliga-
tion or liability. The law also provides protection against certain legal actions during the 
term of active duty military service. The SCRA function is currently available in Oracle 
Daybreak for simple interest loan accounts.

Any account that has been identified under SCRA requirements as eligible for the allow-
able benefits of active military duty for its primary borrower/spouse will have a new inter-
est rate calculation based upon the 6.000% limit set by the SCRA. However, this change is 
subject to exception in case of accounts that already have an interest rate less than 6.000%. 
In such cases, the original interest rate that is less than 6.000% will continue.
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To indicate that a borrower is on active military duty
Transaction Parameters
BORROWER ON MILITARY DUTY TXN DATE

BORROWERS RELATION
    WITH ACCOUNT

ACTIVE DUTY ORDER REF-
   ERENCE

After you post this transaction, the Active Military Duty box (Customers block) and Mili-
tary Duty box (Activity block) are selected on the Customer Service (2) master tab’s 
Account Details page. Oracle Daybreak changes the condition of the account to ON 
ACTIVE DUTY. Details of the transaction appear in the Military Services block on the 
Customer Service (2) master tab’s Customer Details page.

If the interest rate was greater the 6%, Oracle Daybreak will change the rate to 6% and 
adjust the payment accordingly. The CHANGE PAYMENT AMOUNT and RATE CHANGE 
transactions on the Customer Service (2) master tab’s Transactions page.

To indicate that a borrower is no longer on active military duty
Transaction Parameters
BORROWER OFF MILITARY DUTY TXN DATE

BORROWERS RELATION
    WITH ACCOUNT
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Due date change
You can change the due date of an account. If a late fee is no longer applicable because of 
this due day change, Oracle Daybreak will automatically remove the fee.

Note: When you change a due date, Oracle Daybreak determines the next bill date, as well 
as the next due date. The DUE DATE CHANGE transaction does not allow the next billing 
date to change such that it is less than the current billing date. 

Oracle Daybreak also notes the change on Loan Details sub pages in the Extn and Due 
Dates block’s # of Due Day Changes and Due Day Chg Dt fields.

To change a due date
Transaction Parameters
DUE DATE CHANGE TXN DATE

DUE DATE 
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Extensions
Extension transactions allow you to extend a loan. An extension fee may be assessed when 
an account receives an extension. In case of precomputed loans, this is generally done to 
recoup the interest lost.

Oracle Daybreak adjusts the due date on the Dues block’s Oldest Due Dt on the Customer 
Service form’s Account Details to reflect the extension.

It also notes the change with an entry on the Additional Loan Details sub page’s Exten-
sions and Due Dates block’s # of Extensions and # of Extension Term fields.

To apply an extension
Transaction Parameters
EXTENSION TXN DATE

EXTENSION TERM 

To adjust an extension fee
Transaction Parameters
ADJUSTMENT TO EXTENSION FEE - ADD TXN DATE

AMOUNT 

ADJUSTMENT TO EXTENSION FEE - SUBTRACT TXN DATE
AMOUNT 

TO WAIVE AN EXTENSION FEE
Transaction Parameters
WAIVE EXTENSION FEE TXN DATE

AMOUNT 
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Payment amount
You can change the current payment amount of an account. If the transaction is backdated, 
due amounts for the affected periods are re-calculated. While delinquency data could 
potentially change, prior statements are not be changed. The next ACH (if applicable) 
does not reflect the changed payment amount if the account has already been billed at the 
time of posting the transaction. Payments will be re-applied causing changes to account 
balances and late fees may be assessed (if applicable).

Note: You must calculate the new payment amount. Oracle Daybreak does not perform 
any checks on the new payment amount.

After you post the transaction, the new payment amount appears Customer Service (2) 
master tab’s Account Details page in the Current Pmt field of the Activity block.

To change the payment amount
Transaction Parameters
CHANGE PAYMENT AMOUNT TXN DATE

PAYMENT AMOUNT 
PAYMENT AUTO COMPUTER
     INDICATOR

Prepayment penalty
A prepayment penalty is typically applied automatically by Oracle Daybreak if the 
account is paid off prematurely.

The following transactions allow you to adjust or waive the prepayment penalty fee.
The adjustments will appears in corresponding column of the Customer Service form’s 
Balances page for the FEE PREPAYMENT PENALTY Balance Type-- Waive, Adjusted (-), 
or Adjusted (+) -- depending on which of the following the transactions you perform.
Appendix C :-19   User Guide - Consumer Loans Servicing 



To adjust a prepayment penalty 
Transaction Parameters
ADJUSTMENT PREPAYMENT PENALTY - ADD TXN DATE

AMOUNT 

ADJUSTMENT PREPAYMENT PENALTY - SUBTRACT TXN DATE
AMOUNT

To waive a prepayment penalty 
Transaction Parameters
WAIVE PREPAYMENT PENALTY TXN DATE

AMOUNT 

Escrow payment
The following monetary transactions allow you to specify the escrow payment to be billed 
to the customer each month. Rescheduling an escrow payment allows you to change the 
payment rate (and hence the rate and term) and define when the change will begin. The 
“txn date” parameter is when the new agreement starts. 

The following transactions allow you to adjust or waive the escrow advance.
The adjustments will appears in corresponding column of the Customer Service form’s 
Balances page for the ESCROW ADVANCE Balance Type-- Waive, Adjusted (-), or 
Adjusted (+) -- depending on which of the following the transactions you perform.

To adjust escrow advance
Transaction Parameters
ADJUSTMENT TO ESCROW ADVANCE - ADD TXN DATE

AMOUNT 

ADJUSTMENT TO ESCROW ADVANCE - SUBTRACT TXN DATE
AMOUNT 

To waive escrow advance
Transaction Parameters
WAIVE ESCROW ADVANCE TXN DATE

AMOUNT 

To reschedule an escrow payment
Transaction Parameters
RESCHEDULE ESCROW PAYMENT TXN DATE

AMOUNT 

The new escrow payment amount appears on the Escrow page in the Escrow Payment 
block’s Current Escrow Pmt field.

Escrow balance refund 
If an account is paid off resulting in a positive (greater than $0) escrow balance or the last 
item being escrowed is removed resulting in a positive (greater than $0) escrow balance, 
then Oracle Daybreak refunds the escrow and creates a check requisition.
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Pay off quote fee
The PAYOFF QUOTE transaction on the Maintenance (3) master tab includes the required 
parameter ASSESS PAYOFF QUOTE FEE (Y/N). If you select Y, Oracle Daybreak assesses 
a payoff quote fee on the Customer Service form’s Balances page for the Balance Type 
FEE PAYOFF QUOTE. The amount of the payoff quote fee is based on contract setup.

The following transactions allow you to adjust or waive the pay off quote fee.
The adjustments will appears in corresponding column of the Customer Service form’s 
Balances page for the FEE PAYOFF QUOTE Balance Type-- Waive, Adjusted (-), or 
Adjusted (+) -- depending on which of the following the transactions you perform.

To adjust a pay off quote fee
Transaction Parameters
ADJUSTMENT TO PAYOFF QUOTE FEE - ADD TXN DATE

AMOUNT 

ADJUSTMENT TO PAYOFF QUOTE FEE - SUBTRACT TXN DATE
AMOUNT 

To waive a pay off quote fee
Transaction Parameters
WAIVE PAYOFF QUOTE FEE TXN DATE

AMOUNT 
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Nonperforming accounts
Loan accounts can be placed in a nonperforming, or nonaccrual, condition. Once an 
account is set to a nonperforming condition, Oracle Daybreak makes the following modi-
fications and accounting entries:

• After the transaction date, Oracle Daybreak assesses no late charge to this account.
• Stops general ledger entries for interest accrual.
• Transfers the existing principal balance on this account to the Non-Performing Bal-

ance Group on the Customer Service form’s Balance page.
• Charges the unearned dealer compensation back to the dealer.
• Treats payments posted to this account as it does with a normal account; however, the 

general ledger entries for allocation of these amounts towards principal and interest 
will go towards the nonperforming balance.

Oracle Daybreak’s general ledger (GL) is set up (Setup > General Ledger) for the above 
items. There will be no impact on the balances of the account (principal, interest, fee and 
expense) as a result of the above transactions.

To place an account in a nonperforming condition
Transaction Parameters
ACCOUNT NON PERFORMING TXN DATE

NON PERFORMING DESCRIP-
TION 

The following transaction removes the nonperforming condition on an account and 
reverses the nonperforming transactions explained above. General ledger entries for inter-
est accrual, stopped during nonaccrual stage, resume.

To reverse a nonperforming condition
Transaction Parameters
RESUME ACCOUNT PERFORMING TXN DATE
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Convert a precomputed (PC) loan into a simple interest (SI) loan
When converting a precomputed loan into a simple interest loan, Oracle Daybreak 
assumes the following default values: 

• Accrual Calculation Method - interest bearing (simple interest)
• Maturity Date - Computed from the term and next payment due date
• Monthly Payment Amount - Computed from the interest rate, new principal balance, 

accrual start date, and term.
• All balances other than the Note balance are carried over to the simple interest loan.

The resulting “new” simple interest loan will have the same account number with the 
details entered/computed above.

Caution: The converting a precomputed loan into a simple interest loan transaction can be 
performed only by closing the nonperforming condition. 

To reschedule precompute loan to interest bearing loan
Transaction Parameters
RESCHEDULE PRE-COMPUTE LOAN TXN DATE
TO INTEREST BEARING LOAN RESCHEDULE PAYMENT

       START DATE
AMOUNT
RATE
TERM
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Loan nonmonetary transactions
This section catalogues the transaction codes and parameters required to complete the fol-
lowing nonmonetary tasks for loans:

• Update a customer’s name
• Maintain customer details
• Mark a customer as a skipped debtor
• Change a customer’s Privacy Opt-Out indicator
• Stop correspondence
• Modify financed insurance information
• Start or stop an ACH
• Reprint a statement (batch only)
• Create or cancel a one time ACH - phone pay
• Reorder coupon books (or payment books) 
• Cancel or adjust an ESC 
• Apply a refund payment to an ESC 
• Cancel insurance (or reverse the insurance cancellation)
• Add new escrow insurance details
• Add new escrow tax details
• Change insurance annual disbursement
• Change insurance disbursement plan
• Change escrow indicators of insurance
• Change insurance expiration date
• Change insurance maturity date
• Change tax annual disbursement
• Change tax disbursement plan
• Change escrow indicators of tax
• Resume escrow analysis
• Resume escrow disbursements
• Stop escrow analysis
• Stop escrow disbursements
• Refund or adjust insurance
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Customer name maintenance

You can update and change a customer’s name.

To update a customer’s name
Transaction Parameters
CUSTOMER NAME MAINTENANCE TXN DATE

RELATION TYPE CODE 
CUSTOMER FIRST NAME 
CUSTOMER MIDDLE NAME
CUSTOMER LAST NAME
CUSTOMER GENERATION
     CODE

The new name appears in the account title and on the Customer Service (2) master tab’s 
Account Details and Customer Details pages.
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Customer details maintenance
You can update and change the following details regarding a customer: social security 
number, marital status, disability indicator, driving license number, number of dependents, 
and email address.

To change other details about a customer 
Transaction Parameters
CUSTOMER MAINTENANCE TXN DATE

RELATION TYPE CODE
CUSTOMER SSN 
CUSTOMER MARITIAL
     STATUS CODE
CUSTOMER DISABILITY
     INDICATOR 
CUSTOMER DRIVING
     LICENSE NUMBER 
CUSTOMER NUMBER OF
     DEPENDENTS 
CUSTOMER EMAIL
     ADDRESS 1
CUSTOMER BIRTH DATE
CUSTOMER GENDER CODE
CUSTOMER LANGUAGE    
      CODE
CUSTOMER DRIVING 
     LICENSE STATE CODE
CUSTOMER TIME ZONE

The new details appears on the Customer Service (2) master tab’s Account Details and 
Customer Details pages.
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“Skipped” customers
When a customer cannot be located, Oracle Daybreak allows you to mark that person as 
“skipped” (as in, “the person is a skipped debtor.”) Marking a customer as skipped indi-
cates that the customer’s whereabouts are unknown.

To mark a customer as “skipped”
Transaction Parameters
CUSTOMER SKIP TXN DATE

RELATION TYPE CODE
CUSTOMER SKIP INDICATOR

The Skip box is selected on the Customer Service (2) master tab’s Account Details and 
Customer Details pages.

Note: To remove the Skip indicator, follow the procedures above; however, type N in the 
CUSTOMER SKIP INDICATOR parameter.

Privacy Opt-Out indicator
You can change the customer’s Privacy Opt-Out indicator.

To change the customer’s privacy opt-out indicator
Transaction Parameters
CUSTOMER PRIVACY INFO SHARING PREFERENCE PRIVACY OPTOUT

EFFECTIVE DATE
RELATION TYPE CODE 

The Primary Opt-Out box is selected on the Customer Service (2) master tab’s Account 
Details and Customer Details pages.

Note: To remove the Primary Opt-Out indicator, follow the procedures above; however, 
type N in the CUSTOMER STOP CORRESPONDENCE INDICATOR parameter.
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Correspondence (stopping)
You can choose at any time to stop correspondence to a customer. When you do so, the 
customer will receive no correspondence of any kind from Oracle Daybreak.

To stop correspondence with a customer
Transaction Parameters
CUSTOMER STOP CORRESPONDENCE TXN DATE

RELATION TYPE CODE
CUSTOMER STOP CORR
     INDICATOR

The Stop Correspondence box is selected on the Customer Service (2) master tab’s 
Account Details and Customer Details pages.

Note: To remove the Stop Correspondence indicator, follow the procedures above; how-
ever, type N in the CUSTOMER STOP CORRESPONDENCE INDICATOR parameter.

Financed insurance (modifying)
You can change other insurance details entered on the INSURANCE ADDITION transaction 
with the nonmonetary INSURANCE DETAILS MODIFICATION transaction. The changed 
insurance information can be viewed on Customer Service form’s Insurances page on the 
Customer Service (2) master tab.

Note: Please contact your account manager for back porting this functionality on existing 
loan accounts.

Transaction Parameters
INSURANCE MODIFICATION TXN DATE

EFFECTIVE DATE 
INSURANCE TYPE   
POLICY EFFECTIVE DATE   
COMPANY NAME 
PHONE # 1 
EXTN # 1 
PHONE # 2 
EXTN # 2 
POLICY # 
EXPIRATION DATE 
PRIMARY BENEFICIARY 
SECONDARY BENEFICIARY 
REFUND AMOUNT 
RECEIVED 
FULL REFUND RECEIVED 
COMMENT 
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ACH
With the Transaction page, you can either start or stop an automated clearinghouse, or 
electronic funds transfer, for an account.

To start an ACH for an account
Transaction Parameters
ACH MAINTENANCE TXN DATE

ACH BANK NAME
ACH BANK ROUTING 
     NUMBER 
ACH ACCOUNT TYPE CODE
ACH ACCOUNT NUMBER 
ACH PAYMENT DAY 
ACH PAYMENT AMOUNT 
ACH PAYMENT FEQUENCY
     CODE
ACH START DATE 

This information appears on the ACH sub page, available on the Balances, Transactions, 
Tracking Attributes, and Insurances pages on the Customer Service (2) master tab.

To stop an ACH for an account 
Transaction Parameters
STOP ACH MAINTENANCE TXN DATE

Oracle Daybreak clears the information on the ACH sub page, available on the Balances, 
Transactions, Tracking Attributes, and Insurances pages on the Customer Service (2) mas-
ter tab.
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Statement reprinting (batch only)
You can reprint a statement of account activity by defining the starting and closing dates 
included within the statement.

To reprint a statement 
Transaction Parameters
STATEMENT REPRINT MAINTENANCE TXN DATE 

STATEMENT CLOSING DATE

One time ACH - phone pay
Oracle Daybreak provides the ability to handle one time automated clearinghouse initiated 
by nonmaintenance transactions, giving you the ability to offer phone pay services to your 
customers. When accessing a phone pay, Oracle Daybreak creates an ACH file and gener-
ates payment batches.

Note: A one time ACH - phone pay transaction has parameters which are required for the 
ACH file processing.

To create one time ACH - phone pay
Transaction Parameters
ONETIME ACH - PHONE PAY BANK NAME

BANK CITY
ROUTING NUMBER
ACCOUNT TYPE
NAME AS IT APPEARS ON
     ACCOUNT
ACCOUNT NUMBER
DEBIT DATE
PAYMENT AMOUNT
PHONE PAY FEE
SECRET QUESTION
SECRET ANSWER
WHO AUTHORIZED
CHECK NUMBER

To cancel one time ACH - phone pay
Transaction Parameters
CANCEL ONETIME ACH - PHONE PAY (NO PARAMETERS)

* Post transaction to complete.
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Coupon book maintenance (batch only)
In reordering coupon books, you will need supply the first date of new coupons, the new 
coupon start number, and the number of new coupons to order.

To re-order coupon book (batch only)
Transaction Parameters
COUPON BOOK MAINTENANCE TXN DATE 

COUPON FIRST PAYMENT
     DATE 
COUPON START NUMBER 
COUPON COUNT 

• To cancel the coupon book re-order before it is processed in the nightly batch, choose 
Void.

Extended Service Contract (ESC)
You can apply, cancel, or adjust a payment to an extended service contract.

To cancel or adjust an ESC 
Transaction Parameters
WARRANTY MAINTENANCE TXN DATE

INSURANCE/WARRANTY
     CANCEL INDICATOR 
INSURANCE/WARRANTY
     CANCEL DATE 
INSURANCE/WARRANTY
     REMAINING TERM 
INSURANCE/WARRANTY
     REFUND AMOUNT 
     ESTIMATE 
INSURANCE/WARRANTY
     REFUND AMOUNT
     RECEIVED 
INSURANCE/WARRANTY
      FULL REFUND RECEIVED
      INDICATOR 
INSURANCE/WARRANTY 
ITEMIZATION CODE 

To apply a refund payment to an ESC 
Transaction Parameters
WARRANTY PAYMENT MAINTENANCE TXN DATE

INSURANCE/WARRANTY
     REFUND AMOUNT
     RECEIVED
INSURANCE/WARRANTY
     ITEMIZATION CODE
INSURANCE/WARRANTY
     FULL REFUND RECEIVED
     INDICATOR 

Note: A Warranty Refund transaction posted or reversed on the Maintenance page should 
be matched with a payment posting or reversal.
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Insurance maintenance

To cancel insurance (or reverse the insurance cancellation)
Transaction Parameters
INSURANCE MAINTENANCE TXN DATE

INSURANCE/WARRANTY
     CANCEL INDICATOR 
INSURANCE/WARRANTY
     CANCEL DATE 
INSURANCE/WARRANTY
     REMAINING TERM 
INSURANCE/WARRANTY
     REFUND AMOUNT 
     ESTIMATE 
INSURANCE/WARRANTY
     REFUND AMOUNT
     RECEIVED 
INSURANCE/WARRANTY
     FULL REFUND RECEIVED
     INDICATOR
INSURANCE/WARRANTY
     ITEMIZATION CODE 

Note: This is not asset or collateral insurance, but the account insurance; for example, 
“Credit Life and Disability.”

Escrow information and maintenance
The following nonmonetary transactions allow you to add a new tax or insurance escrow 
to an account. 

To add new escrow insurance details
Transaction Parameters
NEW ESCROW INSURANCE DETAILS ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
ESCROW REQUIRED (Y/N)
ESCROW OPT OUT (Y/N)
ANNUAL DISBURSEMENT
     AMOUNT
DISBURSEMENT RULE
TRANSACTION DATE
REFERENCE ACCOUNT #
INSURANCE POLICY #
EXPIRATION DATE
MATURITY DATE
COVERAGE TYPE
COVERAGE TERM
COVERAGE AMOUNT
REASON
REFERENCE
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To add new escrow tax details
Transaction Parameters
NEW ESCROW TAX DETAILS ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
ESCROW REQUIRED (Y/N)
ESCROW OPT OUT (Y/N)
ANNUAL DISBURSEMENT
     AMOUNT
DISBURSEMENT RULE
TRANSACTION DATE
REFERENCE ACCOUNT #
PROPERTY TAX TYPE
REASON
REFERENCE

The following nonmonetary transactions allow you to update any of the escrow informa-
tion regarding an existing tax and insurance.

To change insurance annual disbursement
Transaction Parameters
CHANGE INSURANCE ANNUAL DISBURSEMENT ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
TRANSACTION DATE
ANNUAL DISBURSEMENT
     AMOUNT
REASON
REFERENCE

To change insurance disbursement plan
Transaction Parameters
CHANGE INSURANCE DISBURSEMENT PLAN ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
TRANSACTION DATE
DISBURSEMENT RULE
REASON
REFERENCE

To change escrow indicators of insurance
Transaction Parameters
CHANGE ESCROW INDICATORS OF INSURANCE ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
TRANSACTION DATE
ESCROW REQUIRED (Y/N)
ESCROW OPT OUT (Y/N)
REASON
REFERENCE
Appendix C :-33   User Guide - Consumer Loans Servicing 



To change insurance expiration date
Transaction Parameters
CHANGE INSURANCE EXPIRATION DATE ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
TRANSACTION DATE
EXPIRATION DATE
REASON
REFERENCE

To change insurance maturity date
Transaction Parameters
CHANGE INSURANCE MATURITY DATE ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
MATURITY DATE
REASON
REFERENCE

To change tax annual disbursement
Transaction Parameters
CHANGE TAX ANNUAL DISBURSEMENT ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
TRANSACTION DATE
ANNUAL DISBURSEMENT
     AMOUNT
REASON
REFERENCE

To change tax disbursement plan
Transaction Parameters
CHANGE TAX DISBURSEMENT PLAN ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
TRANSACTION DATE
DISBURSEMENT RULE
REASON
REFERENCE

To change escrow indicators of tax
Transaction Parameters
CHANGE ESCROW INDICATORS OF TAX ESCROW TYPE

ESCROW SUB TYPE
VENDOR #
TRANSACTION DATE
ESCROW REQUIRED (Y/N)
ESCROW OPT OUT (Y/N)
REASON
REFERENCE
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Escrow analysis disbursements
The following nonmonetary transactions allow you to resume and stop escrow analysis 
and disbursements. 

To resume escrow analysis
Transaction Parameters
RESUME ESCROW ANALYSIS TRANSACTION DATE

REASON
REFERENCE

To resume escrow disbursements
Transaction Parameters
RESUME ESCROW DISBURSEMENTS TRANSACTION DATE

REASON
REFERENCE

To stop escrow analysis
Transaction Parameters
STOP ESCROW ANALYSIS TRANSACTION DATE

REASON
REFERENCE

To stop escrow disbursements
Transaction Parameters
STOP ESCROW DISBURSEMENTS TRANSACTION DATE

REASON
REFERENCE

Insurance payment maintenance

To refund or adjust insurance
Transaction Parameters
INSURANCE PAYMENT MAINTENANCE TXN DATE

INSURANCE/WARRANTY
     REFUND AMOUNT
     RECIEVED
INSURANCE/WARRANTY
     ITEMIZATION CODE 
INSURANCE/WARRANTY
     FOR FULL REFUND
     RECEIVED

Note: The insurance refund posted or reversed on the Maintenance page should be 
matched by a payment posting or reversal.
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APPENDIX D : PAYMENT AMOUNT CONVERSIONS

The following table contains the calculations Oracle Daybreak uses to convert the differ-
ent payment frequencies (weekly, biweekly, semimonthly, and so on) to standard monthly 
values for installment accounts.

Payment Frequency: Scheduled Monthly Income Amount:

D = Deferred Zero fill

P = Single payment loan Zero fill

W = Weekly (due every week) Multiple by 4.33

B = Biweekly (due every two weeks) Multiple by 2.16

E = Semimonthly (due twice a month) Multiple by 2

M = Monthly (due every month) As given

L = Bimonthly (due every two months) Divide by 2

Q = Quarterly (due every three months) Divide by 3

T = Triannually (due every four months) Divide by 4

S = Semiannually (due twice a year) Divide by 6

Y = Annually (due every year) Divide by 12
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